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 Jo’s so taken with her 
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indoors. Or at least that 
why she says she’s 
wearing them… Hmm…
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You’re spoilt for choice when it comes 
to all things Apple this issue. We kick 
off with news of the latest updates 
to macOS, iOS, iPadOS, watchOS and 
tvOS on p6 and p14, and then starting 
on p74, you’ll discover in-depth 
reviews of the new iMac 24-inch, 
iPad Pro 12.9-inch and Apple TV 4K.

In between, you’ll find plenty 
to surprise and delight you – in our 
massive 13-page lead feature (p18), 

you’ll find 57 ways to do more with all of your Apple devices – 
from tips and tricks to make using them easier, to incredible 
apps and features, as well as plenty of things to see and do.

On p58 we turn our attention to the Apple Watch, which 
has turned from a nice-to-have luxury to the most personal 
computer you’ll ever use over six generations. Our eight-
page feature will show you how to make the most of it.

Also inside the issue are 22 pages of Genius tips and 
how-tos that cover everything from decluttering your Mac 
to making socially distanced band compositions. Plus there’s 
a back-to-basics guide to Apple’s spreadsheet app, Numbers  
on p67, a weather apps group test (p86), and our pick of the 
best gardening apps (p96) to help you make the most of 
the summer. You’ll also be able to enjoy in-depth reviews 
of Fauna’s stylish audio sunglasses (p83) and much, much 
more. Enjoy the issue and take care,

Paul Blachford
Art Editor
 Paul’s really excited 

about Universal Control in 
macOS Monterey. He can 
now seamlessly share his 
cat memes from any 
device. Joy.
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 WWDC 2021 – 

macOS Monterey, 
iOS 15, watchOS 8, 

and more…

A
pple’s Worldwide Developers 
Conference (WWDC) keynote, on 
7 June 2021, featured no new 

hardware, to the disappointment of anyone 
hoping for a new MacBook Pro or an AirPods 
redesign. But that doesn’t mean it was totally 
devoid of interesting news – as we discuss in 
MacFormat Investigates on page 14, it was full 
to the brim with new software features.

Some of those updates weigh in on what's 
becoming an age-old question: can you now 
replace your MacBook with an iPad? Ultimately 
that depends on how you use both devices, but 
the new features in iPadOS 15 will certainly 
have an impact on that.

At WWDC, Apple spent a lot of time talking 
about iPadOS 15’s new multitasking abilities, 
which are a step up from what was possible 
before. For instance, multi-window 
management is an oft-requested feature 
among iPad power users, and Apple is now 
granting it with iPadOS 15. If you have multiple 
app windows, you can switch between them 
using a kind of ‘shelf’ that acts a little like a 
Dock for that specific app.

As well as that, you can now start a new 
Split View by simply dragging one app on top 
of another in the App Switcher. Or tap the top 
of an app window and you’ll reveal new controls 
to quickly start Split View, Slide Over, or make 

It might be time to switch thanks to iPadOS 15

If your work involves heavier 
workloads, you will probably 
want to stick with a Mac for now.Can your iPad 

replace your Mac?

EDITED BY ROB MEAD-GREEN 

HOT TOPIC!
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issue’s big question!
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facebook.com/macformat

the app full screen. While these multitasking 
tweaks and improvements are not 
particularly revolutionary, they should 
help to alleviate some of the gripes with 
previous incarnations of iPadOS.

If you love the iPad’s form factor and 
want a portable device to be your main 
daily driver, iPadOS 15 might be enough to 
make you switch from Mac. Pair it with a 
keyboard case and it becomes a lightweight 
laptop that, in the iPad Pro at least, has the 
same M1 chip as many of the latest Macs. In 
fact, the iPad does plenty of things the Mac 
cannot, thanks to its touchscreen and Apple 
Pencil support.

The pro user problem
There is a snag, though. The M1 chip inside 
the new iPad Pro means it blows away just 
about every other tablet on the market, but 
hardware has never been the iPad’s main 
shortfall. Instead, it is being held back by 

the same software that Apple made such a 
fuss about at this year's WWDC. The new 
features in iPadOS 15 are a good start, but 
they still deliver less flexibility and ease of 
use than you get on a Mac.

Most average users can probably live 
with that, but for power users the situation 
is much worse. Apple makes iPad and 
iPhone apps available on the Mac using 
a framework called Mac Catalyst, but 
steadfastly refuses to let apps flow the 
other way, leaving the iPad with hobbled 
versions of video editing and music 
production apps. If that is your main 
workload, you will likely lament the lack 
of full-powered Mac apps on your tablet.

There is a probable cause: Apple does 
not want to cannibalise its own products. 
If it makes iPad software more capable, 
people might wonder why they need a 
Mac at all. That makes sense, and for a 
lot of users, the updates to iPadOS are 
more than enough. If you are a power user, 
though, you might be left frustrated that 
your iPad cannot do more.

So, back to that age-old question. For 
a huge number of people, the iPad is now 
quite capable of replacing their laptop, 
offering plenty in the way of productivity 
and entertainment while adding some neat 
new productivity type features in iPadOS 
15. If you have demanding work, though, 
the likelihood is you will be sticking with 
your Mac for the foreseeable future.

WE ASKED…  
What’s your favourite new 
feature from WWDC 2021?

New 
FaceTime 
features

Live 
Text

iCloud+
Universal 
Control

irTag, Apple’s device-tracking 
product that can clip to a 
keyring or be stashed in a bag, 

has been updated to better protect users 
against tracking efforts by bad actors.

When AirTag was released at Apple’s 
Spring Loaded event in April, the company 
said it had designed privacy into the 
product. Yet concerns were raised that 
someone with bad intentions could conceal 
an AirTag in your belongings and use it to 
track you. This issue was compounded 
because AirTag would only buzz three 
days after being separated from its owner, 
making it much easier to hide one without 

it being noticed. Apple has now issued a 
software update that makes AirTag play 
a sound between eight and 24 hours after 
being separated, making it easier to detect 
an unwanted AirTag. In addition to that, 
Apple is working on an Android app that 
will alert you if it detects an unknown 
AirTag, like the Find My app does on 
iPhone. Apple has said the Android 
app will be ready later in 2021.

35% 40%

12.5%12.5%

AirTag gets anti-
stalker update

An update now means an AirTag separated from 
its owner will make a sound within 24 hours.

> According to Daniel Ives at 
industry analysts Wedbush, the 
iPhone 13 Pro and iPhone 13 Pro 
Max could come with up to 1TB 
of storage. Ives also predicted 
that all models in the iPhone 13 
range would come with LiDAR 
scanners as standard, a feature 
that is currently restricted to 
Apple’s Pro and Pro Max phones.

However, reputable analyst 
Ming-Chi Kuo stated in March 2021 
that LiDAR would remain a top- 
end exclusive for the Pro and Pro 
Max devices. Leaker Jon Prosser, 
who claims to have obtained CAD 
files of the iPhone 13 range, also 
doubted that all iPhone 13 models 
would gain LiDAR scanners. Time 
will tell who is correct.

iPhone 13: 1TB 
storage and 
LiDAR scanner

The LiDAR scanner is currently only found 
in the iPhone 12 Pro and iPhone 12 Pro Max.

The gap is closing on macOS and iPadOS, but the 
divide means benefits and frustrations with both.

A
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Both iPad Pro and iPad mini in line for some major changes

A
fter rumours persisted for months, 
Apple released its first miniLED 
display at its Spring Loaded event 

in April 2021. This screen was outfitted into 
the iPad Pro, upgrading it from an LCD panel 
and giving it superb colours and contrast, 
making it the best display in any Apple tablet. 
According to South Korea’s ETNews, other 
iPads will also move on from LCD panels, 
with OLED the most likely replacement tech.

The report from ETNews does not go into 
too many specifics, and instead says only that 
“some” iPad models will get OLED displays 
starting in 2022. While the report is a little 
vague, there are a few substantial reasons 

to suspect the iPad Air will be the first to make 
the leap to an OLED display. One is that reliable 
industry analyst Ming-Chi Kuo stated in March 
2021 that he expects the iPad Air will switch to 
OLED displays in 2022, with Apple reserving a 
miniLED display for the iPad Pro. That would 
give the iPad Air a noticeable improvement 
in display quality without undercutting the 
iPad Pro’s flagship status.

As well as that, the iPad Air was the first 
iPad to follow the iPad Pro and abandon the 
Home button, and is seen as the next down the 
pecking order below the iPad Pro. It therefore 
stands to reason it will be the next to ditch 
LCD panels as well.

New iPads on the horizon
AIRPOWER 
NOT DEAD 
YET – REPORT

>  Apple Watch 7 could 
come in a range of 
colours. According 
to leaker Jon Prosser, 
Apple is testing “new 
experimental colours” 
for the device’s body. 
Prosser’s renders 
depicted Watches in red, 
pale green, light blue, 
and more. Prosser also 
stated the Apple Watch 
7’s body will also feature 
flat-edged sides, which 
follows a report from 
analyst Ming-Chi Kuo 
in September 2020 that 
advanced a similar idea.

APPLE 
NEWS 
ROUNDUP

>  After teasing AirPower 
in 2017, Apple ditched 
its wireless charging 
mat, reportedly due to 
overheating concerns. 
Yet it might not be dead 
– Bloomberg’s Mark 
Gurman has stated 
Apple is “exploring a 
future wireless charger” 
that could work similarly 
to AirPower. The 
company is also 
experimenting with 
wireless chargers that 
can juice up over the air, 
he claimed, but this is 
“several” years away.

A
pple will update the 
iPad Pro and the 
iPad mini with new 

features and designs, says 
Bloomberg’s Mark Gurman. 
The redesigned iPad Pro is 
due to be released in 2022, 
while the iPad mini is 
scheduled for later this year.

According to Gurman, the 
iPad Pro will get a glass back 
to allow wireless charging, 
replacing the current 
aluminium surface and 
bringing it in line with the 
glass-backed iPhone. Apple 
is also testing a MagSafe 
charger for the iPad Pro, plus 
a ‘reverse wireless charging’ 
feature that would let the 
tablet wirelessly charge an 
iPhone that is placed onto its 
surface. It is not clear if either 

of these features will be ready 
in time for the next iteration 
of the iPad Pro.

The iPad mini, meanwhile, 
will get thinner bezels and 
could ditch its Home button, 
says Gurman. That could 
mean it joins the iPad Pro and 
iPad Air in having an all-
screen display. Gurman also 
claimed Apple is working on a 

thinner entry-level iPad aimed 
at students, which could be 
released around the same 
time as the new iPad mini.

Gurman cautioned that 
these new features were still 
being tested and could be 
changed or cancelled in 
due course. If they come to 
fruition, though, they would 
be intriguing updates.

NEW COLOURS 
AND FLAT EDGES

CHARGER ALLEGEDLY 
STILL IN THE WORKS

APPLE WATCH 
REDESIGN

The iPad mini could 
soon get its first update 
since March 2019.

LCD screens are on the way out

Future iPads could get OLED 
displays, with the iPad Air most 
likely to be the first in line.

OLED panels 
coming to 
future iPads
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Apps & games APPLE CORE

AR Pianist –  
3D Piano Concerts
FREE (offers IAPs)

 AR Pianist makes 
clever use of 
augmented reality 

(AR) to help you learn piano. 
It can listen to what you’re 
playing and show you what to 
play next, and the AR piano 
superimposes piano keys that 
you can play in real time. You 
can even watch AR concerts 
with virtual pianists.
Why you need it: AR tech 
meets musical virtuosity.

Secret Neighbor
FREE (offers IAPs)

 A spin on 2017’s 
Hello Neighbor, 
Secret Neighbor 

tasks you and a group of 
friends with infiltrating a 
neighbour’s basement to 
uncover their dark secret. 
Yet one of your group is the 
neighbour in disguise – can 
you uncover them before they 
pick you off and suspicion 
tears your team apart?
Why you need it: Tension and 
mistrust breed excitement.

 Guide a group of 
survivors from the 
shattered ruins of 

underground Moscow across 
post-apocalyptic Russia in 
search of a future for 
humanity. Metro combines 
stunning visuals, immersive 
stealth and frantic combat to 
forge a superb survival game. 
Now on Mac, you get all the 
expansion packs included, too.
Why you need it: It’s a top-tier 
gaming experience.

When it comes to backups, 
Carbon Copy Cloner (CCC) can 
be a lifesaver. It goes beyond 
what Time Machine offers, with 

fine-grained backup options. Version 6 brings 
a selection of new features, and its wide-
ranging overhaul touches almost every area of 
the app. The changes combine to make using 
the app speedier and snappier. For example, 
CCC’s file copier has been revamped, resulting 

[ A L B U M ]

Hi
Texas
£6.99
 The latest album from 

a resurgent Texas sees 
them mix soulful rhythms 
with unexpected twists 
and influences from the 
70s and 80s. It’s their 
best album in years.

[ A U D I O B O O K ]

The Funny Thing… 
Julietta Henderson
£7.99
 After his friend’s death, 

12-year-old Norman 
begins a journey to look 
after his mother, find his 
father, and become a 
comedy legend. Heart-
wrenching and hilarious.

[ P O D C A S T ]

Simplify 
 If you despair at 

life’s complexity, let 
the Simplify podcast 
try to help find ways to 
manage habits, health, 
happiness, and more.

in backups that complete up to 20 times faster. 
You can now preview exactly what each backup 
process will do before you start, too. The result 
is less time spent backing up and more 
confidence when you do it.

There’s a new menu bar widget for 
quick tasks and alerts, a Backup Audit and 
a Snapshot Navigator to make examining 
backups easy, a new interface with dark mode, 
and more. Check out our review next issue!

Metro Exodus
£54.99

AUGUST 2021 | MACFORMAT | 9
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Media 
Picks
 What you should 

be playing and 
reading this month

[ i O S  A P P ] [ M A C  G A M E ][ i O S  G A M E ]

APP OF THE MONTH

Carbon Copy Cloner 6 £29.25
Backing up your Mac gets faster and easier

[ M A C  A P P ]
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APPLE CORE Hot new kit

Crave

 Image credits: DJI, TP-Link Corp Ltd10 | MACFORMAT | AUGUST 2021

> £TBC > tp-link.com/uk

> £1,249 > dji.com/uk

> Kasa’s home security products 
all have two things in common – 
they’re cheap and they work 
well. The Smart Video Doorbell, 
then, has the chance to be a really 
popular option. It stores locally on 
a MicroSD card or can send footage 
to the cloud, sports a full 2K sensor 
capturing footage in 1080p, has 
built-in face recognition, two-way 
audio, a plug-in chime released 
alongside it, and everything else 

you’d expect from a smart doorbell. 
And all at what will almost certainly 
be a lower price than its rivals. 

We say ‘almost certainly’ 
because parent company TP-Link 
has so far said little. We’re not 
even sure when the Smart Video 
Doorbell will be out, but if previous 
trends hold true, keep a look out 
for an even cheaper specced-down 
version potentially landing under 
the TP-Link brand.

> All it takes is a little move of the 
lens position to turn a camera drone 
from a serene filming experience into 
a full-on thrill ride of a flyer; placing 
the camera on its nose makes DJI’s 
first-person-view drone the latter. 
Of course, the idea is you’ll be using 

the FPV to make a big move rather 
than a little one, so it’s a camera made 
to be viewed through goggles at speed: 
a 150° 4K viewpoint – broadcast at HD 
resolutions back to DJI’s own headgear 
at up to 120Hz – gives you a slick 
experience, essential in a world where 

low frame rates can cause motion 
sickness. Every early report says it’s an 
absolute blast to fly, and while we don’t 
see DJI troubling the dedicated racing 
drone market any time soon, this seems 
to be the best way for a beginner to get 
into the world of face-first flying. 

Kasa Smart Video Doorbell

DJI FPV Combo
1

2

THE GEAR WE’RE LUSTING AFTER
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Top gear APPLE CORE

 Image credits: Devialet, nomadplug, Systemic Games AUGUST 2021  MACFORMAT | 11

> From £1,890 > devialet.com

> From $40 (about £30) > pixels-dice.com

> $76.44 (about £55) > nomadplug.com

> Devialet’s new speaker, the 
Phantom I, can hit between 
103dB and 108dB depending 
on how much you spend. 
Both models make the most 
of Devialet’s fondness for 
acronym-based technology: 
the company’s patented ADH 
(Analog/Digital Hybrid) 
amplification; SAM (Speaker 
Active Matching) tech 

accurately balances the 
amplifier to the output 
of the drivers; ACE (Active 
Cospherical Engine) doctors 
sound output to emit it evenly 
in all directions; and HBI (Heart 
Bass Implosion) smashes you 
around with sound. There’s 
better connectivity, too, with 
the ability to now plug in 
analogue sources.

> Tabletop gaming has taken 
a serious knock over the past 
year, and so many sets of 
polyhedral dice remain 
unrolled. But what if there was 
a way to smarten those platonic 
solids up; get them connected to 
the world? That, to us, is the real 
selling point of the Pixels. 

They can have all the 
flashing lights they like, and 
indeed they do pack individual 

RGB LEDs that can glow through 
translucent dice or shine only 
through the numbers on 
the opaque versions, but it’s 
their connectivity that really 
sells them. Roll, and your phone 
will know exactly what you’ve 
rolled; in turn, that means your 
gaming friends playing on 
services like Roll20 will know 
about it – and they’ll know you 
haven’t been fudging any rolls.

> The Nomadplug has been on 
our gadget radar since it was 
first Kickstarted in 2018, but 
it’s only now coming to the 

market. A travel adaptor that 
(at last!) doesn’t look like 

it was designed and 
manufactured in the 
1970s, the Nomadplug 

is modular, colourful, 
and clever, and 
suitable to just toss 

in your bag. You can chop and 
change to convert any kind of 
plug into any other, and the socket 
section cleverly folds down so 
you won’t be creating a tripping 
hazard if it’s plugged into the 
wall. It also includes a matching 
18W USB-C charger, itself 
adaptable to fit international 
plugs, so you can (in theory) 
cut down on the number of 
devices in your hand luggage.

Devialet Phantom I

Pixels

Nomadplug
4

3
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MATT BOLTON…

APPLE CORE Opinion
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ABOUT MATT BOLTON
 Matt is the editor for Apple and home 

tech at T3 and has been charting 
changes at Apple since his student 
days. He’s sceptical of tech industry 
hyperbole, but still gets warm and 
fuzzy on hearing “one more thing”.

IS REDISCOVERING HIS MUSIC 
THANKS TO SPATIAL AUDIO, 
BUT HASN’T DECIDED YET IF 
HE ACTUALLY LIKES IT OR NOT…

As I mentioned, though, the mixes have 
been tinkered with. Voices are raised or 
lowered, instruments have new effects, extra 
flourishes are thrown in. I kind of hated it at 
first – like someone snuck in and swapped 
my pillow for another one that’s really nice, 
but I liked my old one! Still, I started 
switching back to the non-Atmos version 
of songs just as a trial, and they felt so… flat. 
I immediately missed having Lady Gaga 
warbling around my head like a tuneful 
ghost who haunts me.

Now I’m enjoying working through as 
many Dolby Atmos songs as I can find just to 
hear what the new spin on them is. So it’s fair 
to say I’m coming around quickly. Though 
I’m getting to the point where all that’s left is 
Sum 41, so I really hope Apple has a robust 
schedule for adding new songs. 

his issue, I wanted to write something about 
spatial audio, because it’s just arrived in the 
Music app as I write this, yet only a fraction of 

people who see that Dolby Atmos logo next to songs will 
be able to actually try it, because it remains limited to 
AirPods Pro and AirPods Max owners so far. Well, I say 
people will see the Dolby Atmos logo next to songs, but the 
selection it’s available on right now is both limited and kind 
of odd – an alarming amount of hair metal and 2000s emo 
rock – so maybe you won’t see it that often yet.

And the reason I want to tell you what it’s like is because 
it’s… not what I expected. 

It’s not the same as increasing the quality of your music 
source, or even your speaker system. But it is a little bit like 
that. And it’s not like moving from mono to stereo. Though 

it’s not not like that.
What it’s most like is 

listening to a live version 
of an album instead of the 
regular studio recording. 
Not a live album recorded on 
stage with a crowd, and the 
chaos that comes from that. 
It’s a live version like Pink 

Floyd in Pompeii, playing a deliberately different and crafted 
version of a song you know. But it feels even more like you’re 
there, because of the object-based nature of the format.

Dolby Atmos’ big innovation is that it can support sounds 
as ‘objects’ – rather than just having songs flattened into a set 
number of sound channels, instruments can all remain as 

their own individual elements, which 
means they can be positioned in 3D in 
your ears, and treated in different ways. 
I’d actually say that music sounds more 
like 2.5D than 3D – like you’ve opened 
it from being flat on the page to being 
a pop-up book. It’s not like it’s coming 
from all around you, but it’s not 
pumping straight from headphones into 
ears any more. There’s a bubble around 
you with music positioned in it. Adding 
to this is that all the parts of the track 
feel more separated, like they’re being 
played by a group of people, rather than 
being squished into one file.

Spatial audio is like 
listening to a live 
version instead of 
a studio recording

I’ve been listening on AirPods Max, but 
there’s an AirPods 3-shaped hole in this 
entire conversation. Coming soon, surely.

T

Weirdly, Atmos tracks are all quieter, so having the 
volume way up (as we have here) is necessary.
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> To enter the competition, you can visit our website at bit.ly/MFCorelDRAW (web address is 
case sensitive).
> For full terms and conditions, go to bit.ly/MFCorelDRAW. By sending your entry, you agree 
to these competition rules and confirm you’re happy to receive details of future offers and 
promotions from Future Published Limited and carefully selected third parties, if you 
have given us permission to do so on the entry form.
> This competition closes on 26 July 2021. Over 18, GB residents only.
> The winners’ details will be shared with Corel Corporation for the purpose of providing prizes.

 Whether you work with vector 
projects or digital painting and 
pixel editing, CorelDRAW Graphics 
Suite 2021 is a superb option. As 
we said in MF365, it is “an excellent 
choice for almost any graphic design 
work.” This issue, two lucky winners 
will each receive a one-year 
subscription to the suite.

The Graphics Suite comes with 
several bundled apps, with one of the 
best being CorelDRAW. This vector 
drawing tool is perfect for all manner 
of graphic design tasks, from preparing 
marketing materials to creating 
detailed architectural blueprints 

to making beautiful artwork and 
illustrations. It is full of new features, 
including perspective and progressive 
image-editing tools, plus a more 
flexible design space. It even lets you 
collaborate and comment in real time 
on almost any device.

If pixel painting is more your style, 
there’s Corel PHOTO-PAINT. This has 
had a major update, and we love the 
revamped colour replacement tool. 
PHOTO-PAINT is even better when 
paired with an iPad and Apple Pencil 
in Sidecar mode, letting you make 
quick, fluid, pressure-sensitive 
adjustments that feel utterly natural.

HOW TO ENTER…

AUGUST 2021 | MACFORMAT | 13

> THE QUESTION
To be in with a chance of winning one 
of two one-year subscriptions to 
CorelDRAW Graphics Suite 2021, 
just answer this question:

How many fonts are included with 
CorelDRAW Graphics Suite 2021?

A) 250
B) 500
C) Over 1,000

> For more information about 
CorelDRAW and Corel’s other apps 
for your Apple devices, head to the 
company’s website at corel.com.

A copy of CorelDRAW Graphics Suite 
2021 for all your graphic design needs

There’s even more included, like 
Corel Font Manager that comes with 
over 1,000 bundled fonts, the AfterShot 3 
HDR raw image editor, the PowerTRACE 
bitmap-to-vector tracer, and much more. 
That means whatever your flavour of 
graphic design, you will have the tools 
on hand to do the job.

Win 

PRIZES
WORTH
£598

In association with
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For our latest 
subscription offer 

see page 32!

WRITTEN BY CHARLOTTE HENRY  

hatever Apple device or 
services you use, there 
was a lot packed into 
Tim Cook’s WWDC 

2021 keynote address in June.
iOS and iPadOS 15 were previewed, 

as were watchOS 8 and tvOS 15. For 
developers, there were a host of new 
APIs too. One of the fun bits of 
information that we learn at every 
WWDC is what the latest version 
of macOS will be called. Apple has 
once again decided to continue the 
theme of naming it after places in 
California, calling the upcoming 
iteration ‘Monterey’, and it looks like 

it’ll be known as macOS 12 too – if 
the screenshots of the developer beta 
posted online prove to be accurate.

macOS Monterey
Productivity is key to macOS Monterey. 
For instance, it will bring Shortcuts to 
the Mac, meaning you can more easily 
perform regular tasks. Both pre-built 
actions and fully customisable options 
will be available, with Shortcuts Editor 
coming to the Mac too. It will also be 
possible to import existing Automator 
workflows into Shortcuts, and Shortcuts 
will be integrated across the whole 
operating system, including Finder, 

Spotlight, and Siri. Any Shortcut can 
be shared with one click the same way 
other links currently can be.

AirPlay to Mac will enable you to 
share content from an iPhone or iPad 
and play it on a Mac whilst also using 
the computer’s speakers. There are 
new accessibility features coming to 
the Mac too, including alternative 
image descriptions from Markup 
and improved Full Keyboard Access 
and new cursor customisation options.

On all devices
Many of the new features previewed 
will work across macOS Monterey, 

W

Discover the new features coming to your Apple kit this 
autumn – from major FaceTime changes to iCloud+
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Some had thought Apple’s promotional 
imagery was hinting at the company’s 
rumoured AR/VR glasses, but there were 
no hardware announcements at WWDC 2021.

iPadOS and iOS. This includes Quick 
Note, which lets you jot down notes on 
any app or website in order to capture 
a thought or idea. Links from an app, 
websites in Safari or addresses in Maps 
can be saved within Quick Notes. 

These are all saved in the Notes app, 
which is getting a refresh too. Mentions 
will enable you to tag friends, family, or 
co-workers so they can be kept informed 
and collaborate with you, and the handy 
Activity View gives an overview of 
everyone’s’ edits. Tags can be added 
to Notes to make them easy to find in 
the new Tag Browser and tag-based 
Smart Folders.

One of the new features that really 
caught our eye is Live Text, which 
works across iOS, iPadOS and macOS. 
It means any writing contained in a 
photo can be turned into text on your 
Mac, iPhone, or Pad. The examples used 
in the keynote included a photo with 
a phone number on an awning outside 
a restaurant. With all the new operating 
systems, you will be able to highlight 
that kind of text and make the call 
directly. Another good example from 
the presentation showed notes written 
a whiteboard. Take a snap and all the 
points written down can be converted 
into text in a document. Brilliant.

Then there’s Focus. This is a set of 
tools that lets users decide what alerts 
get through and even influences the 
layout of a device’s Home Screen. 
There are both out-of-the-box and 
customisable options on all devices. On 
iPhone and iPad, it’s possible to create 
Home Screen pages with apps and 
widgets that apply to different settings.

More FaceTime
FaceTime took up a significant chunk 
of the presentation, mostly thanks to 
SharePlay. This let’s a group of people 
watch or listen to the same content at the 
same time. It works with Apple Music 
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and third-party content providers 
including Disney+. Apple is taking a leaf 
out of Zoom’s playbook too, enabling you to 
schedule calls in FaceTime and send other 
participants a link. And this even works on 
Android and Windows devices via the web.

An upgrade for Safari
The Safari web browser is getting an upgrade 
across all platforms. The colour of the tab bar 
will dynamically change to match whichever 
website you’re currently on. Also new are Tab 
Groups, which will let you save and organise 
a group of webpages around a topic or project 
and these sync across Mac, iPhone and iPad.

iCloud+
iCloud+ is premium iCloud, but with more 
features and at no extra cost. Many of the 
additional features focus on privacy. They 
include Hide My Email, which generates 
a random, single-use email address, useful 

For Apple 
silicon only >
> While there are lots of 

exciting new features in 

Monterey, a significant 

number of them will only 

work on Macs powered by 

an M1 chip (and, no doubt, 

future generations of Apple 

silicon). The new Portrait 

Mode in FaceTime, Live Text in 

photos, and improvements to 

maps such as a 3D globe of 

the earth and more detailed 

maps in major cities, including 

London, will only work on M1 

machines. And the expansion 

of text-to-speech to more 

languages, and on-device and 

unlimited keyboard dictation, 

will also not work on Intel 

Macs. This is particularly 

notable because a lot of Mac 

users still have Intel devices, 

and Apple is even expected 

to release new ones in the 

future, with an Intel-equipped 

Mac Pro reportedly scheduled 

for next year.
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SharePlay means you can share all sorts of content with 
friends or colleagues on a FaceTime call.

Continuing with the theme 
of California landmarks, Craig 
Federighi introduces Monterey.

for when you’re signing up for things; 
expanded HomeKit Secure Video support; 
and iCloud Private Relay. The latter is similar 
to a VPN. It routes your web traffic through 
other servers, hides your IP address from 
websites, and hides your web traffic. It also 
adds a second server to the chain, meaning 
that not even Apple can follow you around the 
web. iCloud+ will work on all Apple devices 
running iOS 15, iPadOS 15, and macOS 12. 

Other privacy controls
Building on App Tracking Transparency, 
Apple is introducing Mail Privacy Protection. 
This will enable you to decide whether emails 
can collect data about you, such as whether 
you’ve opened a message opened or not. 

macOS Monterey also comes with a 
recording indicator, just like in iOS 14, 
enabling you to see whether apps are 
accessing your microphone or not.

iOS 15
Weather is getting an overhaul in iOS 15. It 
will offer full-screen maps and the layouts 
will change based on the condition. The 
animated backgrounds are being redesigned 
too in a bid to better reflect the position of 
the sun and precipitation levels. There will 
be notifications that highlight when rain or 
snow starts and stops. 

Maps has also been upgraded. There will 
be enhanced details in cities to provide better 
reflections of neighbourhoods, commercial 
districts, elevation, and buildings. There are 
also new road colours and labels, as well as 

Rafi
eie

ngli
sh

cli
nic.

co
m



WWDC 2021 APPLE CORE

AUGUST 2021 | MACFORMAT | 17

custom-designed landmarks. And Maps will 
finally get a new night-time mode too.

iPadOS 15
iPadOS 15 will finally bring the full widget 
experience to iPad, after mysteriously missing 
out last year. You will be able to customise 
and place different-sized widgets on your 
Home Screen with new widgets for the App 
Store, Find My, Mail, Contacts and more. 
iPadOS 15 also sees the arrival of an iOS 
14-style App Library on iPad, making it easy 
to cut Home Screen clutter, while neatly 
automatically arranging apps by category.

Multitasking has been improved with a 
new menu at the top of apps, making it easier 
to access Split View and Slide Over mode (see 
p6), but one of the most impressive additions 
is Universal Control, which enables you to 
seamlessly move files between your iPad and 
Mac using your Mac’s trackpad. You can even 
use your Mac keyboard to type on iPad too.

The iPhone’s Translate app is also coming 
to iPad in iPadOS 15, enabling you to receive 
live translations during face-to-face chats. 
Finally, Swift Playgrounds is coming to iPad, 
enabling you to create and submit your own 
app to the App Store from the device.

And there’s 
more… >
> Apple crams a lot into its 

keynote presentations, and 

there were a lot of new things 

in all the updated operating 

systems. There are also 

features that don’t quite make 

it to the stage (or screen). Here 

are some of the new features 

that you may have missed.

> Low Power Mode – this 

mainstay of mobile devices 

is now coming to your Mac, 

helping you to keep it running 

longer when you can’t charge.

> Account Recovery Contacts 

– users can set these to help 

make it easier to regain access 

if you need to reset your 

password and regain access 

to your account.

> Digital Legacy – each user 

can designate people as 

Legacy Contacts who will be 

able to access the account 

should they pass away.

> Translation - available 

system-wide, you’ll be able 

to translate text from a web 

page, photo, etc.

> Notifications for AirPods 

– in iOS 15, Siri can announce 

notifications on AirPods. 

> Spatial audio – AirPods Pro 

and AirPods Max will deliver 

surround sound and 3D audio 

when used with your Mac.

A little late to the iPad party, iPadOS 15 brings the full 
Widgets experience to the tablet screen.

watchOS 8
Big changes are coming to the Apple Watch. 
watchOS 8 will bring a redesigned Home app 
and improvements to messages, enabling you 
to combine Scribble, dictation, and emoji in 
one message. Also new is the Contacts app, 
plus Breathe is being renamed Mindfulness 
and will offer improved breathe functionality 
and include a new Reflect session type. 
Fitness+ is also getting new sessions – Tai chi 
and Pilates. Staying with heath and fitness, 
watchOS 8 will also enable you to track your 
sleep respiratory rate. Accessibility features 
designed to support those with limb 
differences is also new.

Apple made a big deal about new Key 
functionality that is part of both iOS 15 and 
watchOS 8 (on an Apple Watch Series 6) – 
participating car manufacturers and other 
providers will enable you to use your watch 
or iPhone to unlock things like your vehicle, 
your hotel room, and so on. US users will 
be able to store ID cards too. 
 
tvOS 15
While tvOS doesn’t normally get major 
changes, new features this year include 
SharePlay and Shared with You, as well as 
spatial audio. You’ll also be able to set your 
HomePod mini as the default audio output, 
instead of having to select it manually.

Focus enables you to filters notification types so you can 
receive important info but not be distracted by other stuff.

macOS is getting spatial audio 
support with AirPods Pro and Max.
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hat do you love most about your 
Apple devices? For us it’s that 
every one of them is packed with 
possibilities. There isn’t a single day 

that passes when we don’t discover something new 
our Apple devices can do, whether that’s a cool 
thing baked into the operating system, an app 
that opens up a whole new world or a toggle 
that can turn off some of life’s irritations. 

In this guide, we’re going to share some of our 
favourites from the whole Apple hardware family. 

Whether you’ve got an M1 Mac or an iPad Air, an 
Apple TV or an Apple Watch, an iPhone or an iPod 
touch we think you’ll find some surprising things in 
these pages: apps to excite and delight, features 
that’ll save you valuable time, tools to help you get 
things done and things that’ll bring you some fun 
when the work or school day is done. Some are 
serious, some are spectacular and some are silly; 
whether you’re a Mac beginner or an experienced 
Apple aficionado, we think you’ll find some useful 
ideas, apps and projects here.

AUGUST 2021 | MACFORMAT | 19
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Work, play and everything in-between

1 In the Music app (or iTunes on 
older macOS versions), you can 

display a psychedelic light show 
which reacts to the music as it plays. 
Press ç+T to start and the ß+/ key 
to display the keyboard controls: M 
changes display mode, A and S add 
and subtract bits to or from the light 
show and I shows or hides the track 
info. If you want to keep it old-school, 

select Window > Visualiser Settings > 
Classic Visualiser and you can see the 
visualiser from the original iTunes. It’s 
the same menu option to go back to the 
modern visualiser, but this time just 
choose Visualiser. 

Want to see it on your smart TV? 
If it has AirPlay you can mirror your 
Mac display and see the light show 
on the big screen.

Do more with 
Spotlight

2 Spotlight isn’t just there 
to find files and launch apps. 

It can also save you from opening 
Safari when you need to perform a 
quick calculation or conversion. For 
example, if you press ç+[spacebar] 
and then type ‘999 USD in GBP’, it’ll 
do the currency calculation for you; 
if you type ‘68F’, it’ll convert it to 
Celsius; and if you type ‘1249/36’, 
it’ll work out the monthly cost of 
buying a new 24in iMac over a 
three-year period. 

Spotlight also enables you to 
search with specific criteria, such 
as ‘kind: PDF’, to get definitions by 
using the keyword ‘define’, to get 
the weather for a location by typing 
‘weather London’ or get football 
scores with ‘Man United scores’.

4Avery makes T-shirt transfers 
to print and iron on to any 

garment, and has an online tool to 
help you with the design. Pop along 
to avery.co.uk/fabric-transfers, go to 
Templates > Design & Print, and you 
can do everything in Safari. Once 
you’ve printed the transfer, it just 
takes two minutes to apply. 

Prinnnntttt TTTTT----sssssshhiirrtss

3Need to sign a document? 
No problem: if you have a Mac 

laptop or a Magic Trackpad you 
can handwrite on the trackpad 
to sign PDFs. Simply open the 
document in Preview, click on the 
Markup logo next to the Search box 
and then look for the Signature icon. 
Select Create Signature and you can 
now sign with your finger.

Sign your name

FEAAAATTTTTTTUUUUUUURRRRRRRREE 57 amazing projects
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8 You don’t need an image editor 
to remove backgrounds or put 

someone from photo A into photo B: 
all you need is Preview. You can do 
all kinds of handy things here. 

For example, if you want to get rid 
of everything that’s a particular colour, 
you can bring up the Markup Toolbar, 
select the Instant Alpha icon – it looks 
like a magic wand – and simply click 

and drag on the colour that you want 
to make transparent. 

If you want to copy a person or 
object from one photo to another, 
change the selection tool in the Markup 
toolbar to Smart Lasso, then trace the 
person or thing you want to copy. 
You don’t need to worry about being 
accurate; Preview analyses the image 
to find the object or person’s outline.

Make a meme

7 Internet memes are visual dad 
jokes for every age and gender, 

and making them on your Mac is 
really easy even if you don’t have 
a photo editing app installed. For 
example, in Preview you can open an 
image, bring up the Markup toolbar 
and then add text over the top. 
Change the font to Impact for that 
all-important meme look and then 
either save the image or export it 
in the appropriate format.

If you’d rather do it with even less 
effort, Meme Maker (99p in the App 
Store) has 172 popular memes ready 
for you to use and edit, and you can 
drag and drop your own images to 
create new ones too. 

Alternatively, you could point 
Safari at Imgflip’s meme generator 
(imgflip.com/memegenerator) and 
make memes for free.

Make secret notes Read to you

5 Keychain is a great password 
manager, but it’s also a great 

place to keep secure notes that 
nobody else can access. Launch 
Keychain Access (it’s in Applications 
> Utilities) and then click on File > 
New Secure Note Item. Once saved, 
the note will be password-protected 
so only the title is visible.

6 The accessibility features in 
macOS include something 

that’s really useful for everyone: 
Speak Selection. Once enabled in 
System Prefs > Accessibility > Spoken 
Content, you can highlight text and 
press å+œ to have your Mac read 
it out. It’s really handy for writers 
and for giving your eyes a break.

57 amazing projects FFFEEEAAAAAAAAAAAAATTTTTTTTTUUUUURE 
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9 Since the release of Mojave 
and iOS 12, your Mac has 

been able to use a brilliant feature 
called Continuity Camera. This 
enables you to use the camera in 
your iPhone, iPod touch or iPad 
directly from your Mac: you can take 
a photo and add it to your Keynote 
presentation, or scan a document 
and embed it in Pages. The feature 
is available in Pages, Numbers, 
Finder, Mail, Messages and many 
third-party apps too.

You’ll need the appropriate 
iOS or iPadOS device to be using 
the same Apple ID as your Mac, 
and both it and your Mac will need 
to have Bluetooth and Wi-Fi on. 
≈-click anywhere in your document 
(in Finder, ≈-click on the desktop 
or Finder window) and select Import 
From iPhone or iPad. In some apps 
the option will say Insert rather than 
Import, but it’s the same thing.

You should now see a list of 
the available iOS or iPadOS devices, 
so for example, when we do it our 
iPhone and iPad both appear. Now 
all you need to do is choose what 
you want to do: take a photo, scan 
a document or add a sketch. 

Use your other 
devices as 
cameras or 
scanners

Put multiple files in one PDF

10 You can use custom icons for 
folders and external drives. 

Open the image you want to use in 
Preview and copy it to the clipboard 
with ç+C; then ≈-click on the folder, 
folder alias or drive in Finder, choose 
Get Info, click on its icon in the info 
window and press ç+V to paste. You 
can replace all your folder and drive 

icons with emoji by getting appropriate 
ones from Google Images, but you’ll 
find that many don’t have transparent 
backgrounds. In this case, open the 
image in Preview, bring up the Markup 
toolbar and use the Instant Alpha tool 
to select its background. Tap delete to 
remove the background, then ç+A, 
ç+C to select and copy the emoji.

FEAAAATTTTTTTUUUUUUURRRRRRRREE 57 amazing projects

11  You can send a collection of 
images or PDFs as a single PDF. 

Open one of the files, press ç+ß+å 

+S for the Save As dialog box, and 
save it as a PDF. Now go to Edit > Insert 
> Page From File to bring in the other 
PDFs or images. You can reorder them 
in the thumbnails sidebar, and if you 
want to annotate your pages it’s just a 

matter of bringing up the Markup 
toolbar and scribbling or adding text 
boxes. When you’re finished, save your 
doc and use the Share icon to send it 
to your desired recipient. You can also 
extract individual pages from PDFs. 
≈-click the page thumbnail and select 
Export As. You can now export that 
page as a PDF or image file.
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Explore forbidden places

16 One of the most fascinating 
things you can do on your Mac 

is explore the world. Maps’ 3D city 
views are great, but things get really 
interesting when you use the rival 
Google Maps and go down to street 
level in Safari. Fancy seeing inside the 
control room of Chernobyl? Visit 
tinyurl.com/mfcontrolroom and you 
can see inside, as well as explore the 

area around the ruined, radioactive 
reactor in complete safety. Other 
Street View places include Abbey 
Road Studios, Machu Picchu, the 
black waters of Loch Ness and the 
Base Camp on Mount Everest. You can 
access these on all your devices but 
we think they’re most impressive on 
a Mac that has a big screen or is using 
AirPlay to mirror its screen to a big TV.

12 Photos and GarageBand both 
support plug-ins. For Photos, 

many plug-ins (or extensions) are 
included with other apps – Affinity 
Photo (£48.99) shares its Develop, 
Haze Removal and other tools, while 
Pixelmator Pro (£19.99) shares the lot, 
giving you access to all of its tools 
without you leaving Photos at all.

GarageBand is expandable too, 
with plug-ins adding extra instruments, 
controls and effects. The choice is 
huge and ranges from fun free tools 
such as Izotope’s Vocal Doubler 
(izotope.com) to the same pro-level 
plug-ins designed for Logic Pro X: 
guitar, amp and synth modellers, 
compressors, mastering plug-ins, etc.

Copy between 
devices

14 BOINC enables your Mac 
to take part in cutting-edge 

scientific research, such as the 
search for signs of alien life or the 
cure for deadly diseases. Download 
the BOINC app (boinc.berkeley.edu), 
pick a project to support and your 
Mac will donate spare processing 
capacity whenever it can.

15 Like the autocorrect 
suggested words you get 

when you type on iPhone or iPad? 
You can get the same feature in 
many Mac apps such as Notes and 
writing apps: press å+œ to bring 
up a drop-down menu of word 
suggestions. You can navigate 
through the list with the arrow keys 
and then press ® to choose one.

Look for aliens

13 Universal Clipboard copies 
from your iPhone/iPad/iPod 

touch to your Mac or vice-versa. 
Provided both devices share the 
same Apple ID it’s just a matter of 
copying on one and immediately 
pasting on the other, such as 
copying a link or text from Safari 
on your phone and pasting it into 
Pages in your Mac.

57 amazing projects FFFFFFEEEAAAATTTTTTTTTTTTUUUUUUUUURRRRE 
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18 If your iPad and Mac are 
connected via Wi-Fi or 

Bluetooth you can draw in Mac 
documents with your iPad, 
finger and Apple Pencil. ≈-click 
in your Mac document, choose 
Add Sketch from the shortcut 
menu and select Done to add it 
to your Mac document. You can 
use your iPad for Markup in PDFs 
and images too.

Draawwwwwww oooonnnnn yyyoouurr MMMMMMaaaaccc

17 One of our very favourite 
features in GarageBand is its 

smart instruments, which enable 
you to play guitars, bass and 
keyboards even if you don’t know 
how to play them. By far the best of 
these is Drummer, which effectively 
puts a human drummer inside your 
iPad. That’s because Apple has 
sampled a range of professional 

drummers playing on a variety of 
different kits in all kinds of musical 
styles, and those samples have then 
been teamed with a very clever bit of 
software that plays and sounds just 
like a real drummer. It’s completely 
customisable, packed with presets and 
you can even get it to listen to your 
playing and adjust what it’s doing 
accordingly. And best of all, it’s free.

19 Your iPad is a wonderful 
device for entertainment 

and education, but there are lots 
of reasons why you might not want 
to share the entire thing with a 
small person. There may be content 
you don’t want them to access, 
games you don’t want them to play, 
or data you don’t want them to 
accidentally delete. 

That’s where Guided Access 
comes in. Once enabled in Settings > 
Accessibility > Guided Access, all you 
need to do is open the app you want 
them to use and then tap the Home 
button three times (or triple-click 
the top button if you have an iPad 
without Touch ID). You can now 
disable specific parts of the screen 
as well as turn off the volume 
buttons, keyboards, touch screen 
and other features. 

Share with kids 
without fear

FEEAAAAAAAAATTTTTTTUUUUUUUUURREEE 57 amazing projects

Experience art, make music and 
explore faraway places
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23Apple’s adventures in 
augmented reality (AR) 

could change the way we shop: 
instead of going to the shops, 
the shops bring their stuff to 
you. One of the best-known 
retailers experimenting with 
AR is IKEA: the IKEA Place app 
enables you to see how items 
of furniture will fit and how they 
will look in your actual home. 
The Wayfair app has similar 
functionality, placing 3D models 
of furniture items over the view 
from your camera. If your budget 
is a little higher, John Lewis offers 
a similar feature with Virtual Sofa 
which, as the name suggests, 
enables you to shop for sofas in 
AR; the interior design app Houzz 
has a View In My Room feature 
that places products in real-time 
camera views.

If you want to get really serious 
about home design, the Magicplan 
app uses AR and (on the iPhone 12) 
LiDAR scanning to create detailed 
room plans and 3D models with 
the minimum of effort. If you need 
something a little less powerful, 
PLNAR also uses AR to create 
room models in a flash.

Have fun 
with furniture

21 Google Earth enables you 
to zoom from orbit to street 

level anywhere in the world. What 
makes the app special isn’t just its 
massive maps; it’s the Google Earth 
Voyager and the guided tours from 
the likes of the BBC, NASA, National 
Geographic and many more. We 
particularly love Voyager’s time-
lapse tours.

20Many art galleries provide 
very high-res images of 

their artworks. For example, at the 
National Gallery (nationalgallery.org.
uk), you can get closer to a Vermeer 
than you ever imagined; the Rijks 
Museum (rijksmuseum.nl) does the 
same for Rembrandt. It’s amazing 
to see these artworks in such 
incredible detail.

Expppllloooooorrreeeeee EEEaarrtthhExpppllloooooorrreeeeee cccclaassssiicccc aaarrrt

22Wish you weren’t here? Go 
somewhere else and let your 

iPad screen be a window on another 
part of the world. We’re writing this 
looking at a beach in LA via earthcam.
com, but if we preferred we could visit 
the Sanctuary of Our Lady of Lourdes 
or the Woltsztyn Steam Train Depot in 
Poland courtesy of worldcams.tv. There 
are lots of webcam apps for iPad but 

we’d recommend sticking with Safari 
instead: live webcam sites tend to be 
free whereas apps tend to charge 
money. One of our favourite such sites 
is WindowSwap (window-swap.com), 
which enables you to take a look out 
of somebody else’s window. It sounds 
boring but it’s surprisingly fascinating, 
and if you don’t like one view, you can 
see another with a single tap.

57 amazing projects FFEEEEEEEEAAAAAAAAAAATTTTTTTTTURE 

Rafi
eie

ngli
sh

cli
nic.

co
m



Rafi
eie

ngli
sh

cli
nic.

co
m



AUGUST 2021 | MACFORMAT | 27

24Augmented Reality (AR) 
apps make the impossible 

appear right in front of you.  
ARcheology – Dig Up History 
(£4.99) is a great example of 
that. It puts dinosaurs under your 
floorboards, in the garden, in the 
park or anywhere else you can point 
your phone’s camera, so you can 
discover a T-rex under the terrace or 
a diplodocus under the dinner table. 

The App Store is packed with 
great AR apps, with Mission To Mars 
AR enabling you to drive the Mars 
Rover; Civilisations AR bringing 
treasure directly to you; and 
Big Bang AR showing you the 
beginnings of the universe. And if 
you’d rather blow things up than 
blow your mind, there are AR apps 
that enable you to cause chaos from 
the safety of your sofa. Smash 
Tanks (£1.99) turns your tabletop, 
carpet or floor into a battlefield.

Dig uuuuuuppppp ddddddiiinnoossaauuuurrrrrsss

Scan documents 
in easily

25 If you have an iPhone SE/ 
iPhone 6s or later, you 

can use the built-in Measure app 
to measure things simply by 
pointing your phone at them. It’s 
even better on the iPhone 12 Pro/
Pro Max thanks to LiDAR scanning. 
Just set the start and end points 
and Measure calculates the distance.

27 iOS has a built-in document 
scanner which is great for 

capturing things like business cards 
or receipts, but if you really want to 
use your iPhone as a scanner it’s 
worth investing in a dedicated app 
such as Genius Scan 6.0. Those of 
us who used handheld and flatbed 
scanners in the bad old days can 
only sit in open awe of its features, 
which include ignoring unrelated 
objects and shadows, detecting and 
fixing hard edges, automatically 
adjusting the white balance, 
automatic keyword detection and 
tagging, batch scanning and cloud 
storage and sync. Not only that but 
its optical character recognition is 
incredibly fast and very accurate, 
turning scanned documents into 
editable, exportable text. 

26 The Shortcuts app is an 
amazing tool for tinkerers, 

enabling you to set up automation 
based on “if this happens, do that”, 
but many iPhone users may not be 
aware of its powers. Open the app 
and tap on Gallery to see existing 
shortcuts you can add to your phone 
or adapt to your own requirements.

Meaaasssssuuuuurrrrreeeeee lllikkee mmmaaaaagggggiicc

57 amazing projects FFFFFEEEAAAATTTTTTTTTTUUUUUUUUURRRRRRRE 

Be the iPhone Indiana Jones, explore 
augmented reality (AR) and make some noise

Set shortcuts
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28 Turn one of your videos 
into an animated GIF. 

Create your own Share shortcut 
using Shortcuts, or install a 
dedicated GIF app such as Giphy, 
which enables you to make and 
share GIFs without programming. It 
also has a search engine to help you 
find the right GIF for any message.

32 Guitar pedals and amps 
are so last century. With 

apps such as Amplitube (£23.99), 
use your iPhone as a guitar rig, 
creating original tones or replicating 
the world’s greatest guitarists and 
recording into your favourite music 
app. All you need is an audio 
interface such as the £33 iRig 2. 

Make a GIF Find the secret 
scanner

Be a guitar god

29 It’s nice to show off our 
photos. But that doesn’t 

mean we want friends and family to 
see everything in our library. That’s 
why we love the Photos app’s Hide 
Photos option. Tap the photo or 
video’s Share button, then tap Hide 
to move it to your Hidden album.

31Not getting the right results 
when taking pics in Night 

Mode? Tap the Night Mode icon (top 
of app) and you’ll see a slider: slide it 
to the right to make the camera take 
a longer shot. This works for the 
rear camera (iPhone 11 onwards) 
and selfie camera (iPhone 12).

Keeeeppppp ppphhhhhhooooootooss 
privvvaaaaatttteeeee

Makkkkeeeee NNNNNNiigggggghtt 
Moddddeeeee bbbbbeeeeeetttteerr

30 Your iPhone’s Camera app 
can recognise and decode 

QR codes. There’s also a dedicated 
Code Scanner app on your phone 
that you can only find via search. 
This opens links without sending 
them to Safari, so when you close 
the app it closes the linked page too.

33No, your EarPods don’t 
have a camera in them. 

But you can use them to take 
pictures using the volume up or 
down keys. Open the Camera app, 
point your phone and press the 
button. You can reassign the touch 
controls in AirPods but so far you 
can’t use them to do this.

34 On the iPhone 8 onwards, 
you can turn the Apple 

logo into a button using Back Tap. 
Go to Settings > Accessibility > Touch 
> Back Tap and choose a function for 
a double-tap and triple-tap, such as 
Spotlight, muting audio, or going to 
the Home Screen. Back Tap works 
even if your iPhone is in a case.

Takkeeee pppphhhhhhooooootttooss 
withhhh EEEEEaaaaarrrrPPPPPooddss

Tapp ttttthhhhheeeee bbbbbbacckk

FEEEEEEEEAAAAAAAAAAATTTTTTTTTUUURRREEEEEEE 57 amazing projects
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36We’ve all had those 
moments when we know a 

song but can only remember a bit 
of the tune. Wouldn’t it be great if 
we could just hum that bit and our 
iPhones could tell us what it is? 
That’s what SoundHound does, and 
while it doesn’t recognise everything 
it still has an impressive hit rate.

Hum a song

35Human Anatomy Atlas is 
an extraordinary app. The 

£23.99 app enables you to see and 
explore the human body in 3D, and 
each model comes with textbook 
descriptions and definitions. There 
are male and female models and 
you can use AR if you want to see 
somebody’s spleen on your sofa.

40 You’re not limited to using 
static photos for Lock 

Screen wallpaper. Use any Live 
Photo, and your chosen photo will 
animate if you press down on the 
screen before unlocking your phone. 
Pick, move and zoom the image as 
you would with any other and then 
tap Set > Set Lock Screen. 

37 Are you sick of sales calls 
and spam calls? If you go 

into Settings > Phone and scroll 
down, you’ll see an option marked 
Silence Unknown Callers. This will 
send a call from a number that isn’t 
in your contacts or recent calls list 
to voicemail, and you’ll get a silent 
notification instead of a ringtone.

Seeee iiinnnnssssiiddddddee yyoouurrrrsssseeeeelf

Makkkkeeeee yyyyyoooooouuuuur LLoocckkkkk 
Scrreeeeeeeeeennnnn lliiiivvvee

Sileennnncccceeeee ssssspppaammm cccaaaaalllsss

38 If you’re travelling with 
multiple iPhones, you can 

use FaceTime to turn one of them 
into a really good baby monitor. 
Position one phone in the room, call 
it via FaceTime and then mute the 
audio. The downside to this is that 
it’ll hammer the phone battery, 
and if there’s no Wi-Fi it could 
incur data charges too.

41 In Safari, you can capture 
an entire web page in a 

single screenshot. Even if it’s much 
bigger than what you can see on 
screen and you haven’t scrolled 
through it. Take your screenshot and 
then look at the top of the screen. 
If you tap Full Page, you can now 
save or share the whole thing.

42 Google Translate is the 
electronic equivalent of 

the translating fish in the Hitch-
hiker’s Guide To The Galaxy. And 
nobody has to stick anything living 
in their ear. It provides real-time 
translation of images and live 
conversations, removing awkward 
communication barriers. 

39Night Sky is our favourite 
award-winning stargazing 

app. It’s available across the Apple 
family, but we think it works best 
on iPhone – stomping around in 
the dark seeing the skies on our 
screen never gets old. It’s a brilliant 
educational resource and the 
app makes great use of AR too. 

Watttccccchhhhh yyyyyyyoooooourr bbaabbbbbyyyyy Screeeeeeeeeeennnssssshhhhhhott 
full ppppppaaaagggggeeeeeeesss

Gett aaaa BBBBBBaaaaaabbbeel FFissshhhhhSeeee tttthhhhheeeeee sssssstaarrss

57 amazing projects FFFEEEAAAAAAAATTTTTTTTTTTUUUUUUUUUURRRRE 
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Banish hotel bills, never miss a mumble, 
and get some workout motivation

Enteeeerrrrr ttteeeeeeexxxxxxt eeaasilllyyyyy

46 Are you sick of slowly 
typing text into your 

Apple TV with the remote? Use 
your iPhone, iPad or iPod touch 
instead. Make sure both devices are 
signed in with the same Apple TV 
and that both Bluetooth and Wi-Fi 
are on. You’ll get a notification any 
time there’s a text field on your 
Apple TV; just tap it and type.

48 Earthlapse Pro turns your 
Apple TV into a window on 

the International Space Station, 
with 2GB of 4K HDR visuals 
captured by astronauts as well 
as live views from the ISS’s own 
cameras. You can adjust the 
playback speed and swap the 
soundtrack for your own choice 
of ‘atmospheric’ music.

Seeee ffffrrrrooooommmmmmmm ssppaacceeeee

47Apple TV isn’t just for 
sprawling on the sofa 

eating Wotsits: it’s also your own 
personal trainer. Apple Fitness+ 
connects your Apple Watch and 
Apple TV to give you useful 
workouts that track your activity 
and let you know how well you’re 
doing, with on-screen prompts to 
help motivate you to do even better.

Get fit

43 You can use your Apple 
TV with your hotel room 

TV, streaming TV and movies 
from your iPhone or iPad. Hotel 
Wi-Fi isn’t great, but if your iPhone 
or iPad has a strong 4G/5G 
connection, create a Personal 
Hotspot and connect to that. 

44Missed a bit of dialogue 
because of a mumbling 

actor or noisy kids? Hold down 
the Siri button on the Siri Remote 
and say “what did he/she say?” Siri 
will rewind a few seconds, turn the 
volume up and temporarily enable 
closed captioning to help you too.

45 In addition to education 
apps you can mirror over 

AirPlay from your iPhone, such 
as the free Kahn Academy or the 
useful Udemy, there are dedicated 
Apple TV apps to broaden your 
mind too. For example, the entire 
TED Talks library is available for 
free, and there are paid apps from 
the likes of Coursera and Skillshare.

Bannniissssshhhh hhhhhhoooteel 
borreeeeddddddooooommmmmmmm

Donnn’’tttt mmmmmmmmiiisssss 
mummmmmmmbbbblleeeeessssss

Leaarrrnnnnnn aaaaaannnnnnyyytthhinngggg 
anyyttttiiimmmmmmmeeeee

FEEEEEEEAAAAAAAAATTTTTTTTTTUUUUURRREEE 57 amazing projects
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Make music, get supple and get your weather 
forecasts with a touch of attitude

55Apple introduced this
feature in iOS 14.5 because 

Face ID can’t see through masks. 
In your phone, go to Settings > Face 
ID and Passcode, then enable Unlock 
With Apple Watch. You’ll need to tap 
in your passcode for the first unlock 
each day; after that it’s automatic.

51We love this useful feature
within the Apple Watch 

calculator. If you tap in the total 
of your restaurant or café bill and 
tap on Tip, you can use the Digital 
Crown to select a tip percentage 
and the number of people paying. 
The app then works out everyone’s 
share of the total bill.

Unlooooocccccckkk wwwwwwwwhiilee 
masssskkkkkkeeeedddddd

Worrrkkkkk oooouuuuuttttt aa ttipp

54 There are lots of yoga
apps for your iPhone, but 

it isn’t always easy to see what’s 
on your screen when you’re 
contorting yourself into odd 
shapes. That’s where Start With 
Yoga comes in: it’s a £2.99 app that 
puts poses and routines on your 
Apple Watch to help you learn the 
basics without straining to read.

53 If you install the Shazam
app, you can use your 

Apple Watch to recognise any 
song you hear. The recognised 
songs are automatically saved to My 
Music on your iPhone and, provided 
the place isn’t too noisy, Shazam’s 
accuracy is really impressive. Just 
don’t use it to cheat at pub quizzes.

Learn yogaRecccooooogggggnnnnniiissssse 
anyy ssssooooonnnnnnggggg

49 The Apple Watch isn’t the
first device you think of 

when it comes to making music…
But WatchFunk (£3.99) enables you 
to play piano, drums, synths and 
even trumpets on your wrist. It’s a 
fun app that might help inspiration 
strike and its interface makes great 
use of the limited screen space.

56 The Mickey and Minnie
Mouse Watch faces can 

speak in their inimitable squeaks. 
Make sure Speak Time is on in the 
Apple Watch app – it’s in My Watch > 
Clock – and you’ll be able to hear 
Mickey or Minnie whenever you tap 
the display (or double-tap if your 
Series 5 or 6 display is dimmed).

50As you’ll see in our group
test (p86), CARROT 

Weather isn’t like other weather 
apps. As well as info and forecasts, 
you get a serious side order of 
snark. There are five modes ranging 
from fairly pleasant Professional to 
foul-mouthed Overkill, all of which 
can appear in face complications.

57 Don’t put a cellular Apple
Watch on eBay when you 

upgrade: give it to the kids. Family 
Setup enables you to use any Apple 
Watch from series 4 onwards as a 
GPS child tracker, although you’ll 
need an airtime contract in order 
to take advantage of its location 
features: otherwise it’s Wi-Fi only.

52Have you created a Watch
face with the perfect 

collection of complications? Press 
and hold the display and then tap 
on the Share icon and you can send 
it to friends or family. There’s a 
‘don’t include’ option that enables 
you to specify which complications 
to include and exclude.

Makkkkeeeee mmmmmmmmuuuuuusiicc

Takkeeee tttthhhheeeeee MMicckkeeeyyyyyy

Gett aaaaannnnggggggrrrrryyy wwweeaatttthhhheeeer

Tracccckkkkkk ttthhhhhheeeeee kkiddss

Shaaarrreeeeee yyyyyyoooooouurr ffaacceeeee

57 amazing projects FFFEEEEAAAAAAAAAAAATTTTTTTTTUUUUUUUURE 
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For more than 25 years, we’ve 
been helping Apple fans get the 
most from their kit.

Our tutorials and guides 
empower you with the knowledge 
to get things done in smarter and 
faster ways. 

MacFormat is for Apple fans of all 
experience levels. Whether you’ve 
just bought your first Mac, iPhone 
or iPad, or have been using one for 
years, we’ll ensure you don’t miss 
out on top tips and techniques.

Other benefits of 
subscribing to the 
UK’s best-selling 
Apple magazine…
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 Master Apple 
shortcuts

iOS 
 A tap is a brief contact of 

(usually) one finger on your 
device’s screen.
 To drag is to move a finger 

across the screen to scroll 
or pan around content.
 Swipe means move one or 

more fingers across an item 
or the screen, then let go. 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.
 Pinch means move two 

fingers together or apart, 
usually to zoom in or out.
 Touch and hold means lightly 

rest your finger on an item 
and wait for a reaction.

Your in-depth guide to 
getting more from 

your Apple kit

NEW 
IDEAS

WHAT’S INSIDE

macOS 
 ç is the Command key, 

which is also labelled cmd.
 å means the Option key, 

labelled alt or opt.
 ≈  means the Control key, 

labelled ctrl, and shown as ^ 
in shortcuts in the menu bar.
 ß  is the Shift key.
 ∫  is the Delete key, which 

deletes to the left. ƒ+∫ 

deletes to the right.
 † is the Tab key, which 

shifts the focus between 
some controls.

MAKE BIG SUR ACCESSIBLE

Contact us

 Email your queries and 
your questions to 

letters@macformat.com

Rafi
eie

ngli
sh

cli
nic.

co
m



APPLE SKILLS Mac software

36 | MACFORMAT | AUGUST 2021

Save space with Find 
Duplicates in Parallels Toolbox

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  How to find and 

delete duplicate files

YOU’LL NEED
  Parallels Toolbox 

for Mac (£15.99/year), 
macOS 10.12 or later

It doesn’t take long to fill your 
Mac’s hard drive or solid-state 
drive with clutter. Old photos 
or work files can quickly take up 

hundreds of megabytes of precious storage 
space – take a look at your folder that contains 
email attachments, you’ll find that alone is 
taking up a surprising amount of GB.

One common problem is that many of us 
tend to create duplicate versions of files that 
people send us – some photos from a friend, 
or a bunch of PDF files from a work colleague. 
There’s a tendency to automatically create 

duplicates of photos and files that we need, 
say, for work, keeping the originals safe in one 
folder while editing the duplicates in another.

There are a number of apps that can help 
you to find and delete duplicate files, but the 
one we go to most is part of the Parallels 
Toolbox suite (from parallels.com). Toolbox 
costs £15.99 per year, but it includes more 
than 30 different apps and utilities, and its 
Find Duplicates tool works very much like 
Spotlight, so it feels familiar and easy to use. 
Toolbox also offers a seven-day free trial so 
that you can check it out first. Cliff Joseph

1

Spotlight on 
duplicates

 The tool works 
like Spotlight, 

with a list of files 
on the left and a 
preview of each 
file on the right.

3

What’s in 
a name?
 The app 

doesn’t just 
look at file name 
– it looks at the 
actual content 
of each file.

2

Sort and 
delete

 You can sort all 
your duplicate 

files by file 
name, size 

or type, and 
choose which 

ones to delete.

4

File preview
 You can view 

details of each 
duplicate that 
you find, and 
preview the file 
before deciding 
whether to 
delete it.

EXPLAINED… The Find Duplicates feature 

Find and delete 
duplicate files 
and photos

1

2

3

4
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1Launch Find Duplicates
Parallels Toolbox contains a large 

collection of useful tools and utilities, and 
version 4.5 includes a new ‘dashboard’ 
that automatically shows the tools that 
you use the most. Let’s just click on Find 
Duplicates to launch it.

2Start searching
The Find Duplicates tool is very 

straightforward. You can search any 
folders for duplicate files either by 
dragging and dropping them into this 
window, or you can click Select to open 
the Mac’s standard Open dialog box.

3Select folders
You can select multiple folders 

where you want to search for duplicate 
files, and Toolbox will also search any 
additional sub-folders stored within 
those folders. Just click the ‘Search 
for duplicates’ button to start.

4Save results
Here it’s taken Parallels Toolbox 

30 seconds to scan a folder containing 
10GB of old work files. Toolbox stores the 
results of that scan too, so that other 
scans in the future will be faster even 
if you add more files to that folder.

5Spotlight on duplicates
As mentioned, the Find Duplicates 

tool works in a similar fashion to 
Spotlight, which makes it feel familiar 
and easy to use. It shows a list of the 
duplicate files it has found on the left, 
with a preview of the file on the right.

6Look beyond the name
The app doesn’t just look for 

files that have the same name. It also 
compares the content of each file. Here 
it has found three identical photos of this 
webcam, even though the three files all 
have different names.

7Go auto or inspect
By default, the app selects the oldest 

versions of every duplicate file to delete, 
and leaves the newest version alone. It 
can automatically delete all duplicates 
for you, but you can take a closer look 
at each file if you want.

8Make your selection
There are a number of other options 

available when searching for duplicate 
files. Instead of selecting the oldest file 
copies, you can tell the app to select 
the newest files instead, or tell it not 
to select any files at all.

9Sort and find files
If you’re looking for a particular 

type of file, then you can speed things 
up by sorting through files in alphabetical 
order, by file size or file type. You can 
also arrange the list in ascending 
or descending order.

 HOW TO Find and delete duplicate files 
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Make Big Sur more accessible
Right the accessibility wrongs in macOS and make it even easier to use

IT WILL TAKE
  5 minutes

YOU WILL LEARN
  How to make macOS 
Big Sur easier to use if 

you have visual 
impairments

YOU’LL NEED
  macOS 11 Big 

Sur or later

Apple’s macOS Big Sur is an 
enormous overhaul of the Mac 
operating system, with an 
entirely new look and feel 

compared to older versions. 
Not every change has been welcome, 

though. Apple’s new design includes an awful 
lot of transparent, low-contrast elements that, 
while pretty, make using the system harder 
for anyone with eyesight trouble. Throw in 
small text and plenty of moving elements 
that can cause motion sickness and you 

have a potential accessibility nightmare. 
If you find Big Sur means big problems for 
accessibility, there is help at hand… Apple 
has a range of features that can alleviate 
the most troubling problems in its operating 
system, thanks to an extensive list of 
accessibility tools (like VoiceOver) 
housed in System Preferences. 

In this tutorial, we will focus on the ways 
you can make macOS Big Sur’s visual elements 
more accessible, from increasing text sizes to 
enabling colour filters and more. Alex Blake

 HOW TO Fix Big Sur’s accessibility woes 

1Reduce transparency
Open System Prefs and click Accessibility > 

Display. On the Display tab, enable ‘Reduce 
transparency’. This makes windows and dialog 
boxes opaque and easier to read. For a 
stronger effect, tick ‘Increase contrast’.

2Contrast and colours
In the same Display tab, adjust the slider 

at the bottom to tweak display contrast. You 
can invert Big Sur’s colours (except in images) 
with the checkbox at the top. Click Classic 
Invert to also invert image colours.

Genius tip!
 To add accessibility 

shortcuts to the 
menu, go to System 

Preferences > Dock & 
Menu Bar > Accessibility 

Shortcuts and tick 
Show in Menu Bar.
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Big Sur accessibility APPLE SKILLS

3Reduce motion
Big Sur uses a lot of motion, such as when 

you switch from one desktop space to another 
and everything flies to the side. This can cause 
motion sickness. Fix it by ticking the ‘Reduce 
motion’ checkbox under the Display tab.

4Differentiate without colour
Some apps in Big Sur use colours to 

help indicate different statuses, such as your 
availability in a mail or messaging app. Tick 
the ‘Differentiate without colour’ checkbox 
on the Display tab to use shapes instead.

5Menu bar text size
Big Sur’s menu bar text can feel small 

and hard to read. To increase the text size, use 
the drop-down menu on the Display tab and 
choose Large from the list. You will need to 
log out and in again to see the changes.

6Cursor size
The cursor can also be made larger and 

easier to find. Under Accessibility > Display, 
click the Cursor tab and adjust the ‘Cursor size’ 
slider. Tick the checkbox above to increase 
the cursor size when you shake the mouse.

7Colour Filters
Now click the Colour Filters tab. You 

can enable a range of filters here, including 
greyscale and specific colour blindness options. 
Click Colour Tint to create a custom filter 
based on a selected colour and intensity.

8Zoom in
In the left-hand menu, click Zoom to 

enable various methods of enlarging text 
under your pointer. You can trigger it with a 
keyboard shortcut, by scrolling your mouse, 
or by pressing and holding the ç key.

Genius tip!
 In System Preferences, 

click Users & Groups  
> Login Options > 
Accessibility Options. 
Any features you enable 
will be available on 
the login screen.

Jargon buster
 VoiceOver is a built-in 

screen reader on the 
Mac. It reads aloud 
highlighted items and 
lets you control your 
Mac with your keyboard.

CONTINUED… Fix accessibility woes 
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TextSniper is 
an Optical 
Character 

Recognition 
(OCR) app that 

scans what’s 
on your screen

APPLE SKILLS Mac software
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Capture text with TextSniper
Recipes, presentations, PDFs… TextSniper captures text from anything

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  How to grab usable 

text from anything

YOU’LL NEED
  TextSniper (£9.99), 
macOS 10.15 or later

Have you ever encountered a 
web page that won’t let you copy 
text from it? A recipe that puts 
all the ingredients in the video 

but not on the actual page? An image you 
want to quote, or a fact-packed presentation 
slide that you need to copy from quickly? 

TextSniper can help with all of these 
things. It’s an Optical Character Recognition 
(OCR) app but instead of scanning printed 
documents it scans what’s on your screen 
– so you can grab a block of text from that 

digital magazine, that PDF, that video recipe 
or anything else you can see on your Mac’s 
display. In addition to copying the text to the 
clipboard, it can also read it aloud – which is 
handy for apps or content that doesn’t pass 
editable text along to macOS’s own text-to-
speech features – and it can also decode 
QR codes and barcodes.

Snipe and scan
TextSniper doesn’t work on every Mac: if 
you’re running macOS older than Catalina, 
you’re out of luck. But if your Mac is running 
macOS 10.15 or later, you can take advantage 
of iOS/iPadOS integration and use TextSniper 
on images captured, effectively turning it into 
a document scanner too. 

TextSniper is the kind of app we love to 
see on the Mac; it sets out to do one thing 
and do it well. And it’s reasonably priced too 
– it’s just £9.99 on the Mac App Store and it’ll 
pay for itself by saving you tons of time. You 
can download a free trial from textsniper.app.
Carrie Marshall

The Additive Clipboard is brilliant, enabling you to capture 
text after text without losing what you’ve already copied.
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Grab usable text APPLE SKILLS

 HOW TO Capture text with TextSniper 

1 Inspect the menu
When you run TextSniper it puts a little icon 

in the Menu Bar enabling you to access all its 
features. As you can see it can also connect to 
your iPhone or iPad, which is useful if you want 
to use TextSniper on a scanned document.

2Set the language
TextSniper defaults to English but there’s 

also built-in support for scanning text in a 
number of other languages. If you wish, you 
can also disable the notifications you get 
when text has been captured.

3Set the shortcuts
Although we’re using the Menu Bar 

for clarity, TextSniper is best when you use 
keyboard shortcuts: by default, ç+ß+2. You 
can change that in the app’s preferences as 
well as add new shortcuts for other features.

4Find your text
TextSniper can extract text from anything 

on screen: an image, a PDF, an application 
window, or an ebook. Simply go to the page 
or image you want to capture and use the 
Menu Bar or shortcut to capture the text.

5Get a thumbs up
If you haven’t disabled the notification, 

you’ll now see this message. You can now go 
to another page or image and extract the text 
from that. TextSniper adds captured text to the 
clipboard without erasing what’s there.

6Paste the text
You can now paste the text just as you 

would in any other app; here we’re pasting an 
extract into Notes. TextSniper tries to replicate 
formatting such as line breaks, but it can get 
confused with complex layouts.

Genius tip!
 If you want to translate 

text in an image, you 
can do it from your 
iPhone in real time: just 
install Google Translate 
or Microsoft Translator.

Jargon buster
 Optical Character 

Recognition is the 
catch-all term for 
the technology that 
analyses text in an 
image to turn it into 
an editable document.
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Corel provides 
free high-

quality clip art, 
images, fills 

and fonts
Use your iPad in Sidecar when you need fine control for 
drawing and editing faired curves using Apple Pencil.
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APPLE SKILLS Mac software

Get creative with CorelDRAW
Use its shortcuts to save repetition when creating symmetrical objects

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  To create and use 

complex objects simply 
and efficiently

YOU’LL NEED
  CorelDRAW Graphics 
Suite 2021 (from £299/

year), macOS 10.15 
or later

Faithful drawing with physical 
media is repetitive. This 
introduction to CorelDRAW 
shows how to use its tools to 

save time and effort, getting your Mac to do 
the repeating needed to draw a daisy flower. 
It can easily be extended to other types of 
flower, and most other symmetrical objects.

CorelDRAW (coreldraw.com) is the vector 
drawing app in the CorelDRAW Graphics Suite. 
Here you’ll use drawing tools to create instant 
and regular ellipses rather than having to draw 

the shapes from curves. You could instead 
scan or photograph your pencil drawing, 
clean the image up in Corel PHOTO-PAINT, 
then convert that to vector format using 
CorelDRAW’s PowerTRACE feature. 

Another option, particularly for less 
regular objects, is to draw them in using the 
Smart Drawing tool, which works well with 
a graphics tablet or, best of all, an iPad with 
Apple Pencil connected in Sidecar mode.

Going beyond daisies
Corel provides lots of free high-quality clip art, 
images, fills and fonts to get you started. Here 
you’ll use just one item from its Starter Pack, 
a bitmap fill. These can be obtained through 
the Help menu, and Corel’s Store also offers 
a range of paid-for products. You can easily 
create your own bitmap and vector fills, as 
well as useful objects containing common 
graphic elements.

When you’ve completed this introduction, 
you can try using different effects to give your 
daisies a more natural look, and apply them 
to the side of a 3D carton projected using 
CorelDRAW’s perspective drawing.
Howard Oakley

1

Main toolbar
 ≈-click to 

customise this 
to contain your 
most common 
tools from the 
Object menu.

2

Drawing 
toolbox

 These set 
pointer actions. 
Select variants 

by clicking on 
the lower right 

triangle.

3

Property bar
 This bar 

provides access 
to more detailed 
settings for the 
selected object 
or drawing tool.

4

Inspector
 Selected from 

the list in the 
Window menu, 
commonly for 
Properties, 
Objects or 
Pages.

1

2

3

4
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Create complex objects APPLE SKILLS

 HOW TO Get creative with CorelDRAW 

1Create the disc
Create a new document containing 

one A4 page in landscape mode. Set the 
Zoom to 400%, select the circle/ellipse 
tool, and drag out a near-circle slightly 
smaller than a third of the height of 
the working area.

2Add the first petal
With the circle tool selected, draw 

in a narrow ellipse at the 12 o’clock 
position to form a petal, overlapping 
the disc slightly. Adjust its position by 
dragging it and, as needed, the numbers 
in the property bar.

3Multiply the petals
Select that petal and use the ‘Create 

new symmetry’ option in the Object/
Symmetry menu. In the symmetry group 
property bar, set the number of copies 
to 12, and drag the centre of symmetry 
to the centre of the disc.

4Regroup the petals
When you’re happy all the petals 

are properly aligned around the disc, 
click Finish in the property bar. Select 
that symmetry group and, in the 
property bar, click Break Link to 
change it into a group of objects.

5Double the petals
Select that group, copy and paste 

it in place, then select the rotate figure 
in the edit bar above. Change the rotate 
figure from 0.0˚ to 15.0˚ to rotate the 
second group of petals into place in 
the gaps between the first group.

6Colour the disc
Select the disc and open the 

Properties editor from the Object menu. 
Select the Fill tool, and set a central 
gradient with a Fountain fill from a 
deep yellow start to a pale yellow, 
giving it a central highlight.

7Colour the petals
Select one group of petals and give 

them a colour fill, this time from very 
pale blue to white in a linear not central 
gradient. Repeat this procedure with 
the other group of petals, and adjust 
their order in the Object menu.

8Add the background
Select the rectangle drawing tool 

and drag out a background ordered 
behind the flower. Set its fill to contrast 
colour and texture; if you’ve installed 
the free Starter Pack, this bitmap fill 
(079) should be ideal.

9Spray your daisies
Select the objects in your daisy on 

the page or Objects list and group them 
using that command in the Object menu. 
Zoom out to 200% and duplicate the 
group, dragging each by a corner to 
resize them for variety.
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How to make music remotely
Use the cloud to collaborate with your musical mates

IT WILL TAKE
  30 minutes

YOU WILL LEARN
  How to collaborate 
remotely using Logic 

or other apps

YOU’LL NEED
  Splice Studio (free),  
macOS 10.14 or later

If you’ve ever tried to play along 
with another musician in a Zoom 
call, you’ll know that the lag in 
video apps makes real-time 

collaboration painful. But that doesn’t mean 
you can’t all work remotely on the same track 
when you can’t all be in the same room. Simply 
share your project with your collaborators and 
it will automatically update and sync when 
anybody adds to it.

For remote music making you need 
everyone to have three things. One, decent 

internet access. Two, a music app – ideally 
the same one you have. And three, an 
interface they can use to connect their 
instrument to their computer such as a 
USB guitar, microphone or MIDI interface.

When you have all of those things you 
can use cloud storage to share and sync your 
project, but what if your bandmates don’t 
use the same apps – or, whisper it, don’t 
even have Macs? As we’ll discover, there’s 
an elegant solution to that and it’s called 
Splice Studio. Carrie Marshall

HOW TO Sync and share music projects  

1Use iCloud Drive
The simplest way to share your music 

project is to put it in an iCloud Drive 
folder, ≈-click and choose Share File. 
However, this only works if the recipient 
has either macOS 10.15 or later, iOS 13.4 
or later, or iCloud For Windows.

2Use another cloud
Alternatively, put the project into 

another cloud storage/sharing service 
such as Dropbox or Microsoft’s OneDrive. 
Anything put in a Dropbox or OneDrive 
folder works just as it does with iCloud, 
updating and syncing as it’s changed.

3Share with Splice
Our new favourite way to collaborate 

remotely is to use a service called Splice. 
It works on Macs and PCs and is designed 
for musicians, with support for Logic Pro 
X, Ableton Live. and GarageBand. 
Download and install from splice.com.
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CONTINUED… Sync and share music projects 

4Drag or copy
The app creates a new folder on 

your Mac called Splice. Now you can drag 
your musical projects into it from another 
Finder window, or save directly into 
it from your music app. Here we’re 
dragging a bunch of Logic Pro songs.

5Upload your songs
Splice will automatically upload 

anything new or updated in your Splice 
folder to the cloud; here, our Logic 
projects are uploading. Once uploaded, 
open the project from within Splice, or 
you can view it on the Splice website. 

6See on the web
This is where things get interesting. 

Splice not only uploads your Logic 
project, but it also gives an overview 
of the tracks in it – and you or your 
collaborators can leave comments 
on those individual tracks.

7 Invite the band
Hover to the right of any project’s 

Open button in the Splice app, and you’ll 
see a ‘…’ icon: click it and choose Manage 
Collaborators to add collaborators to that 
project. They’ll need to have signed up 
for Splice before you can add them.

8Do your thing
If you and your collaborators all 

use Splice, it will automatically update 
everybody when someone saves the 
Logic project – but it will also keep the 
previous versions so you can recover 
from other band members’ bad decisions!

9Export for other apps
If not all of the band members have 

a Mac, let alone Logic Pro – don’t worry. 
It’s not a problem. Splice enables you to 
share the individual tracks, called stems. 
To make stems in Logic, use File > Export 
> All Tracks As Audio Files.

10Share your stems
Splice only shares projects, not 

stems, so you need to do that manually 
online. You can do it in two ways: by 
dragging from the Finder over the Attach 
Stem Files bit of the Splice screen, or 
by using the Add Stems button.

11Upload for anyone
The benefit of sharing stems is that 

they work with any music app, but the 
person you’re sharing them with needs to 
know the project tempo so they can sync 
any click track or MIDI with the song. Do 
so by including the BPM in the filenames.

12Share your song
Once your stems are uploaded, 

collaborators can download them. You’ll 
need them to export the stem of what 
they record and share it in the same way: 
Splice can’t update your Logic project if 
the other person isn’t using Logic.
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To further 
pinpoint an 

object you can 
even get an 

AirTag to play 
a sound
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APPLE SKILLS iOS software

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  How to set up and 

use Apple’s AirTag and 
locate AirTag items

YOU’LL NEED
  An Apple AirTag, an 
iPhone (preferably an 
iPhone 11 or 12 with U1 
chip), iOS 14.5 or later, 

Find My app

The Find My app for iPhone and 
iPad makes it easy to keep track 
of your Apple devices – you can 
do so on your Mac and on iCloud 

(although they work slightly differently). 
With the launch of iOS 14.5 and iPadOS 14.5, 
you can now keep tabs on other items too, 
thanks to support for third-party hardware 
such as Belkin’s SoundForm True Wireless 

AirPods and VanMoof’s S3 and X3 E-bikes, plus 
you can also use it to track more personal 
items such as keys and bags. All you need to 
do is attach and activate an Apple AirTag (£29) 
or Chipolo ONE Spot (£28) to each one, then 
select the items tab in the Find My app to 
locate each object you’ve added a tag to.

Precision finding
If you own an iPhone equipped with Apple’s U1 
chip (the iPhone 11 or iPhone 12, say), you can 
go even further. That’s because the U1 uses 
ultra-wideband technology tor precision 
location finding with arrows indicating the 
direction of the object appearing on screen.
Your iPhone will even vibrate when you get 
really close. To further pinpoint an object, 
you can also get an AirTag to play a sound 
through its built-in speaker. Used in this way 
you may never lose your bag or keys again.

Here you’ll discover how to set up and use 
an AirTag and find an item you’ve attached it 
to using the Find My app. Let’s get started. 
Rob Mead-Green

AirTags cost £29 each or £99 for four. To attach one to an 
item, you’ll need an official accessory, such as an AirTag 
Loop (from £29) or AirTag Leather Key Ring (from £35).

Keep track of your stuff with Apple’s new Find My accessory

Get started with AirTag
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Locate AirTag items APPLE SKILLS

 HOW TO Set up and use an AirTag 

1Add an AirTag
Take your AirTag out of its packaging and 

remove the plastic tab to activate the built-in 
battery. With Bluetooth and Wi-Fi active on 
your iPhone, hold the AirTag close to it. Click 
Connect when the pop-up window appears.

2Name your AirTag
Now choose an identity for this AirTag. 

Scroll through the list of names that appears 
onscreen (eg, Keys), then tap Continue. Or click 
Custom and type in a name of your choosing. 
Again, tap Continue when you’re done.

3 Register your AirTag
The next screen will enable you to link 

your AirTag to your Apple ID and so have it 
appear in the Find My app on iPhone, iPad and 
Mac as well as on iCloud.com. Tap Continue. 
On the next screen, tap ‘View in Find My app’.

4 See its location
In Find My > Items, you should now 

see your named AirTag’s location, its name, 
and four further options: Play Sound, Find, 
Notifications and Lost Mode. Tap Play Sound 
and your AirTag will chirp in response. 

5 Find a lost AirTag item
If you can’t find your keys or any other 

item with an AirTag attached, tap Find in Find 
My. On iPhone 11 or iPhone 12, you’ll now see 
a series of arrows appear on screen that can 
help guide you to its precise location. Try it! 

6 Enter Lost Mode
If you can’t find an AirTag item, turn 

on Notifications to be alerted when it next 
appears. If you’ve really lost it, tap Lost Mode. 
This enables anyone with an NFC-equipped 
device to tap it and get in touch with you.

Genius tip!
 To make your AirTag 

play an audio alert while 
using Find My > Find, tap 
the speaker icon. You 
should now hopefully 
hear it chirp up. 

Jargon buster
 Ultra-wideband is 

a low-power, broad 
bandwidth radio 
technology that is ideal 
for location finding and 
is used by the U1 chip 
inside the iPhone 11, 
iPhone 12 and Apple 
Watch Series 6.
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Protect accounts with 2FA
Add a secondary layer of security to your online accounts and services 

IT WILL TAKE
  10 minutes

YOU WILL LEARN
  How to set up Twilio 

Authy to generate 
and supply 2FA codes

YOU’LL NEED
  iPhone running 

iOS 11 or later, 
Authy (Free)

Two-factor authentication 
(2FA) is a form of additional 
verification to protect your 
online accounts in case your 

password is compromised. Verification can 
take several forms: 2FA is the most popular, 
but others include receiving a confirmatory 
email or SMS message to your phone, or the 
need to complete logon using a secondary 
device (as favoured by Apple).

2FA links your phone to your account via 
a special authenticator app that generates 

rotating numerical codes (six-eight digits) that 
change every 30 seconds. After entering your 
password, you’ll be prompted to check your 
app for the code, which you input to complete 
the logon process.

There are several apps available – we’ve 
chosen Twilio Authy because it supports 
multiple devices and secure backups. Once 
you’ve downloaded it, you’ll need to supply 
your phone number and email, then enter the 
registration code you receive via phone call or 
SMS to verify your account. Nick Peers

HOW TO Enable 2FA for any supported website 

1Add a 2FA code
Log into one of your online accounts. 

If it supports two-step verification it’s 
likely to be in the Account or Security 
section. Switch this on, then choose 
the Authenticator App option, which 
should reveal a QR code.

2Set up Authy
Open the Authy app, tap the Settings 

button and switch to the Accounts 
section. Tap the ‘+’ followed by Scan 
QR Code and use your phone’s camera 
to capture the code which will then set 
up the new 2FA link.

3Select logo and verify
Authy will attempt to identify the 

service you’ve connected to and pick 
a suitable icon. Tap Save and Exit. Your 
new account should be selected, so 
type the code into the web page to 
complete setting up the link.

APPLE SKILLS iOS software
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HOW TO Backup and sync  

HOW TO Protect your account 

1Enable cloud sync
When you add your first account, 

you’ll be prompted to create a password 
(make it strong – 12 characters minimum 
– stored in your password manager). 
Enter it, tap Enable Backups and then 
retype the password to confirm.

2Set up backup device
Go to authy.com/download to install 

Authy on your secondary device – this 
can be on iPad, Mac, Android, Linux or 
Windows. Open Authy on your new 
device and enter your country code and 
number into the boxes, then click Next.

3Authorise connection
Choose Existing Device to receive 

verification via your phone. Tap the 
notification that appears on your phone, 
then open Authy and tap Accept, then 
type ‘YES’ before tapping OK to sync 
your codes to your new device.

1Disable multi-devices
Once you’ve set up your chosen 

secondary device(s), remove the risk of 
additional unauthorised devices being 
added by disabling multi-device support. 
Navigate to Settings > Devices and switch 
Allow Multi-device off. 

2Protect app
Next, prevent anyone from accessing 

Authy should they steal your phone. 
Navigate to Security > My Account and 
tap Security. Toggle all the available 
switches to on, and set a four-digit 
passcode when prompted here.

3Review and remove
If a device is no longer required, 

or gets stolen, then log into Authy on 
another device and navigate to Settings > 
Devices. Either tap the device or the bin 
next to it, then choose Remove Device 
followed by Yes.

Recover your account 

If you’re forced to remove Authy from your primary phone, but later recover the 
phone successfully, download the app and go through the account verification 
process as outlined in the main text. After doing so, all your accounts will appear 
back on your phone, but you’ll see they’re protected with a lock symbol – tap 
one and enter your Authy backup password to unlock your account and regain 
access. If this doesn’t work, visit authy.com/phones/reset to begin the account 
recovery process, which can take up to 24 hours to complete.

Restore access to Authy from your phone 
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How submarine tech could mean better iPhone photos

YOU WILL LEARN
 How periscope lenses 
could enhance iPhone 

photography

According to multiple well-
connected Apple leakers, the 
iPhone could be getting a new 
kind of camera in 2022; one 

that sees further than any existing iPhone 
camera without any loss of image quality.

That’s because Apple is experimenting 
with periscope lenses. It wouldn’t be the 
first to do so, either. Samsung’s Galaxy S20 
and S21 Ultra both have periscopes, and 
other Android firms are following suit with 
their own high-end products. So what is a 
periscope lens and why would you want 
it in your phone? Let’s – ahem – look into it.

Why periscopes can help 
you see so much further
Periscope lenses enable you to get much more 
powerful optical zoom without requiring an 
enormous lens sticking out of the back of your 
phone. To understand why that’s important we 
need to understand how optical zooms work, 
and why digital zooms aren’t as good. 

With optical zooms you get the same level 
of detail no matter how much you zoom in or 
out; with digital zoom, software tries to guess 
what detail a zoom lens would see. It’s clever, 
but it’s no substitute for the real thing.

In order to use optical zoom, you need to 
change the focal length of the camera. That’s 
the gap between the lens or lenses and the 
camera sensor. Short focal lengths are brilliant 
for close-up photos, delivering great detail and 
a very wide angle. That’s something many 
smartphone cameras excel at. But it’s no good 
for things that are far away. To shoot them, 
you need the focal length to be as long as 

possible. That means you get the same 
amount of detail with much longer range.

The problem with that is increasing the 
focal length means physically moving the 
lens or lenses further away from the camera 
sensor, and there’s not a lot of room to do that 
in a typically slim smartphone. Firms such as 
Samsung did try to solve that problem by 
putting enormous telescopic cameras on 
otherwise slim phones such as the Samsung 
Galaxy K Zoom, but while the results were 
effective enough the phones weren’t very 
popular. So manufacturers decided to steal 
some ideas from submarines instead.

Periscopes: why they’re 
not just for submarines
We’ve all seen submarine periscopes in movies 
where a grizzled captain pulls down the 
periscope to look for the enemy. It’s a very 
sensible solution to a particular problem; you 
need to see the ships you’re targeting, but you 
don’t want to come to the surface. A periscope 
solves that problem by using angled mirrors to 
bounce light from the lens, which is horizontal, 
down the periscope tube, which is vertical.

Periscope phones do exactly the same 
thing, but instead of bouncing the light 
downwards they bounce it sideways, moving 
it horizontally across the back of the phone. 
On the outside the lens looks the same, but 
instead of sitting in front of a sensor it sits 
in front of a mirror. That mirror bounces the 
incoming light at a right angle so it travels 
horizontally through other lenses until it 
reaches the sensor. By making the light 
travel that distance, you can increase 

Key fact
 To get a longer range 

zoom you need to 
increase focal length 

– the distance between 
the lens and camera 

sensor. In a normal 
camera, you do that by 
making the lens move 
outwards, for example 
by having a telescopic 

lens. Telescopic 
cameras have been 

tried in smartphones 
but they weren’t 

too successful.

Periscope 
lenses give 
you longer 

zoom without 
requiring an 

enormous 
camera 

assembly

HOW IT WORKS

The periscope lens

This image, by Chinese 
hardware firm OPPO, shows 
how a periscope lens works 
in a smartphone.

 Image credit: OPPO
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the focal length far beyond what a normal 
smartphone camera can deliver. Where a 
normal camera might have a focal length 
of a few millimetres, periscope cameras can 
have a focal length measured in centimetres 
– without having to make the camera 
bump any more prominent.

The power of the periscope
That additional focal length means much 
better optical zoom. How much better? In a 
device such as the Samsung Galaxy S21 Ultra, 
the periscope camera achieves 10x optical 
zoom. That’s something you’d normally need 
a proper camera for, not a smartphone. 
Samsung uses software to turn that into an 
effective 100x digital zoom, although as with 
all digital zooms quality degrades noticeably; 
as you get towards three figures, the picture 

becomes more impressionistic 
than photographic. 

Like most digital zooms, 
the figure of 100x here is more 
about looking good on a spec 
sheet. While the Samsung is 
capable of shooting at up to 
108 megapixels, at 100x zoom 
that’s 108 megapixels of jaggy 
and indistinct detail. However, 
as our friends at Techradar 
(techradar.com) pointed out in 
their Samsung review, what’s 
happening at 100x zoom on 
the Samsung is effectively the 
same thing that happens at 10x 
zoom on phones without optical 
zoom lenses. And if you stick to 

the 10x optical zoom, the results are superb, 
enabling you to get really close to faraway 
things without losing any detail.

Do you need a periscope 
lens system in your iPhone?
The short answer is yes; it means longer range 
for photography and for video too. But how 
much longer that range will be depends on a 
lot of things, not least how much room Apple 
can make inside the iPhone’s case for that 
horizontal lens assembly. It’s clearly possible, 
as Samsung’s Galaxy Ultra demonstrates, 
but don’t hold your breath for a periscope 
lens in the iPhone 13 mini. For the time being, 
periscopes are more likely to appear in Apple’s 
biggest phones, most likely the iPhone 13 Pro 
and the iPhone 13 Pro Max.  
Carrie Marshall

Key fact
 Normal periscopes 

use two angled mirrors 
to reflect light, so in a 
submarine periscope the 
lens is horizontal and the 
image is then reflected 
downwards before being 
reflected again into the 
viewer. Periscope lenses 
in cameras use a mirror 
too; they reflect the 
incoming light at a 90° 
angle so it travels across 
the width of the phone.

 The iPhone 12 blends hardware and 
software in a clever way by using 
Computational Photography to 
deliver pro-quality photos instantly. 

In addition to normal image 
processing it uses machine learning 
tech to analyse an image and break it 
down into its component parts, each 
of which is analysed and adjusted 
separately. For example, if you were 
taking a photo of a person, your 
phone would identify and process the 
background, clothing, hair, eyes and 
lips separately, adjusting exposure 

and saturation and then blending 
them all together. The results are 
particularly good with traditionally 
tough tasks like shooting under skies. 
Bright skies can often overpower the 
subject in a photo, but with Smart 
HDR the sky is analysed and adjusted 
separately from everything else. Your 
iPhone effectively cuts out the sky, 
fixes it and sticks it back again. The 
same processing is used in Night 
Mode, which takes advantage of new 
image algorithms to remove noise and 
produce better low light photos.

Snap happier 

This Night Mode shot was taken on an iPhone 12 
Pro Max by NKCHU in China.

Firms such as Samsung tried to combine telescopic cameras with 
smartphones, such as in the Galaxy K Zoom, but without much success.

 Image credit: Samsung
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Big Sur’s missing updaters
Enter the password to see the Recovery 
window. In the Utilities menu, select Startup 
Security Utility. In its window select the external 
disk with the old version of macOS on it and 
click Security Policy… Set the policy to Reduced 
Security and click OK, then restart your Mac 
using the Apple menu.

When your Mac restarts, open the Startup 
Disk pane and switch to your external drive. 
That should start up normally, and you can 
update it to the current release using the 
Software Update pane. Once that’s done, start 
up in Recovery Mode again and set boot policy 
for that drive back to Full Security using Startup 
Security Utility to ensure that your Mac is 
fully secure again.

Q
I often start my M1 Mac mini up 
from a Thunderbolt SSD, but since 
updating its internal drive to macOS 

11.3.1 I’ve been unable to update that external 
disk. How can I do that?
by S I M O N  L U M S D E N

A
Using external startup drives with M1 
Macs is tricky. To ensure success, you 
need to change security boot policy 

for the external drive in Recovery Mode. 
Start your Mac up in Recovery by holding 

the Power button until the Options icon 
appears. Select Options and click Continue to 
open the Recovery Assistant. There select the 
user you know the password for and click Next. 

U
ntil Apple released 
Big Sur, it had 
always provided 

standalone installer 
packages for macOS 
updates and Security 
Updates. While those 
continue for Mojave and 
Catalina, Big Sur’s new 
Sealed System Volume 
requires a different kind 
of installer. The choice now 
is Software Update when 
it’s available and works, or 
download the full installer 
app and use that.

If you just want to 
update macOS and preserve 
your existing Data volume, 
that seems a gamble. In 
early releases of Catalina, 
full installers had a nasty 
habit of trashing or 
duplicating any existing 
Data volume – do you 
remember getting 
‘Macintosh HD – Data – 
Data volumes’? 

Thankfully, Big Sur’s 
installers are behaving 
better, but they’re still 
far less friendly than 
standalone updaters. Maybe 
Apple will reconsider and 
bring back updaters. 

 Email your queries and your questions 
to genius@macformat.com

Setting a startup volume to Reduced Security lets you run older versions of Big Sur on M1 Macs.
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iOS software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

Q
My partner and I updated our 
iPhones to iOS 14.5 to use 
AirTags. Now, when we track 

them in the Find My app, both phones use 
a lot of battery power. Is that normal?
by D O N  M A C L E O D

A
In normal use, AirTags in your 
iPhone’s Find My list should make 
little difference to its battery use. 

AirTags aren’t intended to track items which 
aren’t normally with you, nor people. Pop 
one on a keyring, a purse or bag which you 
keep nearby and could be misplaced. When 
you can’t find them, open Find My and tap 
Items to see where your AirTags are.

To track someone, that person will 
need to agree and share their location 
with you, so you can view their location 
in the People section of the app. That uses 
common location services rather than 
Apple’s Find My system, and remains 
under their control.

Because of the danger of misusing 
AirTags to track people, Apple has built 
deterrents into the Find My system. If an 
unknown AirTag moves with you for a while, 
the Find My app notifies you of its presence, 
and the AirTag plays a sound to help its 
location. You can then tap and hold your 
iPhone against the white side of the AirTag 
to learn information about it: Apple details 
this at bit.ly/mac367airtagalert.

Keep track of the battery use of 
the Find My app if you’re concerned, by 
opening Settings and tapping Battery, 
which lists usage by each app. Sometimes 
shutting your iPhone down then starting it 
up again can return battery use to normal 
after an iOS update.
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How do I sync the 
page I’m reading 

in Books?
> Open Settings > [your 

name] > iCloud and 
enable iCloud Drive and 
Books. Then go back to 

the Books item and turn 
on Reading Now. This 

only works across other 
iOS and iPadOS devices 

accessing the same 
Apple ID, and still 

doesn’t work with Macs 
even if they share the 

same account.

How can I tell the 
Wi-Fi channel my 
iPhone is using?
> Install Apple’s free 

AirPort Utility from the 
App Store. Open that 

app in Settings, and 
enable Wi-Fi Scanner. In 

the AirPort Utility app, 
tap Wi-Fi Scan at the top 

right, then tap Scan to 
see channel details. 

Remember to disable 
Wi-Fi Scanner in 

Settings afterwards 
to save power.

 Email your queries and your questions 
to genius@macformat.com

Do AirTags drain 
the battery?

Quick-fire 
questions 

Ideal for finding keys when you’ve dropped them, AirTags aren’t 
intended for tracking items you don’t keep with you.
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Mac hardware 
We help to solve your hardware hassles, from 
interrupted upgrades to running diagnostics

Quick-fire 
questions 
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Starting two M1 Macs from the same disk
Return to the Startup Disk pane, restart 

from the internal drive, then eject your 
external drive from that Mac. Connect it to 
your other Mac, open the Startup Disk pane 
there to make the external drive that Mac’s 
boot disk. You’ll be prompted to select its 
authorised user, and that Mac should then be 
able to start up from it as well.

Once set up, you’ll probably need to 
authenticate in four ways each time you start 
either of your Macs up from it: your normal 
user password login first, then the password to 
access the internal SSD of that Mac, followed 
by your Apple ID password, and finally the six 
digits sent to your main device for two-factor 
authentication of your Apple ID. Those are 
common to all Macs running Big Sur from an 
external disk, and aren’t peculiar to M1 models.

Q
When my M1 iMac arrives, can I start 
both it and my M1 MacBook Air from 
the same external drive?

by E D D I E  C H A N D L E R

A
Yes, once you’ve set your external 
drive to work with both Macs, and 
provided that they and the drive are 

running the same version of macOS. Format 
it as APFS and run the current Big Sur installer 
app from the App Store, or in Recovery Mode 
if you prefer. When you’re invited to create 
and migrate the existing user, agree, and 
authorise the drive for startup from that Mac. 
Using the Startup Disk pane, restart that Mac 
from your external drive and check that it’s 
properly set up, which will require you to 
sign it into your iCloud account.

Can I replace the 
Fusion Drive in my 

iMac 5K 2017?
> Not unless you’re very 
skilled at tricky internal 
surgery, as the process 

requires separating 
your Mac’s display and 
moving its left speaker. 

This is explained in 
iFixit’s guide at bit.ly/

mac367imacdrive. 
You almost certainly 

need to pay a qualified 
Apple technician to 

do that for you.

How do I check the 
last Diagnostics 

result code?
> Use the About This 
Mac command in the 
Apple menu, click on 
System Report… and 

select the Diagnostics 
item at the left, in the 

Hardware section. That 
should tell you the last 

time Diagnostics was 
run, and the result. 

M1 Macs running 11.3 
may not update this 

correctly, though, as it’s 
stored in NVRAM.

 Email your queries and your questions 
to genius@macformat.com

Using one external disk to start 
two M1 Macs up will require 
multiple authentications when 
you swap between systems.
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system restored. If you have another Mac with 
the current version of Apple Configurator 2, 
from the App Store, and a USB-C cable to 
connect them, you can do this yourself. 
Apple’s detailed instructions are at bit.ly/
mac363config2. Although this appears 
daunting, it’s actually straightforward.

Apple recommends trying to revive it first, 
which updates firmware and Recovery, but in 
your case you’re almost certain to have to 
perform a full restore, which erases all user 
data and installs a fresh copy of macOS. That 
comes from an IPSW image file which 
Configurator can download for you.

Q
When using Chrome on my 
MacBook Pro 2018, it gets 
too hot to rest on my lap, 

and within 90 minutes it needs 
recharging. What’s wrong with it?
by A D A M  H A R R I S

A
First connect it to mains 
power without any peripherals 
connected to it and start it 

up in Diagnostics Mode, holding the D 
key. If the diagnostic results are normal, 
you’ll need to ensure that any cooling 
vents in its case are cleared of fluff or 
dirt. Open Activity Monitor to get a 
better idea of what’s loading the 
processor. Select the CPU view and 
click on the header of the %CPU column 

to put processes which are using the 
most CPU at the top. There’s a catch 
here: you may see a process named 
kernel_task at the top of the list. macOS 
gives that process a lot of CPU time to 
prevent other processes from loading 
the processor when it starts getting too 
hot. That’s part of its cooling system, 
not a cause of your Mac overheating.

Chrome isn’t known to be frugal 
with the CPU, and you may find that 
using another browser such as Safari 
lets your Mac run cooler. If it continues 
to run hot in spite of Diagnostics being 
normal, it’ll be worth your while getting 
it checked out by Apple, as it still could 
prove to be a hardware fault, perhaps 
a failing battery.

Hot and flat MacBook Pro

Reviving a frozen M1

Q
When I tried to create a new user 
account on my M1 MacBook Air, 
it froze, and won’t accept any 

password to start up. What can I do?
by C O N C E T T A  S C R I M S H A W

A
Try starting it into Recovery Mode 
by pressing and holding the Power 
button until it displays the Options 

icon. Select that icon and click Continue 
underneath it. If that provides recovery tools, 
try reinstalling macOS.

If you can’t enter Recovery Mode or get 
any further, you’ll need to get the whole 

 Email your queries and your questions 
to genius@macformat.com

Activity Monitor’s CPU listing lists 
the processes which are loading 
the cores in your Mac, to help 
discover what’s responsible.

Once a sick M1 Mac is in DFU 
mode and connected to the other 
Mac, Configurator 2 can revive 
or restore it completely.

How do I fix dead 
Ethernet on a Mac 
mini 2018?
> Ethernet hardware is 
part of the logic board, 
so is an expensive 
replacement. You can 
work around this by 
connecting a compatible 
USB-C or Thunderbolt 
dock with its own 
Ethernet port, which 
should prove much 
cheaper and provide 
additional ports too.

Do M1 and Intel 
Macs give the same 
maths results?
> Yes, they’re identical. 
That’s not just the vast 
range of calculations 
they get correct, but in 
test cases producing 
less than perfect results 
because of accumulated 
errors, those are also 
exactly the same. You 
shouldn’t notice any 
difference in calculation 
results between the 
two machines.
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macOS 
Shine a spotlight on the solutions to 
your most irritating Mac problems

Quick-fire 
questions 
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How to tell whether 
Mojave Safari is 

vulnerable?
> Open Safari, and open 

the About Safari 
command in the Safari 

menu to show its About 
window. The build 

number given after its 
version should be at 
least 16611.1.21.161.6. 
If the last digit is any 

smaller, then you need 
to update it using the 

Software Update pane.

How to disable 
some of Big Sur’s 

system fonts?
> Use Font Book to 
control your fonts 

unless you’re already 
using a replacement 

font manager. ≈-click 
one of the named 

fonts to see if it can 
be disabled; those 

installed in the 
System’s font folder 

can’t be, nor can they 
be removed from that 

folder, as they’re locked 
on Big Sur’s protected 

System volume.

to recover documents from your mother’s 
Home folder, that would be more difficult, but 
provided that she didn’t use a very secure 
password it can be done. Although more 
expensive, you may find that Apple can help, 
as this is a sadly common situation. You’ll need 
to provide evidence of the Mac’s ownership 
and the endorsement of her executors.

If you don’t want to recover any files from 
that Mac, it’s now so old that it has little value 
or use, and is best sent for recycling. Before 
doing so, it’s worth physically destroying the 
hard drive inside it, which prevents anyone 
else accessing her private information. Some 
Macs can be tricky to gain access to their 
internals, but once you have, extract the hard 
drive and smash it with a heavy hammer 
before adding it to the recycling.

Accessing a Mac without its password

Q
My late mother’s iMac, from around 
2003, won’t start up without her 
password, which I don’t know. 

How can I get it going again?
by D E B B I E  H O L T H

A
Provided that a Mac doesn’t have 
a firmware password set, and has 
neither a T2 or M1 chip, it’s possible 

to start it up from an external disk, if that 
disk has a suitable copy of macOS installed. 
However, the most recent version of Mac OS X 
that iMac is likely to be able to run is 10.5.8 
Leopard, which Apple stopped supporting 
10 years ago.

Depending on what you want to do with 
that Mac, you may need to pay a specialist Mac 
repair shop to help you solve this. If you want 

Before sending an old Mac 
for recycling, remove its 
internal storage and smash 
it up using a hammer.

 Email your queries and your questions 
to genius@macformat.com
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It’s often best to update a new Mac first; when complete, 
use Migration Assistant to copy files from your old Mac.
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Q
Is it safe yet to 
upgrade my iMac 
2015 from Catalina 

to Big Sur?
by G E O F F  I N G R A M S

A
Big Sur 11.3 brought 
many bug fixes, and 
should prove a good 

upgrade. As you’re using 
Catalina, your software is 
already 64-bit and free from 
reliance on retired QuickTime 
codecs. Before starting, 
check all your key apps to 
ensure they’re current, as it’s 
easier to update them before 
you’re running Big Sur.

The most difficult 
decision you’ll face is if your 
Mac is backing up using Time 
Machine. Big Sur introduces a 
huge improvement as it can 
now back up to APFS disks, 
but doing so requires you to 
start a new backup series 

which won’t be compatible 
with Catalina. If you’re forced 
to retreat to 10.15, those 
backups will be inaccessible. 
If you decide to back up to 
APFS, archive old backups 
and start with a new disk.

Another area needing 
attention is any peripheral or 
software reliant on a kernel 
extension. Although they can 
still be installed in Big Sur, 
older extensions are likely to 

be incompatible, and should 
wherever possible be 
replaced with new System 
Extensions, which are less 
likely to cause problems like 
kernel panics.

Immediately before 
upgrading, make one last full 
backup, check your startup 
disk is completely healthy, 
then allow ample time to 
perform the upgrade and fix 
any resulting problems.

Is Big Sur safe yet?

How to migrate from old macOS

Q
What’s the best way to migrate from 
my iMac running High Sierra to a 
new M1 iMac?

by J O N  S P E L L E R

A
Although Migration Assistant works 
best and migrates most data when 
working between two consecutive 

major versions of macOS, such as Catalina and 
Big Sur, it can still save time instead of copying 

across apps and files manually. For a new M1 
iMac, start it up and create its main user 
account before attempting migration. Then 
use Software Update to bring macOS up to 
date. Once you’re happy it’s running sweetly, 
connect the iMacs back to back using the 
fastest means possible, preferably 
Thunderbolt. Open Migration Assistant on 
each Mac, setting the M1 as the destination, 
and your old iMac as source. If you can’t get 
that to complete, go back and be less 
ambitious about what to migrate until it’s 
successful. Next copy across anything you 
couldn’t migrate, and keep the two Macs 
running on the same network until you’re 
happy you’ve got everything.

If you prefer, you can use an app like 
Carbon Copy Cloner to make a copy of your 
old startup disk to an external drive, to 
connect to your new iMac and use as the 
source for migration. Finally, archive your old 
backups and start fresh ones.

 Email your queries and your questions 
to genius@macformat.com

One major advantage of Big Sur is that its 
Time Machine can back up to APFS, using a 
more reliable method.

How to quicken the 
last part of App 
Store updates?
> Once the progress 
circle reaches about 
‘9:30’, downloading the 
update has already 
been completed, and it’s 
prepared then installed. 
The time taken for this 
is largely dependent on 
the work required to 
install the update, and 
there’s nothing you can 
do to accelerate it. 
Sometimes it can take 
half an hour or more.

Why doesn’t 
Spotlight find older 
Rich Text files?
> A late update to 
Catalina introduced a 
bug into the importer 
file used by Spotlight to 
index content of all Rich 
Text files, but not RTFD 
documents. Any RTF 
document created or 
edited from then until 
the bug was fixed in Big 
Sur 11.3 will only be 
indexed if it has been 
changed since you 
updated to 11.3. The only 
way you’ll get existing 
documents properly 
indexed is to force 
Spotlight re-indexing on 
that volume. Open the 
Spotlight pane. Add the 
disk to the exclusion list 
in its Privacy tab, close 
the pane, and after a 
couple of minutes open 
it and remove the 
volume from that list.
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The Apple Watch has evolved into a truly essential accessory. 
Computing doesn’t get much more personal than this
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O
ver the last few 
months, we’ve 
rummaged 
around the more 

obscure corners of macOS 
Big Sur, iOS and iPadOS to 
discover all kinds of tips, 

tricks and apps to get even 
more out of your devices. 
This month, we’re turning our 
attention to the Apple Watch.

It’s safe to say that when 
Apple first launched the 
Apple Watch they weren’t 

entirely sure what it was for 
– the answer to a question 
Apple hadn’t quite worked 
out. But in six generations 
it’s become clear that it’s an 
incredibly powerful health 
monitor and fitness tracker 

and information provider. 
As the range of watch faces 
and complications – the little 
sections that you can use to 
get information from and 
launch apps – has increased, 
so has the Apple Watch’s 

Watch 
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Written by Carrie Marshall

usefulness; what was a fun, 
clever but inessential bit of 
tech has, for many, become 
an integral part of our 
everyday lives.

In this guide, we’ll show 
you how to get your Apple 

Watch just-so, from choosing 
and customising watch faces 
to the apps that can help you 
navigate unfamiliar places 
and find things that matter to 
you. We’ll explore the Watch’s 
fitness features, including 

Apple Fitness+, and you’ll 
even discover how your 
Apple Watch can help in the 
battle against COVID. 

We also reveal why the 
Apple Watch is the most 
personal device Apple has 

ever made – it’s there when 
you sleep and when you 
swim, when you work and 
when you work out, and, if 
you ever go skydiving, you 
can wear it then too. Here’s 
how to make the most of it.

secrets
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HOW TO Change your face > 

1 Enter editing mode
To change, customise or add 

complications to your Apple Watch face 
you need to go into Edit mode. Long-
press the watch face and you should see 
this screen here: a picture of the face, a 
small share icon and a larger Edit button. 

2 Swipe right
If you have multiple faces installed, 

you can swipe left and right to move 
between them. If you want to choose 
a new face, keep swiping until you see 
this big ‘+’ icon. Tapping on it will open 
up the Apple Watch face gallery.

3 Find your favourite
When you’ve found a face you like, 

don’t worry if it isn’t quite perfect; most 
faces are very customisable. Here, we’re 
working with the Chronograph face. To 
customise it, just tap the Edit button 
underneath the image of your new face.

Faces and complications
Your Apple Watch has many faces. Here’s how to find the right one

W
atchOS 7 has an all-new 
look and you can do more 
with it than ever before 
– but if you’re still 

using the default face or don’t use 
complications, you’re missing out 
on some of its best features.

To change a face, long-press and 
swipe to move between installed faces; 
keep swiping right and the big ‘+’ sign 
enables you to install a new one. You 
can customise a face by long-pressing 
and choosing Edit to move into the 
customisation screens. These vary from 
face to face but typically you’ll have one 
screen to customise the colour, which 
you do by turning the Digital Crown, and 
one for choosing complications, which 
you use by tapping the one you want to 
change and using the Digital Crown or 
swiping to see the options. Some of the 
more complex faces have another screen 
for changing their design too. You can 
move between these customisation 
screens by swiping left and right.

Different faces support different 
complications. The Infograph one has 

room for four in the middle, four in the 
corners and one on top; Astronomy 
has two; and Artist doesn’t have any 
complications at all. You’ll also find 
that there are different versions of 
different complications depending on 
where they’re going so, for example, 
complications for corners usually display 
more information than ones in the centre.

>  Need a new app for your Apple 
Watch? Pop to the built-in shop and 
discover what’s available.

You don’t need your iPhone to 
find new apps for your Apple Watch. 
Just press the Digital Crown and 
move the icons until you see the 
familiar App Store icon. Tap it and 
you’ll see a Search bar and some of 
Apple’s recommendations; tapping 
on an app enables you to read about 
it, see screenshots and install it 
directly onto your watch.

Don’t forget 
the App Store! 

You’ll find that corner complications can often 
display more information than central ones.

FEATURE Apple Watch secrets
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4 Change the colour
If the face supports multiple colours 

– most do – use the Digital Crown to scroll 
through the options. The watch face will 
change as you do. Some faces change 
more dramatically than others, such as 
changing individual stripes’ colours.

5 Get complicated
If your face supports complications, 

swipe left until you see a screen showing 
available places. Simply tap on the one 
you want to add or change and swipe or 
scroll through the available options. Press 
the Digital Crown when you’re done.

6 Face your friends
To share a face with someone else, 

long-press it, then tap on the Share icon. 
You can now send it, its complications 
and an accompanying message to 
anyone in your Contacts, and they can do 
the same to you with their own creations.

1

Infograph 
main focus
 The Infograph 

face enables you 
to put four small 
complications 
in the centre 
of your Apple 
Watch face.

3

Keeping the 
centre clear
 When using the 

Chronograph 
face, there’s no 
room for central 
complications 
because of its 
timers.

2

Reminding 
strip
 In addition to 

complications 
in the corners, 
Infograph has 
room for a 
Complication 
strip at the top.

4

Corner 
complications
 With the 

complications in 
the corners, they 
go clockwise 
from top right: 
Music, Weather, 
Calendar and 
Activity.

5

Keeping to 
the corners
 Complications 

on the Stripe 
face are in the 
corners too. This 
is a different 
Calendar, 
showing 
today’s date.

6

Third-party 
apps
 Many third-

party apps have 
complications 
too. This one 
is PCalc Lite, 
the brilliant 
calculator app.

1

2

5

6

3

4
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Y
our Apple Watch doesn’t just 
have a pretty face. From walking 
to weight training, hiking to 
high-intensity interval training, 

swimming to skydiving, your Watch is the 
perfect companion for every kind of activity. 
Well, maybe not skydiving.

The Series 6 has a gyroscope, an 
accelerometer, GPS, altimeter, compass, 
blood O2 sensor and a heart rate sensor, and 
they can track all kinds of health information 
from how vigorously you’re exercising to how 
oxygenated your blood is, how many stairs 
you’ve climbed today and how much loud 
noise you’ve been exposed to. That makes 

it ideal for tracking all kinds of data, which 
then feeds into the Health and Fitness apps 
so you can track your progress over time and 
identify triggers and trends.

While your Apple Watch does all the work, 
its data gets sent to your iPhone; sleep data 
and vital signs are sent to the Health app and 
activity data to it and to the Fitness app. 

Your Apple Watch automatically tracks 
three goals in Activity on your watch and 
Fitness in your phone; daily calories burned, 
daily exercise minutes and daily hours spent 
standing. You can change all three daily goals 
in Activity by scrolling to the bottom and 
tapping on Change Goals. 

>  Fitness+ displays real 
time data from your 
Apple Watch on your 
iPhone, iPad or Apple 
TV as you exercise. 
And you get on-screen 
encouragement like video 
game power-ups when you 
hit certain milestones.

Fitness+ has been 
designed for Apple 
hardware, so on-screen 
metrics are only displayed 
if you’re using your iPhone, 
iPad or Apple TV. However 
you can also AirPlay the 
current workout video to 
your smart TV while the 

Apple Watch continues to 
record your activity. To do 
that, open the video in your 
iPhone or iPad, tap the 
AirPlay icon at the bottom 
right of the screen and 
choose your destination. 
The video should then shift 
to your connected TV.

The Apple Watch can track a wide range of 
workouts, lock out water and motivate you 

Now wash 
your hands!
 Your Apple Watch can 
help you in a COVID-19 
world. Its handwashing 
timer (Settings > 
Handwashing) detects 
running water and hand 
movement and then counts 
down for the recommended 
20 seconds; the Series 6’s 
built-in blood oxygen sensor 
can warn you if your blood 
isn’t saturated enough, a 
telltale sign of respiratory 
problems; and the Series 3 
onwards can still unlock 
your Face ID iPhone when 
you’re masked if wrist 
detection and passcode 
protection are on.

Focus on Fitness+ 

If you have an Apple Watch Series 2 
or later, you can switch on Water 
Lock to prevent accidental input 
while you’re in water.

Helping with the fight against 
COVID - the handwash timer.

Health and Fitness

Your Apple Watch 
is at the centre 
of Fitness+, 
which combines 
fitness tracking, 
online video and 
Apple Music.
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> Your Apple Watch can 
help you get a better 
night’s sleep, and help you 
to wake up in the morning. 

The Watch’s sleep app 
enables you to set sleep 
goals, arrange audible or 
vibrating alarms and turn 
on sleep mode at specific 
times, and it tracks your 
sleep activity too. You can 

create multiple schedules 
so the weekday alarms 
don’t go off at the weekend, 
and you can also set 
Bedtime to have a wind 
down time where it 
simplifies your Watch 
display and goes into Do 
Not Disturb before you 
go to bed every night. Of 
course, if you’re wearing 

your Apple Watch you’re 
not charging it. We actually 
pop our Watch on its 
charger when we get up; 
by the time we’ve showered 
and breakfasted it’s fully 
charged for the day and 
night ahead.

HOW TO Master your Fitness goals > 

1Open the Workout app
You can change your overall fitness 

goals in the Fitness app on your phone, 
but you can create goals on the go with 
the Workout app on your Apple Watch. 
Scroll until you see the kind of workout 
you’re doing: a walk, a dance, a swim…

4 Set the distance
Changing your distance goal works 

in exactly the same way, but this time 
you’re adjusting the distance in miles 
rather than the calorie target. We like 
the way the different targets are colour-
coded so it’s clear what you’re adjusting.

2Choose your metric
Tap on the ‘…’ icon at the right of the 

workout type and you should see the 
goals menu. An open goal doesn’t have 
any targets, but you can specify a target 
number of calories, a target distance or 
a target time. Or all three.

5 Set your timer
The time target works like the 

calories and distance targets – tap the 
icons or use the Digital Crown to make 
the target time increase or decrease. 
Once you’ve set it, just tap Start and your 
watch will start recording your workout.

3 Count the calories
We’ve tapped on the Kilocalories 

icon. You can adjust the calorie target 
upwards or downwards by tapping on 
the ‘+’ and ‘–’ signs or using the Digital 
Crown. The app also shows you your 
personal best for this kind of workout.

6Pause, stop or swim
You can pause your workout at any 

time; swipe right and tap on the pause 
button, remembering to take it off pause 
again when your break is over. You can 
also end your workout, or activate the 
Water Lock feature if going swimming.

From Wind Down to Wake Up 

Apple Watch secrets FEATURE

The Sleep app enables you to 
create different sleep and alarm 
schedules for different days.
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Y
our Apple Watch is your perfect 
travel companion whether 
you’re globe-trotting or nipping 
out to the shops. Its Maps app 

is a brilliant navigation aid with dedicated 
options for drivers, pedestrians, public 
transport users and cyclists, and it can help 
you find places such as restaurants, shops, 
car parks and cash machines. We particularly 
like the eyes-free navigation where your 
watch taps you on the wrist as you walk or 
drive to alert you of an upcoming turn or lane 
change. And if you have the GPS+Cellular 
model, you don’t even need your phone.

That’s not all it can do when you travel. 
Siri can help you find the right phrase in 
other languages (and there are many great 
Apple Watch translator apps too, such as 

iTranslate); you can use the Calculator app to 
calculate the tip when you’re paying in a café 
or restaurant; you can use free apps such as 
Elk to carry out currency conversions, and 
there are tons of to-do apps that you can use 
to make sure you pack everything you need. 
If you’re flying with big-name airlines such as 
British Airways or Lufthansa you can also 
get up-to-the-minute details of gate times, 
arrivals and flight status. And when you 
arrive you can use the Uber app to get you 
from the airport or get Maps to show you 
where the trains or subway rides are. 

The Lufthansa app also enables you to 
have your boarding pass on your watch. Lots 
of airlines did the same when the Watch first 
shipped, but many of them seem to have lost 
interest since – which is a shame, because it’s 
really handy. It’s possible that the move to 
COVID vaccination passports may rekindle 
their interest: the International Air Transport 
Association has announced an iPhone app, 
but it’s unclear whether it’ll have an Apple 
Watch component.

Be in charge
One lesson we’ve learnt the hard way: always 
make sure you’ve got your Apple Watch 
charger when you’re travelling any distance. 
Maps and other location-based apps can be 
quite demanding on your Watch’s battery and 
you don’t want to run out of power when 
you’re far from home.

Maps, Translations and more

The GMT face can show two 
different time zones at once. 

Going somewhere? Your Apple Watch can get you there

Change your 
timezone
 Whether you’re going from 
one side of the world to the 
other or just nipping across 
a border, your Apple Watch 
can show you the time for 
two different places. 

Choose the GMT face, 
press (but don’t long-press) 
the centre and you can now 
use the Digital Crown to tell 
your watch which second 
time zone you’d like it to 
display. When you return to 
the GMT face, it’ll show the 
current time zone’s time in 
the inner, 12-hour dial and 
the other time zone in the 
outer, 24-hour dial.

Public transport information is built into the Maps app 
on your Apple Watch, enabling you to plan even very 
complicated multi-stage routes.
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>  The late, great, Apple-obsessed 
writer Douglas Adams imagined 
a translation tool called the Babel 
Fish, a fish that you stuck in your 
ear to understand any language. 
Your Apple Watch is similar, and you 
don’t need to stick it anywhere. Just 
say to Siri, “how do I say (thing you 
want to say) in (chosen language)?” 
and Siri will show you and also say 
the word or phrase aloud. 

Siri’s translation features are best 
for quick queries. If you want real-time 
translation, use Apple’s Translate app 
on your iPhone. This enables you to 
type or talk, automatically translating 
into your chosen language. If you’re 
speaking it will read the results aloud, 
and if you put it into Conversation 
Mode it’ll listen to two speakers and 
play a translation of what each person 
has just said.

HOW TO Getting from A to B is as easy as A, B, C > 

1Open the app
You can use third-party mapping apps 

such as Google Maps but we’ll stick to the 
Apple option. To open Maps, press the 
Digital Crown, then tap on the Maps icon. 
You’ll see a Home Screen with favourites 
and a Search icon. Tap the search icon.

4 Get directions
Each type of transport displays an 

estimated travel time, based on current 
traffic conditions and public transport 
timetables. Tap the option you want to 
use and your Apple Watch will calculate 
your route, which takes a few moments.

2 State your destination
There are multiple options here. 

You can say or scribble an address, pick 
a contact or use the Nearby feature to 
find useful places nearby. We’re going to 
use that feature to find a supermarket 
that isn’t too far away.

5 Choose your route
Sometimes there are multiple routes 

to the same place, in which case the Maps 
app will let you choose the one you 
prefer. Here, though, there’s only one 
sensible route to the supermarket so 
Maps isn’t providing other options.

3 Choose your transport
Maps can give you four kinds 

of directions: walking, driving, public 
transport and, in some cities, cycling. 
Cycling can take account of things such 
as steep steps, so it can be useful for 
wheelchair users too.

6Hit the road, Mac
Tap the route to start; your Watch 

will display directions and destinations. 
You don’t need to look at the screen 
while you walk, cycle or drive; your Apple 
Watch will tap your wrist in advance 
whenever you need to change direction.

Sprechen sie Siri? 

Want to know how to say something in 
a particular language? Just ask Siri.

Apple Watch secrets FEATURE
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In iOS 11 or later, point the Camera 
app’s photo mode at this QR code 

to download our app.
*First-time digital subscribers only.

and get an issue for free*
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hen it comes to 
spreadsheets and 
data-crunching 
applications, the Mac 

is still relatively poorly served. 
If you don’t want to use Microsoft’s 
behemoth Excel (an application that 
began life on the Mac a full two years 
before the first Windows version), 
and would rather avoid web-browser 
based tools like Google Sheets, then 

Numbers is a versatile and capable tool for 
creating budgets, lists, invoices and more

How to create 
spreadsheets 
in Numbers

Numbers is by far the best option. 
Thankfully, Numbers is very good 
indeed when it comes to tasks like 
personal budgets, planners, invoicing 
and pretty much anything that doesn’t 
involve macros code or the kind of 
enterprise-level automation at 
which Excel, well, excels. 

Numbers’ great strength is in its 
ease of use and its templates. While 
basic, the templates are an excellent 

jumping off point for creating your 
own spreadsheets, customising them 
and, in the process, learning how 
Numbers works. Many of its 
conventions are identical to those 
in Pages, including the way you 
import objects such as images and 
style text. We’ll show you how to 
get started with a personal budget 
template, then get into more detail 
on data, formulas, and charts. 

Beginner’s Guides
Introducing Numbers

W

WRITTEN BY KENNY HEMPHILL
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Numbers templates make it 
easy to get started creating 
your own spreadsheets

n this tutorial, we’ll show you 
how to use one of Numbers’ 
standard templates to make 
your own personal budget. 

The template has two tabs: Budget and 
Transactions. The Transactions tab houses all 
the details of money spent during the period 
covered by the budget. These are allocated 
into categories. In the Budget tab, a table uses 
functions and formulas to add up the values 
of all the transactions in a given category 
and put them in a cell in the Actual column. 
For example, the Actual column in the 

Entertainment row looks for all the cells in 
the Transactions table where the category 
matches ‘Entertainment’ and sums the 
value of the transactions.

The Budget column in the table in the 
Budget tab contains manually entered values. 
These are then compared with the Actual 
spend to calculate the Difference.

A doughnut chart is created from the 
Actual column, showing how total spend 
is split across categories. And a bar chart 
displays the differences between budget 
amounts and actual spend for each category.

1

Multi tabs  
Numbers 

spreadsheets 
can have 

multiple tabs. 
Their names are 
displayed at the 
top of the sheet.

3  
Format
 The Format 

sidebar in 
Numbers is very 
similar to the 
one in Pages, 
but with tabs 
for formatting 
tables and cells.

2

Formula bar
 The formula 

bar at the 
bottom of the 
sheet displays 
the formula or 

value for the 
selected cell. 

4  
Table options
 Reposition 

tables by 
dragging the 
circle (left); add 
rows or columns 
by clicking ‘||’ 
(right).

EXPLAINED… Numbers’ interface 

1

2

3

4

4

Create a 
spreadsheet 
in Numbers

I
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1Choose a template
Launch Numbers. Choose New 

Document to display the Template 
Chooser. Use the categories on the left to 
navigate the templates, then click on one 
and press Create. We’ve chosen Personal 
Budget in the Personal Finance Section.

2Add your budget figures
You’ll notice that the Personal 

Budget template has two tabs, Budget 
and Transactions. We’ll start by adding 
data to the Budget column in the Budget 
tab. For each category, type in the max 
figure you want to spend every month.

3Delete template entries
Now we’ve set the budget, click on 

the Transactions tab. Select all the cells 
in the table by clicking and dragging over 
all the cells in the table and press ∫. 
We’ll use this table to log transactions 
as they are made.

4Add transactions
Type details into the Date, 

Description, and Amount columns for 
each transaction. In the Categories 
column, click on the arrow that appears 
when you click on a cell and choose a 
category from the list.

5Customise table style
You can change the way the budget 

table looks. Click anywhere the table, 
then choose Format in the toolbar. Select 
the Table tab. Choose from one of the 
pre-existing styles or use the options 
beneath to create a custom style.

6Create a new category
In the Transactions tab, click in 

an empty cell the Categories column. 
Choose Format > Cell. Under the list of 
items in the menu, press ‘+’. Type in the 
name of the category, then drag it into 
its alphabetical place in the list. 

7Add the new category
Click on the Budget tab. In the table, 

≈-click on the row above where the new 
category will go and choose Add Row 
Below. Type the name of the category 
into the Description column. Type an 
amount into the Budget column.

8 Filter transactions
To see how much you’ve spent on 

Food, go to the Transactions tab, click the 
header of column C and click the arrow. 
Choose Quick Filter, then Food. Other 
categories will be hidden and you will 
only see those for Food.

9Sort transactions
To list items according to how 

they’ve performed against budget, click 
in the table, then press Organise, and 
Sort Choose Sort Entire Table. Click Add 
a Column and choose Difference. Choose 
Ascending or Descending for the order.

 HOW TO Build your own personal budget spreadsheet 
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Table, charts and functions
Tables and charts are the heart of any spreadsheet. Here’s how they work

sing templates is a great way 
to get to grips with Numbers, 
but very soon you’ll find 
yourself wanting to hack them 

to work with your own data sets, or to 
create spreadsheets yourself from scratch. 

To do that, you’ll need to create your 
own formulas using the functions Numbers 
understands. There are hundreds of these and 
they range from the very basic, such as adding 
up a column of numbers or calculating an 
average, to complex statements with 

conditions and boolean operators. Thankfully, 
Numbers provides detailed descriptions and 
examples of how each function works so you 
know which ones to opt for. 

To see them, click in an empty cell in a 
table, press the Insert button in the toolbar 
and choose New Formula. You will see the 
Functions browser appear on the right of the 
screen with a library of functions, descriptions 
and examples. Use the categories on the left 
to find the function you want to know more 
about or use, or search for it.

HOW TO Add a table  

1Add a table
 When you open a new blank 

document in Numbers, it has one table 
in it. To add another one, click the Table 
icon in the toolbar. Use the arrows to 
scroll through the style options then 
click on one to choose it. 

2Add rows and columns
To add more columns, click on the ‘||’ 

icon to the right of the header row and 
drag it right. To add more rows, click on 
the arrow next to the number of the 
bottom row and choose Add Row 
Above or Add Row Below.

3 Fill out the table
Use the Table tab in the Format 

sidebar to style the table and double-click 
over the default title to type your own. 
You can now start typing data or 
formulas into cells on the table, or 
paste data from another spreadsheet. 

Beginner’s Guides Introducing Numbers
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HOW TO Create a chart 

HOW TO Use functions 

1Add a chart
Identify the data you want to chart 

and decide what type of chart it suits. 
Click on the chart button on the toolbar 
and choose a chart type. Press Add Chart 
data to define the cells you want to use 
to populate the chart.

2Add data to the chart
Click the bottom left of the sheet 

and choose Plot Columns as Series or 
Plot Rows as Series. Click in the first cell 
whose contents you want to plot, then 
the next, and so on. You can add data 
from multiple tables. Click Done. 

3Style the chart
Use the Format sidebar to style the 

chart by selecting a preset, or manually 
making adjustments. You can drag the 
chart and key anywhere on the sheet. 
To add or delete data, select the chart 
and choose Edit Data References.

1Add a simple function
To add a simple function, such as Sum 

or Average, click and drag over the cells 
you want the formula to act on. Choose 
Insert in the toolbar. Select the particular 
function you want. It will then be added 
to the first empty cell.

2Add a complex formula
Click in the cell where you want to 

add the formula. Click Insert and choose 
New Formula. You’ll see a list of formula 
in the Functions browser; browse or 
search the list and choose the one you 
need. Click Insert Function.

3Complete the formula
When the formula appears, click 

on the first cell you want it to act on 
and drag over the rest of the cells. If 
necessary, click on the second parameter 
in the formula and give it a value. When 
done, click the green tick.

Filters let you analyse your data by displaying only those data that meet criteria 
you specify. In our budget spreadsheet, we can filter out table entries where we 
were under budget so we can focus on those where we overspent.

To do this, select the table, choose Organise > Filter. Click Add a Filter. Choose 
Difference. With Numbers selected as the rule, choose ‘is less than’ and type ‘0’.

The table and charts in the spreadsheet will now ignore all the entries where 
you were under budget and display the rest.

Hide data you don’t need so you can focus 

Filter table entries

Introducing Numbers Beginner’s Guides
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BACK ISSUES Collect them all

Missed an issue?
Complete your collection of the 

UK’s No.1 magazine for Apple fans

Download back issues onto your 
iOS device at any time and keep them 

forever in your personal library. 
bit.ly/macformatipad

To order back issues of the print magazine, 
go to bit.ly/macformat_backissues 
or phone +44 (0)330 333 1113 and 

we’ll post them out to you.

NEVER MISS AN ISSUE! SUBSCRIBE TODAY!
IN PRINT & ON iOS

 Our print and digital bundle gets you  
the real magazine and our digital 

edition for iPad and iPhone. 
bit.ly/magazinesdirect_macformat

ON YOUR MAC
 Read on the big screen, too! If you prefer 
to read MacFormat magazine on a Mac, 

then subscribe with Zinio at  
bit.ly/ziniomacf

 IN PRINT  ON iPAD & iPHONE

ISSUE 365 
JUNE 2021

 Big Sur secrets revealed! 
 Our predictions for Apple kit

 Ultimate guide: make music on Mac
 How to improve AirPods audio

ISSUE 366 
JULY 2021

 Say hello to the new iMac! 
 Meet the all-new M1 iPad Pro 

 PLUS: iPadOS 14 tips and tricks 
 AirTag: Apple’s new tracker on test

ISSUE 364 
MAY 2021

 Go further with iCloud 
 Improve your online security

 Top tips for Notification Centre
 Use a thumb drive with your iPadRafi
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82  ViewSonic M2e projector

83  Fauna audio glasses

84 Keychron K3 keyboard

SOFTWARE

86   Group test: iOS weather apps 

92 Nudget

93  Notability, Commander One 3.0

94 Attentat 1942

95  Scanner Pro: PDF Scanner App, 
GoodTask 6.4

96  6 best apps for 
gardening enthusiasts!

AUGUST 2021 | MACFORMAT | 73

 A truly exceptional product. 
Award given solely at the 
discretion of the editor.

 The best example of its 
kind when pitted against 
comparable products.

 A brilliant thing

 Strongly recommended
 

 Worth considering

 Notable flaws

 A waste of your money

Our authoritative reviews 
help you make more 

informed choices

BUYING 
ADVICE

 Our ratings

74

78

81

 Our reviews are totally 
independent; we’re not 
affiliated with Apple or 
anyone else, nor are we 
influenced by advertisers.

Contact us

 Email your queries and 
your questions to 

letters@macformat.com

iMAC 24in (2021)
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APPLE CHOICE Mac hardware

Bringing the homegrown M1 chip and 
a return to colour to the Mac party

T  his is the Mac we’ve been waiting 
for. Measuring just 11.5mm thin 
and available in a choice of up to 

seven different colours, the 24-inch iMac 
feels instantly familiar and all-new at 
the same time. It clearly shares a familial 
familiarity with what’s gone before – an 
all-in-one computer with a gorgeous (now 
4.5K) Retina display, perched on top of an 
aluminium stand with a tell-tale iMac chin. 

The changes though are massive – gone is 
the slightly bulbous shape of old in favour of 
an 11.5mm thin body with squared-off edges, 
making the iMac look more like a big iPad 
on stilts than a computer. The front of the 
machine is now entirely glass – something 
that’s not all that clear from Apple’s photos 
– and then there are the two-tone colours, 
which are stronger and more vibrant on the 
backs and sides of the iMac than on the front, 
which is more of a pastel shade. The Magic 
Mouse, Magic Keyboard and iMac stand all 
come in the paler colour too – although they 
seem to be a slightly different shade than the 
glassy chin. Although that’s more of a trick 
of the light than anything.

While the 54.7cm width of the 24-inch 
iMac is more or less the same as the previous 
generation 21.5-inch iMac (which measured 
52.8cm), its screen is now bigger, thanks to the 
display’s narrower bezels. The 4480x2520 
pixel display looks stunning, thanks to that 
4.5K resolution and 500cd/m2 brightness, 
which beats many standalone displays that 
have lower specs for both. More controversial 
is the use of white rather than black bezels 
– while in our white-walled office it makes the 
screen edges seemingly disappear, it’s also 
divided opinion among some Mac users who 
would have at least liked to have a black bezel 
option. Also controversially, the iMac retains 
its tilting stand – if you want to adjust the 
height of the display, you’ll either have to 
stick the iMac on a pile of books, invest in a 
third-party stand or opt for a VESA mount 
– iMacs without the aluminium stand are 
also available to buy for this purpose.

Ports and specs
The controversies continue elsewhere – that 
super-thin body now means you get even less 
port choices than before – there are no longer 
any USB-A ports or even an SD card slot on 
the back, while the headphone jack has been 
moved to the left-hand side of the iMac, which 
at least makes it somewhat easier to reach. 
Apple has also removed the built-in power 
supply and Gigabit Ethernet port, with the 
former now coming in an offboard white 
143W power brick, where you’ll also find the 
Ethernet port on the mid-range and top- 
spec models; on the entry-level iMac, it’s 
available as a £30 option.

Talking of models, the 24-inch iMac is 
available in three flavours, all equipped with 
Apple’s M1 chip. The £1,249 entry-level iMac 
comes with an 8-core CPU (comprising four 
high-performance cores and four efficiency 
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iMac 24-inch (2021)

 £1,649  FROM Apple, apple.com/uk  
 FEATURES Apple M1 chip (8-core CPU, 8-core GPU), 512GB storage, 8GB of unified 

memory, 24-inch 4.5K Retina display (4480x2520 pixels), 2x Thunderbolt/USB 4 ports, 
2x USB 3 ports, 1x Gigabit Ethernet port, Magic Keyboard with Touch ID

Jo says…
 I really love the look of 

the new iMac, but the 
best thing about it is just 
how quick and easy it is 

to use. And that 4.5K 
Retina display is great for 

watching movies on.
The mid and top models come with two Thunderbolt/USB 4 
and two USB 3 ports, all of which use USB-C connectors.

The 24-inch iMac is wafer thin, 
but that has resulted in even 
fewer ports at the back.
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The iMac is available in up to seven different 
colours with matching accessories. Only the 
mid-range and top-end models get Magic 
Keyboards with Touch ID as standard.

cores), a 7-core GPU, 8GB of unified memory 
and 256GB of solid-state storage. This iMac 
also gets just two Thunderbolt/USB 4 ports, 
plus a colour-matched Magic Keyboard and 
Magic Mouse. Or you can opt for a Magic 
Trackpad for £50 more.

The £1,449 mid-range and £1,649 top-spec 
models are more fully featured, with each 
boasting an 8-core CPU/8-core GPU M1 
chip and 8GB of unified memory, plus two 
Thunderbolt/USB 4 and two USB 3 ports 
(all USB-C), Gigabit Ethernet and a Magic 
Keyboard with Touch ID. The mid-range 
model gives you 256GB of solid-state storage, 
while the top-end model has 512GB. 

Further upgrade options are available 
from the build-to-order list – with up to 16GB 
of unified memory available across the range, 
and 2TB of SSD storage on the mid-range and 
top-end models. The entry level can be maxed 

out with 1TB of storage. All three 24-inch 
iMac models come with Wi-Fi 6 (aka 802.11ax 
Wi-Fi) and Bluetooth 5.0.

You also get more choice when it comes to 
the colour of your iMac in the mid-range and 
high-end configurations. While the entry-
level is available in Blue, Green, Pink and 
Silver, the more expensive machines add 
Yellow, Orange and Purple. A fully-specced 
24in iMac with all the trimmings will cost 
you a cool £2,449. Again a Magic Trackpad 
is an extra £50, but we think it’s worth it. 
The Magic Mouse remains a source of 
bemusement, despite the new colour scheme.

M1 magic
What else is new? Going hand in hand with 
these colour configurations is a new colour-
coded and braided power cable which 
attaches to the back of the iMac using 
magnets, plus there’s a matching USB-C to 
Lightning cable in the box (for charging the 
Magic Keyboard and/or Magic Mouse too). 
We love the fact that you can now log into the 
iMac using Touch ID – a feature that’s finally 

It might come in pretty 
colours, but the Magic Mouse 
retains its old design, which 
includes having a Lightning 
charging port on its bottom.

The 24in iMac iss avvailable in 
three flavours, all eequipped 
with Apple’s M1 chip
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been carried over from Apple’s MacBooks, 
although again entry-level users miss out – 
unless they pay an extra £50 for a keyboard 
with that feature.

While the all-new design and colour 
choices (with echoes of the original multi-
coloured iMacs of yesteryear) are very 
welcome, the real star of the show is Apple’s 
M1 chip, which replaces the Intel Core i5 
found in the old 21.5-inch model (one variant 
of which is still available at £1,099). The 
difference between the two is certainly light 
and day – while the old 21.5-inch could be a 
bit wheezy, even with an SSD inside rather 
than a hard disk or Fusion Drive), the new 
24-inch iMac starts up almost instantly – and 
everything feels really fast: the Finder is fast 

and fluid; apps open in a snap (especially 
if they’re optimised for the M1 as many now 
are), and getting any work done from working 
on spreadsheets in Numbers to making music 
in GarageBand or photo editing in Photos, 
Pixelmator Pro or Affinity Photo feels 
ridiculously quick and satisfying. You’ll 
quickly fall in love with your Mac all over 
again. Intel slowdowns be gone!

Performance scores
However, as with the M1-powered Mac mini, 
MacBook Air and 13-inch MacBook Pro, there 
are caveats – while the iMac is quick and 
efficient with most everyday computing tasks, 
there will be times when you crave more than 
8GB or 16GB of unified memory and more 

graphics cores than are provided 
by the 7-core or 8-core GPU. 

As you’ll see from our 
benchmarks, the M1 iMac achieved 
a single-core score of 1,742 in 
Geekbench 5 (compared to 1,100 for 
a 16-inch MacBook equipped with 
an 8-core Intel Core i9); it was less 
clear cut in our multi-core test 
where the M1 achieved 7,665 score 
and the same Intel Core i9 scored 
6,990. Geekbench’s 5 Compute 
Benchmark, which tests graphics 
performance, also reveals a clear 
difference between the 8-core GPU 
of the M1 iMac (19,349) and the 
discrete graphics of the AMD 
Radeon Pro 5700XT (58,507) 
available in its 27-inch Intel 

The iMac eschews a built-in 
power supply in favour of an 
off-board brick with added 
Gigabit Ethernet port (a £30 
option on the entry-level).

The front of the iMac sports white bezels, the familiar chin and a paler colour compared to the back and sides.

HANDBRAKE 
VIDEO ENCODING
 We transcode a Blu-ray–quality 

video file into H.264 format using 
HandBrake to test the multicore 
processor performance. Handbrake 
hasn’t yet been optimised for the M1.

GEEKBENCH 5  
SINGLE-CORE TEST
 This tests the capability of a single 

processor core. Many more common 
tasks on a Mac will only use a single 
core at a time. Geekbench 5 is a 
universal app running on Big Sur.

RISE OF THE TOMB 
RAIDER (1920X1080)
 For a real-world gaming test, we 

use the benchmarking tool in this 
game, with the graphics quality set 
to High and the resolution set to 
1920x1080. Not yet optimised for M1.

DAVINCI RESOLVE
 In Blackmagic Design’s editing tool 

for video professionals, we exported 
an effects-laden, 2.5-minute project 
to the H.264 format. The latest 
version of the app (Version 17.1) now 
runs natively on M1 Macs.

 BENCHMARKS Our analysis explained 

Duration (shorter is better)Index score (higher is better)

23 mins, 38 secs1,742

23 mins, 48 secs1,742

7 mins, 33 secs
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The colour-matched braided cable attaches magnetically, 
meaning it needs a little less force than before.

 Beautiful to look at 
and a dream to use, 
this is the iMac many 
of us hoped for. Go 
buy one.

 Plenty of power 
for the money

 Gorgeous 
4.5K display

 Touch ID – at last!
 Limited port choice

brother. That’s borne out in our 30-minute 
Handbrake test where the M1 iMac took 23 
minutes, 38 seconds to transcode a Blu-ray 
quality video; the 27-inch iMac achieved the 
same result in just 7 minutes, 33 seconds.

As you’d expect, the M1 iMac’s 
performance in our DaVinci Resolve test, 
where we render an effects-laden video, is 
on a par with other M1 Macs such as the Mac 
mini and 13-inch MacBook Pro, finishing the 
job in a shade under 29 minutes. However, 
the iMac did perform better in our Rise of 
the Tomb Raider benchmark, which runs 
through a 1980x1080 demo with graphics set 
to High, achieving a score of 40 frames per 

VERDICT

Apps open in a ssnapp, and 
getting any work doone feels 
quick and satisfyyingg

M1 is just the beginning 

So far the 24-inch Mac, Mac 
mini, MacBook Air, 13-inch 
MacBook Pro and iPad Pro have 
all been given the M1 treatment, 
but the really exciting stuff is 
still to come. Anyone wanting 
more power for work or play might 
want to wait for the rumoured 
30-inch iMac that’s due later this 
year or early next, along with 
replacements for the existing 
MacBook Pros. What’s certain is 
these new machines will be driven 
by more powerful Apple silicon 

that will finally enable Cupertino to 
show Intel the door. Rumour has it 
that work is already underway on a 
10-core M2, which will make its way 
into redesigned MacBook Pros plus 
a higher-spec Mac mini. The M2 
will have more high-performance 
cores (eight compared to the M1’s 
four) and vastly improved graphics 
power, with 16-core and 32-core 
GPUs mooted. The M2 is also 
expected to support up to 64GB 
of memory, compared to the M1 
maximum of 16GB. 

The squared-off edges and 
11.5mm depth make the iMac 
almost iPad like. And that’s 
no bad thing.

second (fps), whereas the other M1’s hit 30fps. 
The discrepancy here could be thanks to 
better cooling in the M1 iMac – we certainly 
heard the fans kick in although they were 
whisper quiet rather than roaringly loud.

Movies and calls
Finally, we can’t look at the M1 iMac without 
mentioning its movie playback prowess. 
Watch a 4K HDR movie on that Retina display 
and the result is gorgeous and rewarding with 
smooth motion, beautiful, realistic colours 
and suitably meaty sound effects (thanks to 
an improved six-driver speaker array, which 
sits behind the glass chin alongside the logic 
board and other components). 

FaceTime calls are improved too, thanks 
– finally – to the inclusion of a 1080p HD 
camera, while voice and video calls should 
sound clearer thanks to what Apple calls 
a ‘studio-quality’ three-mic array.

So, what do we make of the M1 iMac? 
Like the Mac mini, MacBook Air and 13-inch 
MacBook Pro, Apple has given its most 
affordable and most consumer-friendly 
machines a huge Apple-silicon shaped shot 
in the arm. The machines are quick to start, 
quick to use (for the most part) and deliver 
quality computing in spades. But the iMac is 
especially worthy of praise – it looks great, 
it works like a dream and addresses almost 
all of the shortcomings of its 21.5-inch 
predecessor. It’s not without caveats, sure, 
but for right here, right now the 24-inch iMac 
is practically perfect. We can’t wait to see 
what Apple does next. Rob Mead-Green
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Apple’s largest tablet is better than 
ever – if you can afford it

ig things are happening to 
Apple’s biggest tablet. The 
12.9-inch model on test here now 

sports the M1 – the same Apple silicon 
System on Chip (SoC) found on the Mac 
mini, MacBook Air, 13-inch MacBook Pro 
and 24-inch iMac.

The 2021 iPad Pro also includes a much 
improved display. Dubbed the Liquid Retina 
XDR display, it features 10,000 miniLEDs 
with 2,596 local dimming zones for improved 
colour fidelity and brightness – up to 1,600cd/
m2 in fact – and a 1,000,000:1 contrast ratio. 

Like its Mac siblings, the 12.9-inch iPad 
Pro also now comes with a Thunderbolt/
USB 4 port connection, enabling you to 
connect a huge range of peripherals – from 
Thunderbolt docks and displays to external 
drives, making it much more flexible. 

And the iPad Pro Wi-Fi + Cellular also 
includes support for 5G, so you can now get 
even faster connectivity on the go (conspiracy 
theorists need not apply). Also on board are 
Wi-Fi 6 (aka 802.11ax Wi-Fi) and Bluetooth 

5.0, plus a Pro camera system with Wide and 
Ultra Wide lenses on the back and a 12MP 
TrueDepth camera on the front.

The Pro options
Those are the headlines, now let’s delve into 
the options list: the base £999 model includes 
all of the goodies mentioned above and comes 
with 128GB of onboard storage, the £1,099 
doubles that to 256GB, and the £1,299 version 
doubles that again to 512GB. Spending £1,649 
nets you 1TB of storage space, while the £1,999 
version gets 2TB. These two top-tier models 
also get more memory. While the 128GB, 
256GB and 512GB versions get 8GB of unified 
memory, the 1TB and 2GB models get 16GB. 
Those are the Wi-Fi only prices. 

Wi-Fi + Cellular models cost even more 
– expect to pay £1,149 for the 128GB model, 
£1,249 for the 256GB, £1,449 for the 512GB, 
£1,799 for the 1TB, and £2,149 for the 2TB. 
Phew. Oh, and you’ll need to allow for an 
extra £448 if you want to add a second-
generation Apple Pencil (£119) and Magic 
Keyboard (£329) too.

If those prices are a little rich for you but 
you still want to go pro, the 11-inch iPad Pro 
has also received an M1 upgrade. Prices for 
that start at £749 for a 128GB Wi-Fi model and 
top out at £1,899 for a Wi-Fi + Cellular model 
with 2TB of storage on board. Note: the 
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12.9-inch iPad Pro (2021)

 From £999 (£1,149 model tested)  FROM Apple, apple.com/uk  
 FEATURES 12.9-inch Liquid Retina XDR display (2732x2048 pixels), Apple M1 chip 

(8-core CPU, 8-core GPU), 8GB of memory (128GB, 256GB and 512GB)/16GB of memory 
(1TB and 2TB), up to 2TB of storage, Pro camera system with 12MP Wide and 10MP Ultra 
Wide lenses, 12MP TrueDepth camera, Wi-Fi 6 (aka 802.11ax), Bluetooth 5.0, Face ID, 
Thunderbolt/USB 4 port, 40.88w/hr battery with up to 10 hours battery life

The Pro camera system 
combines a Wide 12MP lens 
and Ultra Wide 10MP lens with 
125° field of view.

Must-have accessories 

Apple’s Magic Keyboard and Pencil combine to really 
transform the tablet experience.

B

To really make the most of the iPad Pro, you’ll 
need to do what the pros do and get these

Apple Pencil 
(2nd generation)
 £119  apple.com/uk
 Apple’s smart stylus makes it easy to 

write, draw and paint on the iPad Pro’s 
screen, thanks to pressure sensitivity, tilt, 
and palm rejection. Its chiselled sides mean 
it won’t roll off your desk, and it attaches to 
the magnet connector for easy charging.

Apple Magic Keyboard
 £349  apple.com/uk
 Once you’ve used the magnetically 

attached Magic Keyboard, you’ll wonder 
how you ever managed to type on an iPad 
without one. Backlit and with widely spaced 
keys, it offers a comfortable typing 
experience while also helping to protect 
your iPad Pro when not in use.
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11-inch iPad Pro eschews the miniLED backlit 
Liquid Retina XDR display in favour of an 
LED-backlit Liquid Retina version.

While Apple has made sweeping changes 
to iPad Pro’s major components, it hasn’t done 
so with the design – and that’s no bad thing. 
It remains one of the best tablets out there. 
Build quality is excellent and we love the 
iPad Pro’s design aesthetic – its flattened 
sides, curved corners and aluminium body 
(available in Space Grey or Silver) look and 
feel fantastic and it’s a look that’s echoed 
across other Apple devices like the iPhone 
12, iPad Air and M1 iMac. In 12.9-inch guise, 
the iPad Pro does feel big, measuring 
214.9mm wide, 280.6mm long and 6.4mm 
deep. That can make it seem slightly unwieldy 
if you’re used to smaller tablets like the iPad 
Air. The larger version is also thicker than the 

model it replaces by 0.5mm, thanks to the 
presence of those miniLEDs.

As before, the iPad Pro comes with four 
speakers – two on the bottom either side of the 
Thunderbolt/USB 4 port and two on the top, 
meaning you can enjoy proper stereo when 
watching movies. The iPad Pro also comes 
with a magnetic connector on one side for 
securing and charging the Apple Pencil, 
plus you’ll find a Smart Connector on the 
back for the Magic Keyboard.

Power on tap
One of the most striking things about the 
Magic Keyboard is that attaching one makes 
the iPad Pro feel more Mac-like. When using 
its backlit, comfortably spaced keys and 
trackpad, your Mac muscle memory can’t 
help but kick in – although, of course, there’s 
a disconnect: iPadOS doesn’t work like 
macOS and so some of the interface instincts 
you want to use here will be wrong (more on 
this later). The Magic Keyboard is brilliant 
though, and we love having a proper 

The iPad Pro charges via 
Thunderbolt/USB 4, and lasts 
up to 10 hours of general use. 

Attaching the MMagicc 
Keyboard to thee iPaad Pro 
makes it feel moore Mac-like

1,000,000:1 contrast ratio, 
1,600 nits of peak brightness, 
P3 wide colour, True Tone and 
ProMotion… the XDR Liquid 
Retina display looks 
incredible.
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hardware keyboard to type on rather than 
an on-screen one. In the Magic Keyboard’s 
new White finish, it looks great too. However, 
it probably won’t take long for it to start 
looking grubby, especially if you frequently 
take your iPad on the road – a black Magic 
Keyboard might be a better option here.

Using this big, brilliant iPad Pro is 
tremendous fun – apps open in a snap, 
applying Machine Learning smarts to photos 
in Pixelmator Pro is a breeze, and playing 
console-derived games such as Divinity: 
Original Sin II (reviewed next issue) show off 
this machine’s incredible graphics prowess – 
with the caveat that iPadOS currently limits 
individual apps to a maximum of 5GB of 
memory. That seems fair when you remember 
that most iPads come with 4GB of memory 
or less (even last year’s iPro only has 6GB), 
but feels wrong when the iPad Pro potentially 
gives you up to 16GB to play with – hopefully 
Apple will address that in a future OS update. 
However, there’s so much power on tap that 
most of us will probably only ever scratch the 
surface of what the iPad Pro can do.

Hi-vis visuals
Talking of creativity, fire up an HDR movie 
and the Liquid Retina XDR display really 
delivers, with deep dark blacks, excellent 
contrast and incredible detail and colour, 
especially in darker scenes. You soon get lost 
in the on-screen action, especially with the 
stereo sound emanating from the built-in 
speakers as well. The display can also go very 
bright – almost ridiculously so. Crank up the 

brightness and you can feel the back of your 
retinas burning. Retina display indeed.

As we suggested earlier, where things 
can fall down is with iPadOS itself. Despite 
the fact that the iPad Pro is effectively a 
touchscreen M1 Mac, it doesn’t work like one. 
While the Files app is closer to Finder than 
ever, and the presence of sidebars helps, 
iPadOS still doesn’t feel as flexible as macOS 
– apps open in full screen by and large (unless 
you’re using Split View), while dragging and 
dropping between apps or in Files feels 
clunkier than in its macOS equivalent. 
iPadOS 15 goes some way towards addressing 
this, but the changes feel timid rather than 
bold – given the Mac and iPad Pro now share 
a common platform, the argument for having 
two separate OSes that work in different ways 
feels increasingly arbitrary. Rob Mead-Green

 The 12.9-inch iPad 
Pro was already 

one of the world’s 
best tablets. Now 

it’s even better.  

 Big, bright, 
beautiful display
 M1 superpowers

 Thunderbolt – at last!
 iPadOS feels limiting

VERDICT

The 12MP Ultra Wide front-facing camera enables Centre 
Stage – which keeps the user focused on in video calls.

GEEKBENCH 5  
SINGLE-CORE TEST
 We use this cross-platform 

benchmarking tool to measure 
a device’s performance, with 
a single-core processor baseline 
of 1,000. Higher scores are better.

3DMARK WILD LIFE 
(2560X1440)
 This cross-platform benchmarking 

app measures a device’s graphics 
performance, running a one-minute 
test at 2560x1440 resolution. Higher 
frame rates are better.

PERFORMANCETEST 
MOBILE (PASSMARK)
 Another cross-platform 

benchmarking tool for mobile 
devices, this one provides individual 
scores. Here we’re measuring 
storage read/write speeds.

 BENCHMARKS Our analysis explained 

Index score (higher is better)

1,697

1,590

1,598
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Paul says…
 As a creative, drawing 

on the iPad is really 
enjoyable – sketching 

away on Procreate for 
iPad from the comfort of 

a sofa is a joy. But I do 
have mixed feelings 

about the tablet. The 
hardware is superb, but 

the software is a little 
hit-and-miss.
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 A small but welcome 
update. The A12 Bionic 
chip makes the Apple 
TV slick to use, aided 

by the redesigned 
Siri Remote. 

  More future-proof 
than before

  Redesigned remote is 
a huge improvement

  Easy-to-use interface
 Rivals are cheaper

VERDICT

The iPod-like clickpad on the new Siri Remote is far less 
prone to accidental presses than its predecessor.
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Apple TV 4K (2021)
Apple’s TV streamer now with a fast 
processor and all-new remote

 £189  FROM Apple, apple.com/uk  FEATURES A12 Bionic chip, 
32GB/64GB of storage (64GB model tested), Wi-Fi 6 (aka 802.11ax 
Wi-Fi), Bluetooth 5.0, 1x HDMI 2.1 port, 1x Gigabit Ethernet port, 
Siri remote, Lightning cable

The Apple 
TV 4K now 

includes Wi-Fi 
6, Bluetooth 

5.0, and 
supports 

Thread

hink the new Apple TV 4K looks 
familiar? That’s because it is, 
coming in the same shape and size 

as the previous generation. But this new 
version has an A12 Bionic chip (replacing the 
A10X found in its older sibling), and an all-new 
aluminium Siri Remote, which has been 
completely redesigned.

The rounded-corner TV streaming box 
retains its compact, yet chunky dimensions, 
measuring 98x98x35mm and features a matt 
black top with Apple TV logo, gloss black sides, 
with an HDMI 2.1 port (upgraded from the 
previous gen’s HDMI 2.0) and a Gigabit Ethernet 
port on the back. The 2021 Apple TV 4K also 
now includes Wi-Fi 6 (aka 802.11ax) and 
Bluetooth 5.0, plus it supports Thread – the fast-
growing Internet of Things (IoT) protocol, while 
also doubling as a home hub for HomeKit-
compatible smart home gear. 

The Apple TV 4K is available at two different 
price points, the only difference being that the 
£169 model has 32GB of on-board storage (for 
things like apps and games), while the £189 
model has 64GB. Given the tiny price difference, 
it makes sense to opt for the larger capacity 
model if you can afford it.

tvOS 14 remains as easy as ever to use, but 
navigating your way around its menus and 
sub-menus feels slicker and quicker now thanks 
to that A12 Bionic chip. The biggest difference 
to usability comes via the Siri Remote (also 
available separately for £55), which now features 
a circular iPod-like touch-enabled clickpad and 
a couple of additional buttons – a dedicated 
Power button (which can also switch on/off 
your TV at the same time) and a Mute button. 
The previous gen’s Menu button is now a 
Back button. Siri access has been moved to a 
dedicated button on the right side – pressing 
it enables you to use Apple’s virtual assistant 
to quickly access your favourite content, carry 
out App Store and iTunes searches and more.

Dolby and HFR HDR
The Siri Remote is certainly much easier to use 
than the model it replaces – that version had a 
large touch-enabled clickpad at the top of the 
device that was too easy to trigger accidentally 
(such as when picking up the remote). The 
new iPod-like clickpad is much less prone to 
being triggered at random, and you can either 
use the four directional buttons to navigate or 
glide your fingers across or around the circular 
clickpad. That makes it easier to scrub forward 
or back when watching content in apps that 
support its new gestures, however not all apps 
have been updated to take advantage of it… yet.

If you’re a home cinema buff, another 
reason to get the new Apple TV 4K is that it now 
supports Dolby Vision as well as High Frame 
Rate HDR, delivering much more dynamic 
range on TVs that support the feature. It’s 
all very impressive. Rob Mead-Green

While the latest update may not seem like a giant leap, the 
A12 chip, Wi-Fi 6 inclusion and redesigned remote make for 
a much more enjoyable Apple TV experience.

T
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 Easy setup, good 
connectivity features, 

including AirPlay 
support, and decent 

image quality. 

  Effective auto- 
focus feature
  Impressive 

connectivity features
  1080p resolution

  Best in a dark room

VERDICT

The M2e 
supports 

AirPlay screen-
mirroring to 

stream video 
from your 

Apple devices

The M2e provides HDMI, USB-C, USB-A and microSD for 
connectivity options, as well as a 3.5mm audio jack port.
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rojectors are primarily aimed at 
business users for presentations, 
or home cinema buffs who aren’t 

satisfied with a mere TV screen for 
watching Hollywood blockbusters. 
However, ViewSonic’s new M2e is a feature-
packed, compact projector that is well suited 
for use at home, while still being affordable 
enough to provide an alternative to a 
conventional TV.

The compact projector measures just 
184mm wide and deep, and stands 54mm 
high, so you shouldn’t have any trouble 
finding a convenient spot for it on a coffee 
table or stand. It’s light too, weighing in at just 
1kg and, as well as running off mains power, 
it’s also possible to power the M2e from a 
USB-C powerbank. The powerbank will 
need to provide at least 45W output, and the 
projector’s brightness will be reduced to 60%, 
but that’s still a handy option if you want to 
take it out into the garden for an alfresco 
movie evening on a warm summer night.

The primary projector features are fairly 
straightforward, with the M2e providing 
standard HD resolution (1920x1080) and 
1,000 lumens brightness. The image quality 
is good – although not a match for the Retina 
resolution that most of us are used to from our 
Apple devices – and its short ‘throw’ feature 
is actually quite impressive, as it can create 
an image 100 inches in size (diagonally) from 
a distance of just 2.7m from your screen. 
However, the relatively modest brightness 
does means that you really need to block 
external daylight as much as possible in 

order to see the image clearly. When trying 
the projector out in the office first, the slatted 
blinds were a problem, allowing in quite a lot 
of sunlight while testing the M2e on a sunny 
spring morning, but it was fine later in 
the day in a room with closed curtains.

Well connected
The projector scores in other areas too, 
particularly on ease of use for people who may 
not have used one before. As well as the 1080p 
lens, the projector also has a camera and light 
sensor built in, which allow it to auto-focus 
like the camera in an iPhone. We had the 
projector set up and perfectly focused in about 
five minutes. In fact, the most complicated 
aspect of the M2e is deciding which of its 
many input options you want to use. 

As you’d expect, there’s HDMI for 
connecting devices such as an Apple TV or 
Roku streaming stick, but it also has a USB-C 
port, USB-A, and MicroSD slot so that 
you can play video from a wide range of 
computers, mobile devices and storage 
devices. It’s got a respectable little set of 
Harman Kardon speakers already built in, 
but the M2e also provides a 3.5mm audio 
output, as well as Bluetooth for streaming 
to wireless speakers. The M2e even includes 
dual-band Wi-Fi and – although ViewSonic’s 
website bafflingly omits any mention of this 
– it supports AirPlay too. This means that you 
can use AirPlay’s screen-mirroring features 
to stream video via Wi-Fi from your Apple 
devices too (although this does require a 
5GHz Wi-Fi network).

The M2e won’t completely replace your 
TV, as it’s best suited for use in dimly-lit 
rooms, but its wide-screen image and the 
sheer versatility of its connectivity features 
make it a good addition to your home 
entertainment system. Cliff Joseph

AirPlay support makes the M2e a good option for 
movie nights with your Apple devices.

A versatile home projector with 
Wi-Fi and AirPlay support

 £549  FROM ViewSonic, viewsonic.com/uk
 FEATURES 1080p projector, HDMI, USB-C, USB-A, MicroSD,  

dual-band Wi-Fi and AirPlay

P

ViewSonic M2e
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 Look good and 
sound good with 

these great-sounding 
audio glasses. 

 Surprisingly 
impressive sound

 Nicely designed with 
discreet speakers

 Don’t pause 
automatically when 

removed/no off switch
 Not for true 
audiophiles   

VERDICT

The case is only a fraction on the bulky side considering 
it also acts as the charging station for the glasses.

Hardware APPLE CHOICE
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Fauna audio 
glasses
Audio kit for both your 
ears and your eyes…

 £249  FROM wearfauna.com  FEATURES Glasses with 2-way sound 
system (USound MEMS microspeakers, electrodynamic woofers), 
250Hz-20kHz, Bluetooth 5.0, IP52 dust and water resistance

The audio is 
clear with 

impressive 
stereo 

separation

hen it comes to the latest audio 
gadget, the future’s so bright we 
gotta wear shades! Designer shades 

that belt out our musical needs, that is. We’re 
talking about Fauna’s designer audio glasses. 

We’ve seen ‘open audio’ gadgets before and 
felt the addition of speakers has either ruined the 
look of a pair of perfectly good glasses or, more 
importantly, not impressed in terms of audio 
ability. The Fauna glasses look and sound great.

Fauna do both clear glasses and sunglasses, 
and the Fabula Crystal Brown sunglasses we 
reviewed are neat, light, and fashionable. We 
were expecting a weight penalty thanks to the 
temples’ audio control bars but at 50g they’re on 
a par with most designer shades. The case is 
chunky (169x57x66 mm) but it’s also pretty light 
(196g) considering it acts as the charging station. 

The case has a QR code in the lid, taking you 
to the Fauna website for set-up instructions and 
support. Six charging pins either side inside the 
case pair up with discreet contacts on the arms 
of the glasses; close the case, then plug in the 
(included) short USB-A to USB-C cable at the 
front. Four LEDs to the right of the port then 
indicate charge level. The glasses last around 
four hours per charge and the case can boost 
them back up several times.

You connect the glasses via Bluetooth, 
then let the audio magic commence. On the left 
temple, you double-tap to start or pause, slide 

back to increase volume/slide forward to lower 
volume, or tap and hold for four seconds to skip 
to the next song. For phone calls, double tap to 
accept or end a call; volume controls are the 
same, and you hold and tap for four seconds to 
decline a call. From the right temple, you double-
tap to activate your voice assistant. The controls 
are easy to remember and work perfectly.

 
Sound and vision
The audio is surprisingly good. Each arm 
comprises a MEMS electrodynamic speaker 
and woofer. We love the freedom the glasses 
provide – you don’t having to worry about fiddly 
wires/losing tiny earbuds/wearing oversized 
inconspicuous cans… The glasses lack a bit of 
bass oomph, but they can go pretty loud, and 
the audio is clear with precise directional audio 
and impressive stereo separation. Anybody 
particularly close by can hear a slight 
background noise but this is very minimal and 
no different to sound leaks from headphones. 
We appreciated the fact you are also well aware 
of external sounds, making the glasses feel safe 
to wear when, say, crossing a road or riding a 
bike. The beam-forming, echo-cancelling mics 
in the right arm mean making and receiving 
calls is also a clear and pleasant experience.

The Carl Zeiss Vision 1.8mm-thick acetate 
lenses are 50% lighter than mineral glass. The 
sunglasses provide over 99% UVA and UVB 
protection, and the clear options have a coating 
to protect from artificial light. The lenses can be 
changed for prescription ones at any opticians.

We’d have liked the audio to stop when the 
glasses are removed. And there’s no ‘off’ button 
(although the glasses go into standby mode after 
about 20 minutes). But these are minor niggles. 
The price is pretty fair too – given that Bose’s 
audio glasses are similarly priced. Jo Membery

The speakers and touchpad 
controls on the arms are 
very inconspicuous.
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 This low-profile 
mechanical keyboard 

is great, although it 
can take some 

getting used to. 

  High quality 
keyboard

  Customisable 
actuation/feel

 Can take some 
getting used to

 Bluetooth battery 
life is short

VERDICT

Keychron 
offers a choice 
of switch types 

as well as 
customisable 

key options

The Keychron website gives a detailed overview of what 
the options mean for key behaviour, travel and sound.
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uch as we like Apple’s Magic 
Keyboard for Mac, the typing 
experience falls a little flat. 

That’s, in part, due to the keyboard’s ultra-
slim profile. But it’s also due to the limited 
key travel, making it irksome to type on – the 
Apple Wireless Keyboard (2003-2015) it ain’t.

If you miss that old typing feel, then the 
K3 keyboard from Keychron might just be the 
solution. It’s a tenkeyless compact Bluetooth 
keyboard that offers a choice of switches and 
customisable keys – enabling you to get the 
feel you want. The K3 is also backlit (unlike 
the Magic Keyboard) and you can choose 
between white backlighting or whizzy RGB.

The Keychron K3 offers a choice of two 
main switch types: Low-Profile Gateron 
Mechanical (11.7mm) and Low-Profile 
Keychron Optical (10.7mm). Gateron 
Mechanical switches give you lots of tactile 
feedback; the Optical switches are better for 
gamers and typists who want lightning speed.

The choices don’t end there: Gateron 
Mechanical switches are available with three 
different levels of behaviour/sound level – 
Red (Linear/Quiet), Blue (Clicky/Clicky) and 
Brown (Tactile/Gentle). The Optical switches 
have seven options – from White (Linear/
Quiet) to Orange (Clicky/Clicky). The 
Keychron website helpfully explains what 
each of these colour options are best suited to.

Choosing the right switch/option is 
important. That’s because Gateron switches 
are soldered in place, whereas Keychron 
Optical switches are hot swappable – so you 
can mix sets of switches however you like. 
Our review unit shipped with three sets of 
Keychron Optical switches – Brown, White 
and Orange – and swapping them out is fairly 
straightforward, thanks to the inclusion of 
keycap/switch puller tools. Of the three sets, 
we preferred the default Brown switches, 
which offer decent travel while being quiet to 
type on. The Orange set has the most noise/
key ‘clackiness’.

Travel set
Swapping from Apple’s Magic Keyboard to 
the Keychron K3 takes some getting used to. 
Because this is a low-profile keyboard, you 
won’t get the same degree of key travel as 
some mechanical keyboards, however at 
10.7mm that’s a lot more travel than the Magic 
Keyboard can muster. The underside of the 
Keychron keyboard also has two pullout 
feet for added height. 

You can also pair the K3 keyboard with 
up to three different devices – using the 
multi-position switch on the back of the 
keyboard’s aluminium frame, where you’ll 
also find a Bluetooth 5.1/Off/Cable switch and 
a USB-C port for charging and/or direct 
connection to your Mac.

While this is a Bluetooth keyboard with 
auto shutoff, we didn’t find its battery life to 
be particularly long, so you’ll probably need 
to top up either after long typing sessions or 
every few days. The keyboard can also be 
slow to wake from sleep. Rob Mead-Green

Keychron K3
A low-profile mechanical keyboard with options
 $74 (about £50)  FROM Keychron, keychron.com  FEATURES Tenkeyless Bluetooth keyboard, choice of 

Gateron Mechanical or Keychron Optical switches, custom switch options, USB-C port for connection and charging
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Whatever the weather out there, make sure 
you’re ready for it with these brilliant apps

Reviewed by CRAIG GRANNELL

ON TEST…
 CARROT Weather
 Dark Sky
 Hello Weather
 (Not Boring) Weather
 Weather by Tomorrow.io
  Weather Underground: Local Map

BEST 
WEATHER 
APPS FOR 
iPHONE 
AND iPAD

Group test

APPLE CHOICE Group test
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iOS weather apps APPLE CHOICE

How we tested
 Counter-intuitively, we didn’t get 

hung up on weather forecasting 
accuracy. Doing so would have 
been scientifically illiterate, 
because you can only test 
accuracy for a single location 
at specific points in time. Instead, 
we concentrated on usability and 
clarity, along with each app’s 
wider feature set and options. 
Our primary test device was an 
iPhone, but we also used each 
app on an iPad to see which 
developers are optimising their 
output for Apple’s tablet.

here’s a line of 
thinking that 
weather forecasts 

are redundant. Just look out of 
the window! But that only works 
for about 10 minutes into the future. 
As everyone who’s marched out 
of the door wearing a T-shirt and 
subsequently been drenched will 
attest, longer-term forecasts are 
handy things.

These days, you needn’t 
rely on newspapers or the TV 
to help you plan: you can put a 
meteorologist in your pocket. Not 
literally, obviously… we’re referring 
to weather apps. Apple provides 
one in the form of the imaginatively 
named Weather, but search the 
App Store and you’ll find a range 
of third-party alternatives.

This round-up explores why 
you might look further afield. The 
apps on test provide rich feature 
sets, customisation and unique 
interfaces that might gel with you 
a little more than Apple’s app does. 
Also, there’s nothing stopping you 
installing several weather apps. 
Use each one for a specific function, 
even if you stick with Apple’s for an 
at-a-glance indication of whether 
you need to head out with a bottle 
of suntan lotion, a jumper, or an 
umbrella (in other words, ready for 
The Typical British Summer™).
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T

 Image credits (left to right,top to bottom): Electric Dream Machine Inc, Weather Underground LLC, Andy Works LLC, Grailr LLC

Rafi
eie

ngli
sh

cli
nic.

co
m



Image credits: Grailr LLC, Apple Inc/The Dark Sky Company LLC88 | MACFORMAT | AUGUST 2021

1 Available sources
>Weather forecasting is complex 

and accuracy varies wildly. Apps that 
enable you to switch between a range 
of sources can therefore be a boon.

2 Pricing and subscriptions
>You might balk at subscribing 

to a weather app, but weather data costs 
developers a lot of money. Consider 
the value proposition for what you need. 
A free version might be enough.

3 Settings and units
> Decide how much you want 

to bend an app to your will and have 
that govern your selection. Some are 
inflexible even with units. Others have 
many settings.

4 Data access
> How much weather information 

do you really need – just the temperature 
and a weekly outlook? If so, you’ll be set 
with pretty much any weather app.

Things to consider…

Dark Sky
 £3.99  FROM Apple, darksky.net/app

CARROT Weather
 Free or £4.99 per month/£19.499 per year 
 FROM Grailr, meetcarrot.com/weather

The original Dark 
Sky dazzled with 

cloud-like neon rainfall 
predictions billowing 
across black maps. 
Hyperlocal forecasts peeked 
an hour into the future, 
aiming to help keep you dry.

Now, the app’s more 
conventional in appearance 
yet recalls its minimalist 
roots in a forecast view 
that’s easy to scan. A single 
scrolling pane houses cloud 
cover, precipitation, and 
temperature information.

The map exists in static 
thumbnail form and a 
bespoke Map tab. The latter’s 
full globe view – with barely 
any delay – is the most fluid 

and gratifying. Beyond the 
glitz, a powerful notifications 
system provides daily 
summaries and alerts based 
on user-defined data points.

Omitting Home screen 
widgets is a blow, though, 
and the lack of alternate 
sources will sting if Dark 
Sky isn’t accurate where you 
live. Apple’s purchase of the 
app also means its long-term 
future remains unclear. For 
now, though, it’s a solid buy.

Like a weather 
forecaster combined 

with HAL 9000, CARROT 
Weather dishes out 
forecasts and sarcasm. 
This gives the app lashings 
of character, which alongside 
its AR mode and location 
game makes for the most 
unlikely of things: a fun 
weather app.

But tap almost anything 
and you can dig deeper, be 
that to unearth weather data 
in the main view or settings 
when holding tabs. A handy 
cards system shows info 
while using little screen 
space. On iPad, this is the 
sole app on test where it feels 

like the creator really cares 
about Apple’s tablet.

Interface Maker takes 
CARROT Weather the extra 
mile. You use a drag-and-
drop system to craft custom 
set-ups. The only downside 
is this and other key features 
like notifications and 
widgets, are behind an 
IAP. Still, the price matches 
feature-packed rivals – and 
the app itself betters them.

 Easy to read forecast
 First-rate precipitation map
 Single purchase and no IAP
 No Home screen widgets

 Excellent customisation
 Great on iPhone and iPad
 Character and clarity
 Maps aren’t the best 

1

2
1

APPLE CHOICE Group test
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Hello Weather
 Free or £1.99 per month/£12.99 per year 
 FROM Electric Dream Machine, helloweather.com

Hello Weather’s 
sunshine icon 

provides an indication of 
what’s to come. This breezy 
app has chunky visuals and 
revels in simplicity, rather 
than deep data dives.

That’s not to say it lacks 
information. Tap the ‘Right 
now’ section and you can 
view humidity, pressure, and 
UV details. The week’s 
forecast can be switched 
between bar charts and 
written form. The Home 
screen widgets are the 
best we’ve seen on iPhone 
– just don’t expect to tap 
something and be inundated 
with numbers and graphs.

Notably, the free version 
is also barely compromised 
from a visual standpoint, 
merely adding an upsell 
button to the forecast screen. 
It’s ideal for the basics or if 
you want a vibrant weather 
app. Go pro and unlock data 
sources beyond Dark Sky, 
a great Apple Watch app, 
and other settings. You 
should weigh up the value 
proposition for your needs.

43

 Vibrant, friendly design
 Superb Home screen widgets
 Impressive Apple Watch app
 Sluggish radar view

3

(Not Boring) Weather
 £1.79 per month/£14.49 per year 
 FROM Andy Works, andy.works

(Not Boring) 
Weather comes 

across more graphic 
design experiment than 
weather app. If it’s sunny, 
a bold red orb sits before you, 
with a temperature readout 
you could see from across the 
street. When it rains, chunky 
raindrops blaze across the 
screen from a black cloud.

Below these animations, 
you can access daily or 
weekly predictions, 
scrubbing across them to 
update the main display. It’s 
wonderfully playful – the 
moon and sun set and rise as 
you scrub; but it’s awkward 
to switch between views. 

Other drawbacks include 
widgets being mentioned 
in the app’s settings but not 
showing up on the Home 
screen and a subscription 
charge. Still, if you want a 
fresh approach to weather 
apps and are keen on other 
Andy Works apps (currently 
a timer and calculator, both 
unlocked with the same 
subscription), this one’s 
worth a look.

> VERDICT
 Unique visual design
 Playful, fun nature
 Awkward view switching
 Comparatively pricey

4

2

> VERDICT

iOS weather apps  APPLE CHOICE
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Weather by Tomorrow.io
 Free or £19.49 per year/£48.99 lifetime 
 FROM The Tomorrow Companies, tomorrow.io

Examine several 
iPhone weather 

apps and Weather by 
Tomorrow.io seems solid 
but struggles to stand out. 
The unfussy interface clearly 
outlines current conditions, 
and a Show Details button 
reveals a table with eight 
further data points for 
anyone desperate to know 
what the dew point will be 
at noon. There’s a jerkily 
animated map, news stories 
to browse, and options for 
notifications and units.

The Activities tab is more 
interesting. Here, you define 
activities you partake in, and 
can assign them to any of 

your locations. Bar charts 
then detail when would be 
optimal, good, acceptable, 
or bad for things like 
walking or driving. We’d 
be hard-pressed to splash 
out £19.49 annually for this 
app’s premium incarnation, 
which removes the ads and 
provides unlimited alerts, 
but as a freebie for the 
activities stuff it’s certainly 
worth a download.

5

  Clean, pleasant interface
 Activities recommendations
 Map is pretty poor
  No alternate sources

> VERDICT

6

Weather Underground: Local Map
Free or £3.99 per month/£19.49 per year 
 FROM Weather Underground, wunderground.com/download

A few years ago, this 
was an impressive 

free weather app. Weather 
Underground deftly packed 
in data and looked great. 
Since then, it’s regressed, 
with a comparatively 
decompressed interface that 
forces you to scroll too much.

Fortunately, there’s still a 
lot to like. The daily forecast 
pane makes it easy to spot 
rainfall and temperature 
trends over the coming 
week, and the sun/moon 
pane is brilliantly designed.

The best bit, though, is 
the Wundermap. A small 
version exists on the main 
screen, but tap that and it 

fills your display. It’s not as 
pretty as Dark Sky’s map, 
but is slick and responsive 
as you pinch-zoom to view 
rainfall and temperature 
readings. Handily, it doesn’t 
lurk behind the IAP – this 
app’s premium tier merely 
removes adverts and adds 
‘smart forecasts’. So stick 
with the free version and 
get a first-rate weather map 
on your phone.

 Useful, fluid, responsive map
 Great daily forecast pane
 Decompressed design
 No Home screen widgets

6
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 How 
do they 
compare?
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lexibility, features, 
and fun combine 
to make the best 

weather app on both the 
iPhone and iPad. From an 
objective standpoint, CARROT 
Weather blows the competition 
out of the water. That said, it 
doesn’t better its rivals at 
everything – Dark Sky and 
Weather Underground have 
superior maps; Hello Weather 
is bolder and friendlier; there’s 
no equivalent of Weather by 
Tomorrow.io’s activities 
recommendations. But it gets 
things right where it counts.

The app is packed with 
features and it’s hugely flexible, 

with a superb interface 
designer. It doesn’t flood the 
screen with information, but 
leaves deep data dives only a 
tap away. And it is equally 
impressive and optimised for 
iPad. The snag is that you pay 
for that quality, though the price 
tag is pretty reasonable.

Anti subscriptions? Go for 
Dark Sky – assuming Apple 
doesn’t remove it from play. 
Happy to pay monthly but want 
something simple? Get Hello 
Weather. And if you don’t fancy 
paying any money but are bored 
with Apple’s Weather, go for the 
free versions of the CARROT 
and Hello Weather apps.

Note: The final verdict scores reflect the overall opinion of a product and are not necessarily an average of the criteria listed in the table.

Feature-packed forecasts with 
a funny outlook

F

> Specs CARROT  
Weather Dark Sky Hello Weather (Not Boring) 

Weather
Weather by 
Tomorrow.io

Weather 
Underground

Price Free or £4.99 per 
month or £19.99 per 
year (premium tier)

£3.99 Free or £1.99 per 
month or £12.99 
per year or £43.99 
lifetime

£1.79 per 
month/£14.49  
per year

Free or £19.49 per 
year or £39.99 
lifetime

Free or £3.99 per 
month or £19.49  
per year

Website meetcarrot.com/
weather/

darksky.net/app helloweather.com andy.works tomorrow.io/
consumer-app/

wunderground.com/
download

Multiple sources Yes No Yes Yes No No

Notifications Custom Custom No No Custom Severe/significant 
weather

Extended forecast Up to 14 days 7 days 7 days 7 days 14 days 9 days (free);  
15 days (premium) 

Units Custom UK/USA/metric UK/USA/metric UK/USA/metric UK/USA/metric/
custom UK/USA/metric

Apple Watch app Yes Yes Yes No Yes No

Home screen widgets Yes No Yes No No No

> Overall

THE WINNER  
CARROT Weather

iOS weather apps  APPLE CHOICE
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APPLE CHOICE Software

 Image credit: Sawyer Blatz

racking and managing 
personal budgets 
would seem to be a 

task well suited to software. 
But many applications on the 
market are more business-
oriented, with features that a 
regular user probably doesn’t 
need. There’s always a Numbers 
or Excel spreadsheet then, but, 
well, they’re not exactly fun. 
Nudget aims to streamline and simplify the 
tracking of your personal spending. If it’s 
easy to do, people are more likely to do it. 

Nudget is slick and Apple-like. There 
are no sign-ups or logins, and iCloud sync 
is available across your iOS devices. Face ID 
can also be used on supported devices for 
authentication. On first launch you are 
prompted to enter your monthly income, 
which can be edited at any point, and extra 
income can be added on an ad-hoc basis.

In the Budget section, you can add 
recurring expenses like rent or subscriptions 
that the app will automatically factor into 
your budget. You can also specify an amount 
you plan to put into savings every month. 
The Budget screen shows you how much 
spending money you have, based on 
deductions for expenses and savings. The 
figures can be split by day, week, fortnight, 

month, quarter, or year. The day-to-day 
business of tracking spending then happens 
in the Transaction section. Here you simply 
tap to add an amount when you make a 
purchase and there are editable tags like 
transit, groceries, clothing, and more. The 
developer recommends using fewer, more 
generic tags rather than the names of 
individual stores, for example, to keep 
the overviews more readable. 

Hey big spender
These transactions automatically get 
deducted from your available spending 
money and the third section, called Insights, 
provides you with an overview of how your 
spending is going. There’s a budget 
projection, a list of your biggest purchases, 
notable drops and jumps in spending in 
specific categories, and a total spend 
indicator. This data can be viewed using the 
same date range breakdowns as mentioned 
above. Data can be exported as plain text too. 

Nudget is a straightforward way to record 
and track personal spending that’s beautifully 
designed. Bear in mind that it’s not linked to 
your actual bank accounts, so it only knows 
what you tell it. It also seems a perfect 
candidate for Apple Watch support, and 
happily this is slated for a future update. 
Budget tracking can be a chore, but Nudget 
is one of the easiest ways to do it, providing 
a clear and uncluttered overview of your 
finances. Hollin Jones

Nudget is a 
beautifully 

designed way 
to track your 

personal 
spending

 £3.99  FROM Sawyer Blatz, nudgetapp.com  
 NEEDS iOS 13 or later
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Nudget: Spending Tracker
An easy way to monitor your money

Nudget is slick and Apple-like, and iCloud sync is 
available across devices. 

 Nudget is a well-
designed budget 

tracker that keeps 
things simple. 

 Very affordable
 Easy to set 
up and use

 iCloud sync 
across iOS devices

 Apple Watch 
support is pending

VERDICT

T

Get detailed but clear insights into how your spending 
habits break down.
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 This is a companion 
app rather than a 

standalone Mac app.

 Syncs over iCloud
 Made for fingers

VERDICT

 A modest update 
for everyone but 

macOS Big Sur users. 

 Dual-pane 
file manager

 Not M1 optimised

VERDICT

Software APPLE CHOICE

otability is one 
of our favourite 
note-taking apps 

for iOS and iPadOS. 
The Mac app interface is 

organised into four sections, 
including the main editing 
window. The Library is a 
Finder-style sidebar that 
shows note categories; to its 
right are the thumbnails of the 
notes in that category. There’s 
a main edit panel, and a note 
navigator with thumbnails of 
the current note at the right. If 
you hide all the other panels, 
the editing panel automatically 
resizes and rescales. We found 
that quite annoying – hiding 

the panels made the text jump 
from 11pt to 20pt, and 
switching into full-screen 
mode took it to 48pt.

One of the things we like 
best about Notability on iOS is 
its support for Apple Pencil, 
enabling you to annotate, 
scribble, sketch, and highlight 
in a really natural way. You 
can do all these things with 
your Mac too, but unless you 
have a graphics tablet or use 
your iPad and Pencil via 

Sidecar it’s quite awkward 
with a trackpad or mouse. 
And if you’re going to use 
Sidecar you might as well 
use the iPad Notability app.

Note that handwriting 
recognition, to turn writing 
into editable text, and maths 
recognition, to turn equations 
into hi-res images, are in-app 
purchases (at £2.99 each).

Notability on Mac is best 
considered as a companion to 
the iPad app. Carrie Marshall

espite Finder’s 
advances, there 
are still Mac 

owners who feel it doesn’t 
go far enough. Commander 
One 3.0 is a versatile dual-pane 
solution with support for 
unlimited tabs, hotkey 
shortcuts, built-in Command 
Line bar, and FTP client that 
speeds up everyday tasks, and 
eliminates the need for third- 
party utilities. It also now 
directly accesses cloud storage 
services Google Drive, 
OneDrive, Mega, and pCloud, 
as well as Dropbox and Box.

There’s now full support 
for Big Sur. The app remains 

Intel, although it installed and 
ran fine on our M1 MacBook 
Pro. Despite the claims of 
faster data transfer rates, 
we found the Apple silicon-
enhanced Finder copied an 
80GB Parallels VM to a USB 
3-connected external SSD 
in just under three minutes – 
about 10 seconds faster than 
using Commander Pro.

The overcrowded interface 
is chock full of options, but file 
manager competitors Path 

Finder or ForkLift feel more 
like native Mac apps while also 
improving discoverability of 
crucial features, which are 
largely buried here.

That said, compatibility 
with macFUSE 4 enhances 
Commander One’s handling 
of native file systems, as well 
as those from third parties. 
Amazon S3 users will also like 
a new option to use path-style 
URLs when accessing their 
buckets. JR Bookwalter

Notability
Share and sync with iOS devices
 £8.99 (IAPs)  FROM Ginger Labs, gingerlabs.com  
 NEEDS macOS 10.15 or later

Commander One 3.0
A dual-pane Finder alternative
 Free (IAPs)  FROM Electronic Team, ftp-mac.com  
 NEEDS macOS 10.12 or later

N

D

You can record audio with notes 
– useful in meetings and lectures.
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The interface just doesn’t feel 
like a native Mac app.
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Comparisons let you see 
how your changes are 

altering the original shot.

APPLE CHOICE Software

 Image credit: Charles Games

he premise of Attentat 1942 
seems simple – you interview 
survivors of the Nazi occupation 

of Czechoslovakia to discover 
information about your grandfather. 
The more you play, though, the more it reveals 
the complexity and ambiguities of trying to 
survive amidst such brutal repression.

Why was your grandfather arrested by 
the Gestapo? How did your grandmother 
survive the war? These are surface questions, 
but they reveal deeper uncertainties – 
by agitating against Resistance activities, 
are you a collaborator or a survivor? Should 
you fight back even if it triggers violent 
retaliation against innocent people? The 
characters react in different ways; the past 
is complex, the truth hard to discern.

Much of the game involves interviewing 
these people in live-action vignettes. The 
characters are portrayed by actors, but they 
are remarkably believable thanks to the 
writing and the skill of the actors. The story 
was written by historians, giving it a 
grounded authenticity.

You can easily forget Attentat 1942 is 
a game that must be completed rather than an 
interactive movie that you passively consume. 
Ask the wrong question and your subjects can 
suddenly trail off or refuse to divulge any 
more, temporarily locking you out of lines of 
inquiry or interview subjects. You can redo 
interviews at the cost of one coin per retry, but 
these often involve long, unskippable sections 
before you get the chance to ask a fresh 
question, which is a shame.

Under pressure
How do you earn coins? By completing the 
mini games scattered throughout Attentat 
1942. Each is set during the occupation period 
and takes the form of an animated comic 
strip. Some are puzzles while others comprise 
quick-time events, so there’s a good variety 
to keep you on your toes.

Frustratingly, many are completely devoid 
of hints. One game involves stalling the 
Gestapo at your front door so your wife can 
hide incriminating Resistance evidence, with 
each word you choose spawning more options 
to blurt out under the pressure of an ever-
decreasing time bar. Most options seem 
reasonable, making choosing the correct 
one feel like an exercise in guesswork. Get it 
wrong and the worst that happens is you miss 
out on some coins, but it feels a little arbitrary.

This is a minor gripe, though. Attentat 
1942 is an otherwise excellent experience. 
Its lifelike, deeply realistic portrayal of life 
under occupation – the fear, the resilience, the 
attempts at survival, and even some degree of 
normality – will resonate long after you finish 
it. Regardless of whether you’re a history buff 
or exploring the subject for the first time, 
there’s plenty to love. Alex Blake

The story was 
written by 
historians, 
giving it a 
grounded 

authenticity

 £3.99  
 FROM Charles Games, attentat1942.com  
 NEEDS macOS 10.15 or later
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Attentat 1942
Life under Nazi occupation in 
authentic voyage of discovery

You must interview survivors of Nazi repression to 
progress the story.

 History brought to 
life with poignancy 

and gravitas. 

 Realistic 
and believable

 Excellent acting
 Fascinating story
 Some repetition

VERDICT

The characters’ memories are 
portrayed using comic strips.
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 Better than ever, and 
now free for all to use.

 Best-in-class 
document scanner

 Sharing watermark 
on free app

VERDICT

VERDICT
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Software APPLE CHOICE

 Image credit: Readdle Inc, GoodTask by Haha Interactive/HiLab Co

canner Pro has 
recently been 
updated to version 

8.0. The biggest change? The 
app is now free, so everyone 
benefits from auto crop, 
shadow removal, iCloud 
syncing, and sharing with 
others – albeit with a 
watermark. This limitation 
can be removed with a Plus 
subscription (£19.49/year), 
which also enables on-device 
OCR in 26 languages, full text 
search, password protection, 
and automatic upload 

workflows. These and other 
current features remain 
unlocked for those who own 
the paid version; developer 
Readdle plans to introduce 
additional goodies which 
may or may not require 
a subscription.

The update also enhances 
Scanner Pro’s look and feel, 
and organisation approach. 
The interface now uses dual 
shades of eye-pleasing purple, 
with the option to view scans 

as thumbnails or in a list. New 
sorting options allow finding 
docs more quickly by name, 
date created, or date modified.

The Text Vision feature 
recognises scanned text in a 
document so you can copy or 
share it, and the app now uses 
that data to make the content 
of all saved files searchable. 
This feature works from the 
app home screen or can be 
limited to the currently open 
document. JR Bookwalter

oodTask makes 
the process of 
creating tasks as 

easy as possible. Version 6.4 
adds a Board View that lets 
you easily view upcoming 
tasks by deadline in columns 
across the screen.

The app syncs with iOS 
Reminders and Calendars and 
pulls in lists from the former. 
You can pick which lists to 
include and create new ones, 
add tags to tasks and filter 
them to only see those with, or 
without, a specific tag. Actions 
enable you to create or edit 
parameters, such as title, due 
date, and notes. Quick Actions 

allow you to apply multiple 
Actions simultaneously. There 
are several ready to use, or you 
can create your own. You can 
also create templates – groups 
of tasks and subtasks – and 
apply one on any given day, or 
set it to recur. 

The app can be customised 
with themes, and you can 
change font sizes and the way 
tasks are displayed. There’s an 
accompanying Apple Watch 
app, and support for iOS 

Widgets. The Favorites widget 
lets you add a customised new 
task or directly open a list. 
And you can share lists using 
Share Sheets. 

One of the few things 
GoodTask doesn’t do is allow 
you to collaborate or delegate 
tasks easily with others. The 
iOS app costs £9.99 to unlock 
all features; the Mac version 
costs £38.99. That’s still 
competitive and good value 
for money. Kenny Hemphill

Always find what you’re looking 
for from the home screen search.

The refined interface ncludes the 
option to display docs in list view.

Scanner Pro: PDF 
Scanner App
Excellent free mobile scanner 
 Free (IAPs)  FROM Readdle, readdle.com  
 NEEDS iOS 11 or later

GoodTask 6.4
Track everything about yourself
 Free (IAPs)  FROM Haha Interactive, hahaint.com  
 NEEDS iOS 12 or later

Quick Actions allow you to apply 
multiple actions with one tap.

You can create Smart Lists based 
on task parameters.

S

G

 A powerful and 
highly customisable 

task manager. 

 Powerful 
Quick Actions

 No delegation or 
collaboration tools
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APPLE CHOICE App round-up

ummer is finally upon us, and 
if a wet Spring has stopped 
you from making the most 

out of your garden, now is the time 
to get out there and put your green 
fingers to work. 

While gardening may seem like a 
very traditional pastime, it can really 
benefit from a touch of digital 

assistance. Whether you want to grow 
your own veg or nurture a field of 
beautiful flowers, there are plenty of 
apps to help you. We’ve rounded up six 
gardening apps that do everything from 
identifying plants and offering growing 
tips to planning your dream garden in 
minute detail. Best of all, they’re all 
completely free to get started. 

 Image credits: iScape Holdings, Bento Software, The Royal Horticultural Society

6 apps to 
rejuvenate 

your garden
Turn over a new leaf with these apps

To have a thriving garden, you 
need to plan it to perfection. 
Visualising how the finished 

product should look can be tricky, but 
iScape makes it simple. This handy app 
lets you plan and landscape your garden 
from the comfort of your device. With 
tons of design tools on hand and easy 
ways to purchase the products you need, 
you’ll have a ready-to-go plan in no time.

What better place to get 
gardening advice than the Royal 
Horticultural Society? The 

RHS’s Grow Your Own app is chock-full 
of advice tailored to your experience and 
skill level. There’s a calendar to help with 
planting schedules, advice for common 
problems, plus help for over 100 varieties 
of fruit, veg and herbs. Even better, it is 
100% free, with no fees or subscriptions.

iScape
 Free (IAPs)  NEEDS iOS 12.2 or later

Grow Your Own
 Free  NEEDS iOS 8 or later

While iScape focuses on your 
entire garden, Veggie Garden 
Planner drills down into the 

detail of planting and growing your own 
vegetables. You get a top-down view of 
your plot, with tips on which vegetables 
grow well next to each other and which 
are bad neighbours, when to sow and 
when to harvest, and advice on best 
practices for crop rotation. 

Veggie Garden Planner
 Free (IAPs)  NEEDS iOS 9 or later

Reviewed by ALEX BLAKE
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As your plants grow and your 
garden develops, it’s important 
to keep track of everything and 

ensure it’s going to plan. The Gardenize: 
Grow & Track Plants journal app lets 
you record your plants and the actions 
you’ve taken through photos, notes, and 
reminders. You can also connect with 
other users and find inspiration in their 
gardening success stories.

Gardenize 
 Free (IAPs)  NEEDS iOS 10 or later

Rearing an outdoor garden is 
one thing, but growing plants 
indoors is another matter. 

Planta offers advice based on where you 
grow your plants, whether indoors or 
out. With care guides and reminders, 
flower identification tools, and even a 
light meter to ensure your plants are 
never under- or over-exposed, it has 
all you need for happy horticulture.

Planta: Keep your plants alive  
 Free (IAPs)  NEEDS iOS 13 or later

Do you have a mystery plant 
lurking in your garden that you 
can’t identify? PictureThis – 

Plant Identifier uses artificial intelligence 
to classify almost anything growing in 
your garden – just snap a quick pic and 
it gets to work. Once the plant has been 
unmasked, PictureThis can diagnose 
problems and guide you on how to care 
for it, with reminders and notes. 

PictureThis 
 Free (IAPs)  NEEDS iOS 11 or later
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 Ever since the Bondi Blue iMac 
debuted in 1998, Apple’s all-in-
one desktop computer has been 
setting standards in gorgeous 
design and powerful performance.
And Apple’s April 2021 Spring 
Loaded event delivered the new, 
colourful 24in iMac, available in 
green, yellow, orange, pink, purple, 
blue, and silver. The larger screen 
has also been bumped up to a 
4.5K Retina display with a 
4480x2520 resolution. 

Inside, Apple’s own M1 chip 
combines with macOS Big Sur, and 
Apple promises up to 85% faster 
CPU performance and up to two 
times faster graphics performance 
than the 21.5-inch iMac models. 
All the models come with 8GB of 
unified memory (upgradeable to 
16GB). The eight-core CPU/seven-
core GPU option comes with a 
256GB SSD (configurable to 512GB 
or 1TB). The eight-core CPU/eight-
core GPU versions come with either 
a 256GB or 512GB SSD and can be 
upgraded to 1TB or 2TB.  

The new iMacs all feature a  
1080p FaceTime camera, a high-
fidelity six-speaker system, a studio-
quality three-mic array and support 
for spatial audio. You’ll also find two 
Thunderbolt/USB 4 ports on each 
model, with middle- and high-end 
options gaining two additional 
USB-C ports. Thunderbolt 2, HDMI, 
DVI and VGA are supported using 
adaptors.) All come with a Magic 
Keyboard, with the mid- and high-
end versions boasting Touch ID. 
Prices start at £1,249. 

The 27in iMac, last updated mid 
2020, sports SSDs across the line 
and you can choose from six-core 
tenth-gen Intel Core i5s on the entry 
level models, or an eight-core tenth-
gen Intel Core i7. The 27in iMacs 
also boast AMD Radeon Pro 5300 
graphics on the entry and mid-
range models, and an AMD Radeon 
Pro 5550 XT GPU on the £2,999 
model. All three models have 5K 
Retina displays with True Tone. You 
can add up to 128GB of memory 
and up to 8TB of solid-state storage.

iMac

 Choose an iMac
 MODEL  KEY SPECIFICATIONS  PRICE

24in, M1 MEMORY 8GB of unifed memory
GRAPHICS Seven-core GPU
STORAGE 256GB SSD
DISPLAY Retina 4.5K (P3 gamut) 
ALSO Magic Mouse, Magic Keyboard

£1,249

24in, M1 MEMORY 16GB of unifed memory
GRAPHICS Eight-core GPU
STORAGE 512GB SSD 
DISPLAY Retina 4.5K (P3 gamut)
ALSO Magic Mouse with Touch ID,  
Magic Keyboard

£1,649

27in 3.8GHz  
eight-core  
Intel Core i7

MEMORY 8GB of 2,666MHz DDR4
GRAPHICS AMD Radeon Pro 5500 XT
STORAGE 512GB SSD 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse, Magic Keyboard

£2,299
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 From 
£1,249

The 24in iMac released in April brought with 
it a return of colour to the Apple spectrum.

EXPECTED
AUG 2022
UPDATED
APR 2021

EDITED BY ROB MEAD-GREEN 

Your complete guide to the 
best Apple hardware and 
third-party accessories
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 Aimed at creative pros, 
Apple’s high-end desktop 
has always been designed 
to deliver as much power 
and flexibility as possible.

Ironically, the previous ‘trash 
can’ Mac Pro proved to be a 
design dead-end, and so Apple 
came up with this – a stainless 
steel and aluminium tower that’s 
almost infinitely configurable – 
you can even add wheels if 
you want to.

If the price at the top makes 
you wince, that’s just the start – 
prices rise incredibly steeply 
once you get beyond the 
standard spec, and even those 
wheels will cost you £400, while 
adding six 128GB DDR4 EEC 
memory cards costs £14,000. 
Given that you can fit everything 
from a 28-core Intel Xeon W 
processor to 8TB of SSD storage 
that’s hardly a surprise, though.

Mac Pro

EXPECTED 
DEC 2021

 In November 2020, Apple rather 
surprised the tech world with an earlier-
than-expected release of the first 
MacBook Pro with its own custom 
designed 5nm Apple M1 chip. 

The eight-core CPU is said to offer 
2.8 times faster performance over its 
predecessor, while the eight-core GPU has 
five times faster graphics. The 16-core 
Neural Engine completes the powerhouse 
spec sheet for advanced machine learning. 
All this, coupled with a 61W battery, 
translates to the longest battery life for 
a MacBook Pro so far, with an impressive 
17 hours of web browsing and 20 hours 
of video play. The Pro comes with 8GB 
of unified memory but you can upgrade 
to 16GB. Storage starts at 256GB SSD, 
and can be configured up to 2TB. 

The physical build remains the same as 
the May 2020 model (1.56x30.41x21.24cm), 
and still features the Magic Keyboard, Touch 
Bar, Touch ID and Force Touch trackpad. 
There are now two Thunderbolt/USB 4 
ports. As well as Bluetooth 5.0, the 13in 
Pro now supports 802.11ax Wi-Fi. 

13-inch model pricing starts at £1,299; 
while upping the unified memory to 16GB 

MacBook Pro

 Choose a MacBook Pro

 From 
£1,299

 From £5,499

and opting for the top SSD storage of 
2TB takes the price to £2,299.

So far, only the 13-inch model has been 
updated to the M1 chip, but the 16-inch is 
obviously due to follow. The 13-inch 2.0GHz 
Intel Core i5 Quad Core model with Intel Iris 
Plus Graphics, starting at £1,799, is still 
available. As are the 16-inch ninth-gen Intel 
Core models, which start at £2,399.

The new Mac Pro has 
been designed to be as 
configurable as possible.

The MacBook Pro 13-inch 
(Late 2020) features Apple’s 
own silicon 5nm M1 chip.

 MODEL  KEY SPECIFICATIONS  PRICE

13in, M1 
8-core CPU, 
8-core GPU

MEMORY 8GB of 
unified memory
STORAGE 256GB SSD
TOUCH BAR Yes
TOUCH ID Yes

£1,299

13in, M1  
8-core CPU, 
8-core GPU

MEMORY 16GB of 
unified memory
STORAGE 512GB SSD
TOUCH BAR Yes
TOUCH ID Yes

£1,699

16in 2.4GHz  
8-core  
Intel Core i9

MEMORY 64GB of  
2,666MHz DDR4
GPU AMD Radeon 
Pro 5500 4GB
STORAGE 1TB SSD
TOUCH BAR Yes
TOUCH ID Yes

£3,799
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UPDATED
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 Apple’s thinnest, lightest laptop 
now also gets the M1 treatment. 
But without a price hike! Prices 
still start at just £999. The next 
step model (with increased SSD 
storage and eight-core GPU) even 
costs £50 less at £1,249. Like the 
MBP, Apple’s own unified memory 
silicon enables faster performance 
and better graphic speeds. And the 
16-core Neural Engine results in nine 
times faster machine learning. 

It may be Apple’s most 
affordable laptop, but the MacBook 
Air certainly doesn’t feel like a 
budget machine, thanks to its 100% 
recycled aluminium unibody, and 
13.3-inch LED-backlit Retina display, 
which has a resolution of 
2560x1600 (227ppi) and True Tone, 
which automatically adjusts the 
display’s colour temperature 
depending on the ambient light.

The inclusion of the M1 chip has 
changed none of the Air’s physical 
characteristics – the portable laptop 
is still just 1.61cm thin, and weighs 
1.29kg. Despite the performance 
boost, the Air is now fanless, using 
an aluminium heat dissipating panel 
instead – which also means that it 
runs in complete silence.

The base model comes with an 
eight-core CPU, but a seven-core 
GPU, and 256GB SSD storage. While 
on the step-up model, the CPU and 
GPU are both eight-core, and the 
storage starts at 512GB. Both offer 
the option to upgrade to 16GB 
memory, and are configurable 

 MacBook Air

 Despite a near two-year wait for 
the last update to the Mac mini, 
within just eight months, Apple 
released it again in November 2020 
with the homegrown M1 chip.

The processor boasts far superior 
processing and graphics performance 
to the Intel innards of the previous 
incarnation. Like the MacBook Pro 
and MacBook Air, the base model 
starts with 8GB of memory that can 
be boosted to 16GB. The SSD options 
go from 256GB all the way up to 2TB.

The Mac mini now supports Wi-Fi 
6 and Bluetooth 5.0. You get two 
Thunderbolt/USB 4 ports, as well 
as two USB-A ports, an HDMI 2.0 
port and a 3.5mm headphone jack. 

The entry level Mac mini is 
available for £699. Taking it to its max 
memory and SSD capacity will set you 
back £1,699. The 3.0GHz Intel Core i5 
model is still available from £1,099.

 Choose a MacBook Air

 MODEL  KEY SPECIFICATIONS  PRICE

13in, M1  
8-core CPU, 
7-core GPU

MEMORY 8GB of 
unified memory
STORAGE 256GB SSD
TOUCH BAR No
TOUCH ID Yes

£999

13in, M1 
8-core CPU, 
8-core GPU

MEMORY 16 GB of  
unified memory
STORAGE 2TB SSD
TOUCH BAR No
TOUCH ID Yes

£2,049
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 Apple’s media streamer has been 
around since 2007, and in April 
2021 Apple unveiled the sixth 
generation. Running an A12 Bionic chip 
and its own OS (tvOS), the latest model 
offers 4K high frame rate HDR. You get 
Apple TV+, as well as access to third-
party content using apps such as BBC 
iPlayer. You can also use it to play 
Apple Arcade games, run Apple 
Fitness+ content, stream photos and 
your music library, and more. The Siri 
Remote has been redesigned with an 
improved touch-enabled clickpad.

The M1-equipped MacBook Air 
(Late 2020) is an incredible 
portable performer.

EXPECTED
SEP 2021

UPDATED 
NOV 2020

EXPECTED
APR 2023

UPDATED
APR  2021

with increased storage; you can add 
up to 2TB of SSD storage for £800 
on the base model or £600 on the 
eight-core GPU model. 

The M1 MacBook Air can be 
teamed with Apple’s Pro Display XDR, 
although none of the M1 Macs can be 
used with an external GPU (eGPU). 
You also get Touch ID for secure 
logins, and a Force Touch trackpad.

The MacBook Air is also equipped 
with two Thunderbolt/USB 4 ports 
and a headphone socket. The laptop 
now supports 802.11ax Wi-Fi – aka 
Wi-Fi 6, has Bluetooth 5.0 onboard, 
and is equipped with a 720p FaceTime 
camera for video chats.

So with the new internal upgrades, 
does the MacBook Air still boast its 
legendarily long battery life? Yes, and 
some! You can now get up to 18 hours 
of Apple TV app movie playback, or 15 
hours of wireless web surfing, thanks 
to its 49.9W battery. Like the earlier 
2020 incarnation, the new MacBook 
Air comes with Apple’s Magic 
Keyboard for fast, fluid typing.

EXPECTED
SEP 2021
UPDATED
NOV 2020

 From £169 
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 In October 2020, Apple launched the 
iPhone 12 family of handsets. The Pro 
features Apple’s A14 Bionic chip, with 
either a 6.1-inch or 6.7-inch (Max version) 
Super Retina XDR all-screen OLED True 
Tone display, and comes in 128, 256 or 
512GB storage options. The 12MP camera 
system incorporates Ultra Wide, Wide 
and Telephoto lenses with Portrait mode, 
plus HDR video with Dolby Vision. 

The iPhone 12 and iPhone 12 mini 
have the same A14 Bionic processor as 
their pricier sibling, but come in 64, 128 
and 256GB storage options. Both boast 
the Super Retina XDR True Tone display. 
The standard screen size is 6.1-inch, 
while the mini is 5.4-inch. These phones 
feature 12MP Wide and Ultra Wide 
cameras, but can also record HDR video 
with Dolby Vision. All the new iPhone 12 
models connect to 5G, and feature Face 
ID, Apple’s U1 chip and Haptic Touch. 

 In September 2020, Apple brought 
out the eighth-gen iPad featuring a 
new six-core A12 Bionic chip. The 
processor update allows for a Neural 
Engine to support image processing and 
Augmented Reality experiences.
Built for iPadOS, the iPad is great at 
multitasking. You can slide a second app 
over the right side of the one you’re 
working on. Picture in Picture enables 
you to watch video in a corner of the 
screen. There’s also Split View, which lets 
you work on two apps side by side.
iPad also supports external drives and, 
since the iOS 14.5 update, Xbox Series X 
and PlayStation 5 DualSense controllers 
for more immersive gaming.

The iPad comes in Gold, Silver and 
Space Grey with 32GB or 128GB options. 
At 490g, it is light yet the recycled 
aluminium enclosure is one of the most 
durable built by Apple.

 MODEL  KEY SPECIFICATIONS  PRICE

iPhone 
12 mini 
(5.4in Super 
Retina XDR)

CAPACITY: 64GB
PROCESSOR: A14 Bionic
FACE ID Yes
CAMERA 12MP photos 
(dual lens), HDR video 

£699

iPhone 12 
(6.1in Super 
Retina XDR)

CAPACITY: 128GB
PROCESSOR: A14 Bionic
FACE ID Yes
CAMERA 12MP photos 
(dual lens), HDR video

£849

iPhone 12 
Pro Max 
(6.7in Super 
Retina XDR)

CAPACITY: 512GB
PROCESSOR: A14 Bionic
FACE ID Yes
CAMERA 12MP photos 
(triple lens), 4K video

£1,399

 MODEL  KEY SPECIFICATIONS  PRICE

10.2in iPad CAPACITY 32GB 
PROCESSOR A12 Bionic
CONNECTIVITY Wi-Fi
CAMERA 8MP
UNLOCKING Touch ID

£329

10.9in 
iPad Air

CAPACITY 64GB
PROCESSOR A14 Bionic
CONNECTIVITY Wi-Fi
CAMERA 12MP
UNLOCKING Touch ID

£579

12.9in 
iPad Pro

CAPACITY 128GB
PROCESSOR M1
CONNECTIVITY Wi-Fi
CAMERA 12MP
UNLOCKING Face ID

£999

 iPhone

 Choose an iPhone  Choose an iPad

E
N

T
R

Y
 L

E
V

E
L

E
N

T
R

Y
 L

E
V

E
L

U
P

G
R

A
D

E
R

U
P

G
R

A
D

E
R

H
IG

H
 E

N
D

H
IG

H
 E

N
D

 There are changes 
aplenty for the iPad Air. 
The larger 10.9-inch 
Liquid Retina display also 

boasts slimmer bezels. You now get an 
A14 Bionic chip with Neural Engine for 
40% faster performance. The device 
still uses Touch ID but has replaced the 
Lightning connector with USB-C. The 
device is compatible with the second-
gen Apple Pencil and the Magic 
Keyboard with trackpad.

iPad Air
 From £579

 The world’s number one 
smartwatch now boasts an 
always-on Retina display. 

Along with the two size 
options (40 and 44mm), the 
Watch is available in aluminium, 
stainless steel, titanium. The 
ceramic option has now been 
discontinued. Along with the W3 and U1 chips, the 
64-bit S6 dual-core processor promises to make 
the watch 20% faster than Series 5, while 
retaining the same 18-hour battery life.

Series 6 now boasts a blood oxygen sensor 
and makes the most of the new watchOS 7 
features, such as Family Sharing, improved sleep 
and fitness tracking, and more customisable faces.

 Apple’s rather expensive 
over-ear headphones are 
finally here. The aluminium 
cups rotate independently, the 
knitted mesh headband helps 
reduce on-head pressure, and 
the Digital Crown helps you to 
control your audio with ease. More 
importantly, the high-fidelity audio 
performance is exceptional, and the H1 chip 
uses computational audio to assist ANC and 
Transparency mode. In addition, spatial audio 
with dynamic head tracking ensures that the 
headphones deliver an immersive experience.  

 From £379 (Series 6)

 From £549

 From  
£699 

 From 
£329  iPad
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STORE GUIDE Accessories

 THUNDERBOLT 3 HUB
Brydge Stone Pro Hub
£229.99 brydge.co.uk

 PORTABLE SPEAKER
Sonos Roam
£159 sonos.com

 IN-EAR EARPHONES

M&D MW07 Plus
£279 masterdynamic.com

 HEADPHONES
Beats Solo Pro
£269.95 beatsbydre.com

 The latest Beats 
headphones pack an 
impressive 40-hour 
battery life and Active 
Noise Cancellation. 
We love the unfold 
to power design and 
sound reproduction 

is excellent. Powered by Apple’s H1 
processor, the Solo Pro also offer simple 
pairing, Hey Siri detection and audio 
sharing with iOS 13 or later.

 Image credits (left to right, top to bottom): Ruark Audio, Brydge, Sonos Inc, Master & 
Dynamic, Apple, Other World Computing Inc, Logitech, Zyxel, Hex

 Winner of MF357’s head to head, 
the MR1 speaker set looks and sounds the 
business. The dome tweeter and long-
throw woofer can handle a variety of 
audio styles with aplomb. You get a good 
variety of connectivity options, and we 
love the chunky function/volume dial too.

 DESKTOP SPEAKER
Ruark MR1
£329.99 ruarkaudio.com

 Don’t let the size of 
this neat little SSD 
fool you – it’s both 
tough and efficient. 
Not only is it dust- 
and waterproof 

(IP67), and drop tested to military 
standards, it boasts blisteringly fast 
read and write speeds, and the supplied 
cable is capable of transferring data at 
5,000MB/sec over Thunderbolt. Storage 
capacities range from 240GB to 2TB. 

 EXTERNAL SSD
OWC Envoy Pro FX SSD
£365.99 (1TB) owcdigital.com

 If you spend a lot of time at your desk, 
you’ll know how imperative the right 
keyboard is. The MX Keys is full size with 
spherically dished, smooth-touch keys. 
The keyboard can pair with up to three 
Mac or iOS devices, and you can switch 
between them without having to re-pair. 
Battery life is good and the backlight is 
cleverly triggered by a proximity sensor.

 KEYBOARD  (MAC/iOS)
Logitech MX Keys For Mac
£99.99 logitech.com

 Looking for a bag that 
hits the sweet spot for 
generous storage and 
stylish looks? Look 
no further. The Hex 
Technical’s 17.5-litre 
capacity is made up of 

device-hugging padded pockets for a 
MacBook (up to 16in), iPad, power bank 
and more. The bag is waterproof and has 
a 1680D Cordura ballistic bottom so it’s 
also reassuringly rugged.

 MACBOOK BAG
Hex Technical backpack
$149.95 (about £110) hexbrand.com

 Zyxel’s Multy U 
mesh router hits the 
sweet spot, offering 
great performance 
at a competitive 
price, making it ideal 

for homes and small offices. The AC2100 
router offers up to 280Mbps with a range 
of 6,000sq ft, and the nodes are easy on 
the eye, too. The companion app comes 
with helpful speed tests and diagnostic 
tools, as well as parental controls. 

 WI-FI ROUTER
Zyxel Multy U WSR30
£199 zyxel.com/uk

 If you’re looking for a hub that offers 
multiple connectivity and impressive 
power delivery, this could be the one for 
you. You can power up your MacBook, 
thanks to over 87W of power from the wall 
power supply, and you can also charge up 
to four extra USB devices at once (three 
USB-A and one USB-C). You also get a 
dual-purpose audio and mic mini jack port.

 Master & Dynamic’s 
MW07 Plus offer 10 
hours of listening time, 
and the charging case 
holds an additional 
three charges (so you 

get 40 hours in total). These great-
sounding earbuds are IPX5 rated, so 
they’re excellent for workouts and 
commuting. The marble-effect finish gives 
them a premium aesthetic, as does the 
stainless steel charging case.
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 According to Sonos, this is its smartest 
speaker yet. You get Bluetooth and Wi-Fi 
connectivity, and Alexa and Google 
Assistant AI. The lightweight but rugged 
speaker’s extensive feature list includes 
Sound Swap – throwing sound to the 
nearest Sonos speaker, and Auto TruePlay 
– where it automatically tunes itself to 
the environment. It also sounds great!
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Software STORE GUIDE

 PHOTO EDITOR (MAC)
Luminar AI
From £59 skylum.com

 TEXT RECOGNITION (MAC)
TextSniper
£6.99 textsniper.app 

 NOTE-TAKING (iOS)
Notability 10
£8.99 gingerlabs.com

 TO-DO (MAC/iOS)
Todoist
From Free todoist.com

 FILE FINDER (MAC)
HoudahSpot 6
£31 houdah.com/houdahSpot

 TIME TRACKING (MAC/iOS)
Tyme 3
£3.49 per month tyme-app.com

 PHOTO EDITOR (iOS)

Pixelmator
£4.99 pixelmator.com

 CALENDAR & TASKS (MAC/iOS) 

Fantastical 3
From £3.25 per month 
flexibits.com

 EMAIL MANAGER (MAC/iOS)

Spark
Free sparkmailapp.com

 If you want to improve 
your photos without 
spending too much, this is 
the app for you. If you’re 
worried that you don’t have 

the know-how for technical image edits, 
this is also the app for you! The software 
uses artificial intelligence (AI) to analyse 
your photos with templates for various 
categories, instantly enhancing your shot. 
And, once the AI has worked its magic, you 
can make your own easy tweaks.

 Not only can TextSniper 
extract and recognise 
text from anything you 
see on your Mac’s screen, 
it can do so very quickly. 

The app can handle just about any type of 
copy – be it a screenshot, PDF, scanned 
photo document, and so on. It’s easy to 
use, works almost instantly, and we’re 
really impressed with its accuracy. If you 
need a decent text recognition app, try 
this excellent affordable option.

 Notability is a very 
flexible note-taking app. 
It can combine different 
mediums, such as 
illustrations, handwriting 

and audio recordings, and import PDFs 
and scan documents. Version 10 also 
brings an in-house Shop for purchasing 
additional stickers, themes and features, 
such as handwriting conversion. The app 
works well with Apple Pencil and supports 
a range of cloud-based services.

 If you find that Spotlight 
isn’t quite the Mac super 
sleuth you need it to be, 
try HoudahSpot 6. 
Searches are fully 

customisable and groups of criteria can be 
combined into logical expressions. Custom 
search windows can then be saved as 
templates, handy for common searches, 
and your searches can be further refined 
progressively. The Mail plug-in is great for 
drilling down through your mailboxes.

 If you need to make 
sure you’re paid for 
hours/miles you put in 
for work, or any expenses 
you incur, you need this 

app. Create a project, add your tasks and 
let Tyme keep track for you. The app 
doubles as an organiser and project 
manager and comes as a package for 
Mac, iPhone, iPad and Apple Watch. 
Geofencing means times can be recorded 
automatically based on your location. 

 Feeling inbox anxiety? 
The solution could be 
Spark, our favourite 
iPhone email app after 
winning MF340’s 

group test. Its ‘smart inbox’ prioritises 
emails based on perceived importance – 
no more vital messages getting lost in 
a sea of spam. You can snooze messages 
to be reminded about them later, and 
search your mailboxes using natural 
language. And to top it all off, it’s free.

 If your calendar and 
reminders are getting out 
of control, Fantastical can 
sort things out. It has 
support for natural 

language entry, so you can enter events 
and reminders as you would say them. It’s 
got a nifty menu bar shortcut, plus a great 
interface, clever calendar management 
and a powerful iOS app. Its predecessor 
won MF338’s group test. 

 Pixelmator is a full-
fledged layer-based 
photo editor, graphic 
design and painting app. 
It offers over 100 

brushes, dozens of tools and 32 blending 
modes giving you full control, all for a 
really affordable price. The app works with 
iCloud to sync all your projects across 
devices including Mac. It also supports 
formats like PSD, PNG and JPEG, making 
it the best app for all your graphic needs.

 Image credits (left to right, top to bottom): Skylum, Valerijs Boguckis, Ginger Labs, 
Doist Inc, Houdah Software, Muse Software Inc, Pixelmator, Flexibits, Readdle 
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 Task management apps 
should be clear and simple 
but with features on hand 
for you to be as productive 
as possible. Todoist 

provides that platform, and the Premium 
£3.99 tier in particular gets our vote. The 
interface is very easy to navigate and 
the comprehensive toolset is accessible 
without being overwhelming. The price 
includes both Mac and iOS apps, file 
uploads, and collaborative tools.Rafi
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GOODBYE Until next issue… 
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When connected to an Ethernet 
network, the AirPort Express 
base station provided wireless 
internet access.

Charlotte Henry recalls how Apple entered, then 
exited, the competitive world of internet routers

AirPort Express

ABOUT CHARLOTTE HENRY
 Charlotte Henry is a journalist and author 

covering media and technology. Based in 
London, she is the UK Associate of The Mac 
Observer, hosts its Media+ podcast, and has 
written for various other outlets. Her first 
book, Not Buying It, was published in 2019.

n 7 June 2004, Apple proudly 
unveiled AirPort Express. It was 
an 802.11g mobile base station 

that could be plugged into the wall, 
providing internet connections wherever 
you went.  It’s hard to imagine now, but in 
2004 ‘portable’ internet might required all 
sorts of cables and power supplies – it wasn’t 
as simple as opening up the hotspot provided 
by your iPhone then. Four years later, in 
March 2008,  things improved further as 
Apple updated the AirPort Express, 
introducing the 802.11n wireless standard 
which it said delivered up to five times better 
performance than its predecessor. A second 
generation of the 802.11n arrived in June 2012. 

As significant as the mobile internet 
developments were, there were also analogue 
and digital audio outputs in the base station. 
This meant that users could connect it to 
a stereo and use the AirTunes music 
networking software to wirelessly stream 
music from iTunes on their Mac or PC. 
“Users can now play their iTunes music on 
any stereo in their home – all without wires,” 
commented Steve Jobs at the time of the 
release. From the start, multiple base stations 
could be bridged together, enabling music 
to be played across a wider area.

 However, it wasn’t to last. In November 
2016, Bloomberg News revealed the team 
working on the AirPort Express and its 
siblings, AirPort Extreme and AirPort Time 
Capsule, had been disbanded. Then, in April 
2018, the company confirmed to 9to5Mac that 
the entire AirPort line had been discontinued.  

The demise of the AirPort Express wasn’t 
really a surprise. Wireless routers were never 
really an industry in which Apple could be 
said to be a leader and, ultimately, other Apple 
products like the HomePod provided a better 
solution for playing music wirelessly. Beyond 
the HomePod, the legacy of the AirPort 
Express remains, with the Apple TV and even 
the Mac mini closely resembling the second-
generation base station’s design.
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